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A.1 Rules for Arithmetic Operations

A P P E N D I X  A Basic Math Concepts and Symbols

RULE EXAMPLE

1. and b + a = ca + b = c and 1 + 2 = 32 + 1 = 3

2. a + (b + c) = (a + b) + c 5 + (7 + 4) = (5 + 7) + 4 = 16

3. but b - a Z ca - b = c but 7 - 9 Z 29 - 7 = 2

4. (a)(b) = (b)(a) (7)(6) = (6)(7) = 42

5. (a)(b + c) = ab + ac (2)(3 + 5) = (2)(3) + (2)(5) = 16

6. a , b Z b , a 12 , 3 Z 3 , 12

7.
a + b

c
=

a
c

+
b
c

7 + 3
2

=
7
2

+
3
2

= 5

8.
a

b + c
Z

a

b
+

a
c

3
4 + 5

Z
3
4

+
3
5

9.
1
a

+
1
b

=
b + a

ab

1
3

+
1
5

=
5 + 3
(3)(5)

=
8
15

10. aa

b
b a c

d
b = a ac

bd
b a2

3
b a6

7
b = a 122162132172 b =

12
21

11.
a

b
,

c

d
=

ad

bc
5
8

,
3
7

= a 152172182132 b =
35
24

A.2 Rules for Algebra: Exponents and Square Roots

RULE EXAMPLE

1. (X a)(X b) = X a+b (42)(43) = 45

2. (X a)b = X ab (22)3 = 26

3. (X a>X b) = X a-b 35

33
= 32

4.
X a

X a = X 0 = 1 34

34
= 30 = 1

5. 1XY = 1X1Y 1(25)(4) = 12514 = 10

6.A
X

Y
=
2X

2Y A
16

100
=
216

2100
= 0.40

550
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APPENDIX A Basic Math Concepts and Symbols 551

RULE EXAMPLE

1. log(10a) = a log(100) = log(102) = 2

2. If then a = 10blog(a) = b, If then a = 102 = 100log(a) = 2,
3. log(ab) = log(a) + log(b)

= 1 + 1 = 2
log(100) = log3(10)(10)4 = log(10) + log(10)

4. log(ab) = (b) log(a) log(1,000) = log(103) = (3) log(10) = (3)(1) = 3
5. log(a>b) = log(a) - log(b) = log(1,000) - log(10)log(100) = log(1,000>10)

= 3 - 1 = 2

A.3 Rules for Logarithms
Base 10
Log is the symbol used for base-10 logarithms:

Take the base-10 logarithm of each side of the following equation:

SOLUTION: Apply rules 3 and 4:

 = log(b0) + X log(b1) + log(e)

 = log(b0) + log(bX
1) + log(e)

 log(Y) = log(b0b
X
1e)

Y = b0b1
Xe

EXAMPLE

Base e
ln is the symbol used for base e logarithms, commonly referred to as natural logarithms. e is
Euler’s number, and :e � 2.718282

Take the base e logarithm of each side of the following equation:

SOLUTION: Apply rules 3 and 4:

 = ln(b0) + X ln(b1) + ln(e)

 = ln(b0) + ln(bX
1) + ln(e)

 ln(Y) = ln(b0b
X
1e)

Y = b0b
X
1e

EXAMPLE

RULE EXAMPLE

1. ln(ea) = a ln(7.389056) = ln(e2) = 2

2. If then a = ebln(a) = b, If then a = e2 = 7.389056ln(a) = 2,
3. ln(ab) = ln(a) + ln(b) ln(100) = ln3(10) (10)4

=  ln(10) + ln(10) = 2.302585 + 2.302585 = 4.605170

4. ln(ab) = (b) ln(a) ln(1,000) = ln(103) = 3 ln(10) = 3(2.302585) = 6.907755
5. ln(a>b) = ln(a) - ln(b) ln(100) = ln(1,000>10) = ln(1,000) - ln(10)

= 6.907755 - 2.302585 = 4.605170
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552 APPENDICES

A.4 Summation Notation
The symbol the Greek capital letter sigma, represents “taking the sum of.” Consider a set of

n values for variable X. The expression means to take the sum of the n values for variable

X. Thus:

The following problem illustrates the use of the symbol Consider five values of a variable
and Thus:

In statistics, the squared values of a variable are often summed. Thus:

and, in the example above:

the summation of the squares, is not the same as the square of the sum:

In the example given above, the summation of squares is equal to 79. This is not equal to the
square of the sum, which is 

Another frequently used operation involves the summation of the product. Consider two
variables, X and Y, each having n values. Then:

Continuing with the previous example, suppose there is a second variable, Y, whose five
values are and Then,

 = 45

 = 2 + 0 + 2 + 20 + 21

 = (2)(1) + (0)(3) + (-1)(-2) + (5)(4) + (7)(3)

 a
n

i=1
XiYi = X1Y1 + X2Y2 + X3Y3 + X4Y4 + X5Y5

Y5 = 3.Y1 = 1, Y2 = 3, Y3 = -  2, Y4 = 4,

a
n

i=1
XiYi = X1Y1 + X2Y2 + X3Y3 + Á + XnYn

132 = 169.

a
n

i=1
X 2

i Z aa
n

i=1
Xib

2

aa
n

i=1
Xib

2

,a
n

i=1
X 2

i ,

 = 79

 = 4 + 0 + 1 + 25 + 49

 = 22 + 02 + (-1)2 + 52 + 72

 a
5

i=1
X 2

i = X2
1 + X 2

2 + X 2
3 + X 2

4 + X 2
5

a
n

i=1
X 2

i = X 2
1 + X 2

2 + X 2
3 + Á + X 2

n

a
5

i=1
Xi = X1 + X2 + X3 + X4 + X5 = 2 + 0 + (-1) + 5 + 7 = 13

X5 = 7.X:  X1 = 2, X2 = 0, X3 = -1, X4 = 5,
©.

a
n

i=1
Xi = X1 + X2 + X3 + Á + Xn

a
n

i=1
Xi

©,
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APPENDIX A Basic Math Concepts and Symbols 553

In computing you need to realize that the first value of X is multiplied by the first

value of Y, the second value of X is multiplied by the second value of Y, and so on. These prod-
ucts are then summed in order to compute the desired result. However, the summation of prod-
ucts is not equal to the product of the individual sums:

In this example,

and

so that

However,

The following table summarizes these results:

a
5

i=1
XiYi = 45

aa
5

i=1
Xib aa

5

i=1
Yib = (13)(9) = 117

a
5

i=1
Yi = 1 + 3 + (-2) + 4 + 3 = 9

a
5

i=1
Xi = 13

a
n

i=1
XiYi Z aa

n

i=1
Xib aa

n

i=1
Yib

a
n

i=1
XiYi,

VALUE Xi Yi XiYi

1 2 1 2
2 0 3 0
3 -1 -2 2
4 5 4 20
5 7 3 21

a
5

i=1
Xi = 13 a

5

i=1
Yi = 9 a

5

i=1
XiYi = 45

Rule 1 The summation of the values of two variables is equal to the sum of the values of
each summed variable:

Thus,

 a
5

i=1
Xi + a

5

i=1
Yi = 13 + 9 = 22

 = 22

 = 3 + 3 + (-3) + 9 + 10

 a
5

i=1
(Xi + Yi) = (2 + 1) + (0 + 3) + (-1 + (-2)) + (5 + 4) + (7 + 3)

a
n

i=1
(Xi + Yi) = a

n

i=1
Xi + a

n

i=1
Yi
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Rule 2 The summation of a difference between the values of two variables is equal to the
difference between the summed values of the variables:

Thus,

Rule 3 The sum of a constant times a variable is equal to that constant times the sum of the
values of the variable:

where c is a constant. Thus, if 

Rule 4 A constant summed n times will be equal to n times the value of the constant.

where c is a constant. Thus, if the constant is summed 5 times,

 nc = (5)(2) = 10

 a
5

i=1
c = 2 + 2 + 2 + 2 + 2 = 10

c = 2

a
n

i=1
c = nc

 ca
5

i=1
Xi = 2a

5

i=1
Xi = (2)(13) = 26

 = 26

 = 4 + 0 + (-2) + 10 + 14

 a
5

i=1
cXi = a

5

i=1
2Xi = (2)(2) + (2)(0) + (2)(-1) + (2)(5) + (2)(7)

c = 2,

a
n

i=1
cXi = ca

n

i=1
Xi

 a
5

i=1
Xi - a

5

i=1
Yi = 13 - 9 = 4

 = 4

 = 1 + (-3) + 1 + 1 + 4

 a
5

i=1
(Xi - Yi) = (2 - 1) + (0 - 3) + (-1 - (-2)) + (5 - 4) + (7 - 3)

a
n

i=1
(Xi - Yi) = a

n

i=1
Xi - a

n

i=1
Yi

Suppose there are six values for the variables X and Y, such that 
and and 

Compute each of the following:

(a)

(b)

(c) a
6

i=1
X2

i

a
6

i=1
Yi

a
6

i=1
Xi

Y6 = -3.Y1 = 4, Y2 = 0, Y3 = -1, Y4 = 2, Y5 = 7,X4 = -3, X5 = 1, X6 = -2
X1 = 2, X2 = 1, X3 = 5,EXAMPLE

(d)

(e)

(f) a
6

i=1
(Xi + Yi)

a
6

i=1
XiYi

a
6

i=1
Y2

i
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add+ multiply*
subtract- divide,
equal to= not equal toZ
approximately equal to� less than6
greater than7 less than or equal to…
greater than or equal toÚ

(i)

(j) a
6

i=1
(Xi - 3Yi + c), where c = +3

a
6

i=1
(cXi), where c = -1

Answers
(a) 4 (b) 9 (c) 44 (d) 79 (e) 10 (f) 13 (g) (h) 65 (i) (j) -5-4-5

References
1. Bashaw, W. L., Mathematics for Statistics (New York: Wiley, 1969).
2. Lanzer, P., Basic Math: Fractions, Decimals, Percents (Hicksville, NY: Video Aided

Instruction, 2006).
3. Levine, D. and A. Brandwein, The MBA Primer: Business Statistics, 3rd ed. (Cincinnati, OH:

Cengage Publishing, 2011).
4. Levine, D., Statistics (Hicksville, NY: Video Aided Instruction, 2006).
5. Shane, H., Algebra 1 (Hicksville, NY: Video Aided Instruction, 2006).

(g)

(h) a
6

i=1
(Xi - 3Yi + 2X 2

i )

a
6

i=1
(Xi - Yi)

A.6 Greek Alphabet

GREEK LETTER LETTER NAME ENGLISH EQUIVALENT GREEK LETTER LETTER NAME ENGLISH EQUIVALENT

A a Alpha a N n Nu n
B b Beta b Ξ j Xi x
≠ g Gamma g � o Omicron oI

¢ d Delta d ß p Pi p
E e Epsilon eI P r Rho r
Z z Zeta z © s Sigma s
H h Eta e T t Tau t
Θ u Theta th Y y Upsilon u
I i Iota i £ f Phi ph
K k Kappa k X x Chi ch
¶ l Lambda l ° c Psi ps
M m Mu m Æ v Omega o

A.5 Statistical Symbols
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B.1 Objects in a Window
When you open Excel or Minitab, you see a window that contains the objects listed in Table B.1 and shown in Figure B.1. To effectively 
use Excel or Minitab, you must be familiar with these objects and their names.

A P P E N D I X  B Basic Computing Skills

556

Number Element Function

Title bar Displays the name of the program and contains the
Minimize, Resize, and Close buttons for the program
window. You drag and drop the title bar to reposition a
program window onscreen.

Minimize, Resize, 
and Close buttons

Changes the display of the program window. Minimize
hides the window without closing the program, Resize
permits you to change the size of the window, and Close
removes the window from the screen and closes the
program. A second set of these buttons that appear below
the first set perform the three actions for the currently
active workbook.

Menu Bar and 
Toolbars

The menu bar is a horizontal list of words, where each
word represents either a command operation or leads to
another list of choices. Toolbars are sets of graphical icons
that represent commands. The toolbar icons serve as
shortcuts to menu bar choices. (Minitab and Excel 2003)

Ribbon A selectable area that combines the functions of a menu bar
and toolbars. In the Ribbon, commands are arranged in a
series of tabs, and the tabs are further divided into groups.
Some groups contain launcher buttons that display
additional choices presented in a dialog box or as a gallery,
a set of pictorial choices. (Excel 2007 and Excel 2010)

Workbook area Displays the currently open worksheets. In Excel, this 
area usually displays the currently active worksheet in the
workbook and shows the other worksheets as sheet tabs
near the bottom of the workbook area.

Scroll bar Allows you to move through a worksheet vertically or
horizontally to reveal rows and columns that cannot
otherwise be seen.

T A B L E  B . 1
Common Window
Elements 1

2

3

4

5

6
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B.2 Basic Mouse Operations
To interact with the objects in a window, you frequently use a mouse (or some other pointing de-
vice). Mouse operations can be divided into four types and assume a mouse with two buttons, one
designated as the primary button (typically the left button) and the other button designated as the
secondary button (typically the right button).

Click, select, check, and clear are operations in which you move the mouse pointer over an
object and press the primary button. Click is used when pressing the primary button completes an
action, as in “click (the) OK (button).” Select is used when pressing the primary button to choose
or highlight one choice from a list of choices. Check is used when pressing the primary button
places a checkmark in the dialog box’s check box. (Clear reverses this action, removing the check-
mark.)

Double-click is an operation in which two clicks are made in rapid succession. Most double-
click operations enable an object for following use, such as double-clicking a chart in order to make
changes to the chart. Right-click is an operation in which you move the mouse pointer over an ob-
ject and press the secondary button. In the Excel Guide instructions, you will often right-click an
object in order to display a pop-up shortcut menu of context-sensitive command operations.

Drag is an operation in which you hold down the primary button over an object and then move
the mouse. (The drag operation ends when you release the mouse button.) Dragging is done to se-
lect multiple objects, such as selecting all the cells in a cell range, as well as to physically move an
object to another part of the screen. The related drag-and-drop operation permits you to move one
object over another to trigger an action. You drag the first object across the screen, and when the
first object is over the second object, you release the primary mouse button. (In most cases, releas-
ing the primary button causes the first object to reappear in its original position onscreen.)

Without a working knowledge of these mousing operations, you will find it difficult to under-
stand and follow the instructions presented in the end-of-chapter Excel and Minitab Guides.

B.3 Dialog Box Interactions
When you interact with either Excel or Minitab, you will see dialog boxes, pop-up windows that
contain messages or ask you to make entries or selections. Table B.2 identifies and defines the com-
mon objects found in dialog boxes which are shown in Figure B.2.

F I G U R E  B . 1
Minitab, Excel 2010, and
Excel 2007 windows (with
number labels keyed to
Table B.1)
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Element Function

Command button A clickable area that tells a program to take some action. For example,
a dialog box OK button causes a program to take an action using the
current entries and selections of the dialog box. A dialog box Cancel
button closes a dialog box and cancels the pending operation
associated with the entries and selections in the dialog box.

List box A box that displays a list of clickable choices. If a list exceeds the
dimensions of a list box, list boxes display scroll buttons or sliders
(not shown in Figure B.2) that can be clicked to reveal choices not
currently displayed.

Drop-down list A special button that, when clicked, displays a list of choices from
which you typically select one choice.

Edit box An area into which entries can be typed. Some edit boxes also contain
drop-down lists or spinner buttons that can be used to make entries. A
cell range edit box typically contains a clickable button that allows you to
drag the mouse over a cell range as an alternative to typing the cell range.

Set of option
buttons

A set of buttons that represent a set of mutually exclusive choices.
Clicking one option button clears all the other option buttons in the set.

Check box A clickable area that represents an optional action. A check box displays
either a checkmark or nothing, depending on whether the optional action
has been selected. Unlike with option buttons, clicking a check box does
not affect the status of other check boxes, and more than one check box
can be checked at a time. Clicking a check box that already contains a
checkmark clears the check box. (To distinguish between the two states,
instructions in this book use the verbs check and clear.)

T A B L E  B . 2
Dialog Box Elements

F I G U R E  B . 2
Excel 2010 Open (partially obscured) and Minitab Print dialog boxes

Z02_LEVI0923_06_SE_APPB.QXD  1/7/12  11:58 AM  Page 558

10



APPENDIX B Basic Computing Skills 559

B.4 Unique Features
Excel 2007 This version of Excel uniquely features the Office Button, the circular logo in the
upper left of the window that displays a menu of basic computing commands when clicked (see
Figure B.1). The Office Button functions much like the File menu in Excel 2003 and Minitab and
the File tab in Excel 2010.

Minitab All versions of Minitab use a session manager (shown in Figure MG1.1), a window 
in which results are added as a continuous log. (All Minitab results, other than charts, shown 
in this book have been copied from a session manager log.)

Minitab 16 Minitab 16 includes an Assistant feature that helps guide you through the choice of
the statistical method to use. The Assistant appears as an additional choice on the Minitab menu bar
and also provides direct clickable shortcuts to menu choices that might otherwise require several
different mouse clicks to select. The Assistant is not explicitly used in this book due to its uniqueness
to Minitab 16.
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C.1 About the Online
Resources for This Book
The online resources for this book are the data files for in-
chapter examples and problems as well as other files that
support your study. Online resources have been grouped into
the following categories: 

• Data Files The files that contain the data used in
chapter examples or named in problems. These data
files are available as either a set in the. xls format (Excel
Data Files) or as a set in the .mtw format (Minitab Data
Files). A complete list of the names of all the data files
appear in Section C.4 under the subheading Data Files.

• Excel Guide Workbooks Workbooks that contain
model solutions that can also be reused as templates for
solving other problems. A complete list of the names of
the Excel Guide Workbooks appear in Section C.4
under the subheading Excel Guide Workbooks.

• Files for the Digital Case The set of PDF files that
support the end-of-chapter Digital Cases. Some of the
Digital Case PDF files contain attached or embedded
Excel and Minitab files for use with particular case
questions.

• Files for the Managing Ashland MultiComm
Services Running Case The set of data files that sup-
port the “Managing Ashland MultiComm Services”
running case. These data files are also included in the
Data Files set and are listed with the other data files in
Section C.4.

• Online Topics PDF files that contain additional top-
ics and reference tables for Chapter 5 as well as the full
text of Chapter 14, “Statistical Applications in Quality
Management.”

• Visual Explorations Files The files needed to use the
Visual Explorations add-in workbook, the interactive
Excel add-in that illustrates selected statistical concepts.
The add-in workbook requires Excel VBA, found in
Microsoft Windows-based Excel 2003, 2007, or 2010
(as well as earlier, retired Excel versions) and in Mac
Excel versions other than Excel 2008.

• PHStat2 Readme File and PHStat2 Setup
Program Files that allow you to use the PHStat2 
add-in with Microsoft Windows-Based Excel 2003,
2007, or 2010. The readme file, in PDF format, pres-
ents late-breaking news about PHStat2 and reviews all
technical and setup requirements. The setup program,

A P P E N D I X  C Online Resources
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a self-extracting .exe file, sets up and installs PHStat2
on your Microsoft Windows system. See the end of
Section C.4 for more information about setting up and
using PHStat2.

To download a set of files, right-click its download link
and click the “save as” choice from the shortcut menu (Save
Target As in Internet Explorer, Save Link As in Mozilla
Firefox). Other than PHStat2, each set is downloaded as a
self-extracting archive of compressed files, which you
extract and store in the folder of your choice.

C.2 Accessing the Online
Resources
Online resources for this book are available either on the
download page for this book or inside the MyMathLab
Global course for this book, further explained in Section C.3.

To access the download page for this book, open a web
browser and go to www.pearsoninternationaleditions.
com/levine. On that web page, find the entries for this book
and click the link for the download page for this book. On
the download page, right-click the download link for one of
the resource categories listed in Section C.1. Click the “save
as” choice from the shortcut menu (Save Target As in
Internet Explorer, Save Link As in Mozilla Firefox). With
the exception of the PHStat2 files, the online resources have
been packaged as compressed zip archive files that you
download and then expand on your system.

C.3 Accessing the MyMathLab
Global Course Online
The MyMathLab Global course for this book contains all of
the online resources. Log into the course at the MyMathLab
Global website (www.mymathlab.com/global) and in the
left panel of the course page, click Student Resources and
then Tools for Success. On that page, click the link for one of
the resource categories listed in Section C.1. With the excep-
tion of the PHStat2 link, you will be prompted to download
and save a compressed zip archive file that you later expand
on your system. The PHStat2 link leads to a separate web
page from which you can download the PHStat2 readme file
and the PHStat2 setup file. Using MyMathLab Global
requires that you have an access code for this book. An
access code may have been packaged with this book. If your
book did not come with an access code, you can purchase
access online at www.mymathlab.com/global.
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C.1 About the Online
Resources for This Book
The online resources for this book are the data files for in-
chapter examples and problems as well as other files that
support your study. Online resources have been grouped into
the following categories: 

• Data Files The files that contain the data used in
chapter examples or named in problems. These data
files are available as either a set in the. xls format (Excel
Data Files) or as a set in the .mtw format (Minitab Data
Files). A complete list of the names of all the data files
appear in Section C.4 under the subheading Data Files.

• Excel Guide Workbooks Workbooks that contain
model solutions that can also be reused as templates for
solving other problems. A complete list of the names of
the Excel Guide Workbooks appear in Section C.4
under the subheading Excel Guide Workbooks.

• Files for the Digital Case The set of PDF files that
support the end-of-chapter Digital Cases. Some of the
Digital Case PDF files contain attached or embedded
Excel and Minitab files for use with particular case
questions.

• Files for the Managing Ashland MultiComm
Services Running Case The set of data files that sup-
port the “Managing Ashland MultiComm Services”
running case. These data files are also included in the
Data Files set and are listed with the other data files in
Section C.4.

• Online Topics PDF files that contain additional top-
ics and reference tables for Chapter 5 as well as the full
text of Chapter 14, “Statistical Applications in Quality
Management.”

• Visual Explorations Files The files needed to use the
Visual Explorations add-in workbook, the interactive
Excel add-in that illustrates selected statistical concepts.
The add-in workbook requires Excel VBA, found in
Microsoft Windows-based Excel 2003, 2007, or 2010
(as well as earlier, retired Excel versions) and in Mac
Excel versions other than Excel 2008.

• PHStat2 Readme File and PHStat2 Setup
Program Files that allow you to use the PHStat2 
add-in with Microsoft Windows-Based Excel 2003,
2007, or 2010. The readme file, in PDF format, pres-
ents late-breaking news about PHStat2 and reviews all
technical and setup requirements. The setup program,
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a self-extracting .exe file, sets up and installs PHStat2
on your Microsoft Windows system. See the end of
Section C.4 for more information about setting up and
using PHStat2.

To download a set of files, right-click its download link
and click the “save as” choice from the shortcut menu (Save
Target As in Internet Explorer, Save Link As in Mozilla
Firefox). Other than PHStat2, each set is downloaded as a
self-extracting archive of compressed files, which you
extract and store in the folder of your choice.

C.2 Accessing the Online
Resources
Online resources for this book are available either on the
download page for this book or inside the MyMathLab
Global course for this book, further explained in Section C.3.

To access the download page for this book, open a web
browser and go to www.pearsoninternationaleditions.
com/levine. On that web page, find the entries for this book
and click the link for the download page for this book. On
the download page, right-click the download link for one of
the resource categories listed in Section C.1. Click the “save
as” choice from the shortcut menu (Save Target As in
Internet Explorer, Save Link As in Mozilla Firefox). With
the exception of the PHStat2 files, the online resources have
been packaged as compressed zip archive files that you
download and then expand on your system.

C.3 Accessing the MyMathLab
Global Course Online
The MyMathLab Global course for this book contains all of
the online resources. Log into the course at the MyMathLab
Global website (www.mymathlab.com/global) and in the
left panel of the course page, click Student Resources and
then Tools for Success. On that page, click the link for one of
the resource categories listed in Section C.1. With the excep-
tion of the PHStat2 link, you will be prompted to download
and save a compressed zip archive file that you later expand
on your system. The PHStat2 link leads to a separate web
page from which you can download the PHStat2 readme file
and the PHStat2 setup file. Using MyMathLab Global
requires that you have an access code for this book. An
access code may have been packaged with this book. If your
book did not come with an access code, you can purchase
access online at www.mymathlab.com/global.
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C.4 Details of Downloadable
Files
Data Files
Data files contain the data used in chapter examples or
named in problems. Throughout this book, the names of data
files appear in a special invert color typeface—for example,

.
Data files are available as either a set in the .xls format

(Excel workbook files), compatible with all Excel ver-
sions, or as a set in the .mtw format (Minitab worksheet
files), compatible with Minitab Release 14 or later. Excel
and Minitab worksheets organize the data for each variable
by column, using the rules discussed in Sections EG1.2
and MG1.2. Except where noted in this book, each Excel
.xls workbook file stores data in a worksheet named
DATA.

In the following alphabetical list, the variables for each
data file are presented in the order of their appearance in the
file’s worksheet. References to the chapters in which the file
is mentioned appears in parentheses.

AD PAGES Magazine name, magazine ad pages in 2008,
and magazine ad pages in 2009 (Chapter 10)
ADVERTISE Sales ($thousands), radio ads ($thousands), and
newspaper ads ($thousands) for 22 cities (Chapter 13)
AMS2-1 Types of errors and frequency; types of errors and
cost; types of wrong billing errors and cost (Chapter 2)
AMS2-2 Days and number of calls (Chapter 2)

AMS8 Rate willing to pay in $ (Chapter 8)

AMS9 Upload speed (Chapter 9)

AMS10-1 Update times for e-mail interface 1 and email
interface 2 (Chapter 10)

AMS10-2 Update time for system 1, system 2, and system 3
(Chapter 10)

AMS12 Number of hours spent telemarketing and number
of new subscriptions (Chapter 12)

AMS13 Week, number of new subscriptions, hours spent
telemarketing, and type of presentation (formal or informal)
(Chapter 13)

AMS14 Day and upload speed (Chapter 14)

ANGLE Subgroup number and angle (Chapter 14)

ANSCOMBE Data sets A, B, C, and D—each with 11 pairs
of X and Y values (Chapter 12)

ATM TRANSACTIONS Cause, frequency, and percent-
age (Chapter 2)

AUDITS Year and number of audits (Chapter 2)

AUTO 2011 Car, miles per gallon, horsepower, and weight
(in lb.) (Chapters 12 and 13)

Bond Funds  
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BANK1 Waiting time (in minutes) of 15 customers at a
bank located in a commercial district (Chapters 3 and 9)

BANK2 Waiting time (in minutes) of 15 customers at a
bank located in a residential area (Chapter 3)

BANKTIME Day, waiting times of four bank customers
(A, B, C, and D) (Chapter 14)

BB2010 Team, league (0 = American, 1 = National), wins,
earned run average and runs scored (Chapters 12 and 13)

BBCOST2010 Team and fan cost index (Chapters 2 and 6)

BESTFUNDS Fund type (large cap value, large cap
growth), 3-year return, 5-year return, 10-year return, expense
ratio (Chapter 10)

BESTFUNDS2 Fund type (foreign large cap blend, small
cap blend, midcap blend, large cap blend, diversified emerg-
ing markets), 3-year return, 5-year return, 10-year return,
expense ratio (Chapter 10)

BESTFUNDS3 Fund type (intermediate municipal bond,
short-term bond, intermediate term bond), 3-year return, 
5-year return, 10-year return, expense ratio (Chapter 10)

BILL PAYMENT Form of payment and percentage
(Chapter 2)

BOND FUNDS Fund number, type, assets, fees, expense
ratio, 2009 return, 3-year return, 5-year return, risk, bins,
and midpoints (Chapters 2, 3, 4, 6, 8, 10, and 11)

BOND FUNDS2008 Fund number, type, assets, fees,
expense ratio, 2008 return, 3-year return, 5-year return, risk,
bins, and midpoints (Chapters 2 and 3)

BOOKPRICES Author, title, bookstore price, and online
price (Chapter 10)

BULBS Manufacturer (1 = A, 2 = B) and length of life in
hours (Chapters 2 and 10)

CANISTER Day and number of nonconformances
(Chapter 14)

CATFOOD Ounces eaten of kidney, shrimp, chicken liver,
salmon, and beef cat food (Chapter 10)

CATFOOD3 Type (1 = kidney, 2 = shrimp), shift, time
interval, nonconformances, and volume (Chapter 14)

CATFOOD4 Type (1 = kidney, 2 = shrimp), shift, time
interval, and weight (Chapter 14)

CD RATE One-year and five-year CD rate (Chapters 2, 
3, 6, 8)

CEO-COMPENSATION Company, compensation of
CEO in $millions, and return in 2010 (Chapters 2, 3, and 12)

CEREALS Cereal, calories, carbohydrates, and sugar
(Chapters 3 and 12)

CIGARETTETAX State and cigarette tax ($) (Chapters 2
and 3)

COFFEESALES Coffee sales at $0.59, $0.69, $0.79, and
$0.89 (Chapter 10)
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C.1 About the Online
Resources for This Book
The online resources for this book are the data files for in-
chapter examples and problems as well as other files that
support your study. Online resources have been grouped into
the following categories: 

• Data Files The files that contain the data used in
chapter examples or named in problems. These data
files are available as either a set in the. xls format (Excel
Data Files) or as a set in the .mtw format (Minitab Data
Files). A complete list of the names of all the data files
appear in Section C.4 under the subheading Data Files.

• Excel Guide Workbooks Workbooks that contain
model solutions that can also be reused as templates for
solving other problems. A complete list of the names of
the Excel Guide Workbooks appear in Section C.4
under the subheading Excel Guide Workbooks.

• Files for the Digital Case The set of PDF files that
support the end-of-chapter Digital Cases. Some of the
Digital Case PDF files contain attached or embedded
Excel and Minitab files for use with particular case
questions.

• Files for the Managing Ashland MultiComm
Services Running Case The set of data files that sup-
port the “Managing Ashland MultiComm Services”
running case. These data files are also included in the
Data Files set and are listed with the other data files in
Section C.4.

• Online Topics PDF files that contain additional top-
ics and reference tables for Chapter 5 as well as the full
text of Chapter 14, “Statistical Applications in Quality
Management.”

• Visual Explorations Files The files needed to use the
Visual Explorations add-in workbook, the interactive
Excel add-in that illustrates selected statistical concepts.
The add-in workbook requires Excel VBA, found in
Microsoft Windows-based Excel 2003, 2007, or 2010
(as well as earlier, retired Excel versions) and in Mac
Excel versions other than Excel 2008.

• PHStat2 Readme File and PHStat2 Setup
Program Files that allow you to use the PHStat2 
add-in with Microsoft Windows-Based Excel 2003,
2007, or 2010. The readme file, in PDF format, pres-
ents late-breaking news about PHStat2 and reviews all
technical and setup requirements. The setup program,
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a self-extracting .exe file, sets up and installs PHStat2
on your Microsoft Windows system. See the end of
Section C.4 for more information about setting up and
using PHStat2.

To download a set of files, right-click its download link
and click the “save as” choice from the shortcut menu (Save
Target As in Internet Explorer, Save Link As in Mozilla
Firefox). Other than PHStat2, each set is downloaded as a
self-extracting archive of compressed files, which you
extract and store in the folder of your choice.

C.2 Accessing the Online
Resources
Online resources for this book are available either on the
download page for this book or inside the MyMathLab
Global course for this book, further explained in Section C.3.

To access the download page for this book, open a web
browser and go to www.pearsoninternationaleditions.
com/levine. On that web page, find the entries for this book
and click the link for the download page for this book. On
the download page, right-click the download link for one of
the resource categories listed in Section C.1. Click the “save
as” choice from the shortcut menu (Save Target As in
Internet Explorer, Save Link As in Mozilla Firefox). With
the exception of the PHStat2 files, the online resources have
been packaged as compressed zip archive files that you
download and then expand on your system.

C.3 Accessing the MyMathLab
Global Course Online
The MyMathLab Global course for this book contains all of
the online resources. Log into the course at the MyMathLab
Global website (www.mymathlab.com/global) and in the
left panel of the course page, click Student Resources and
then Tools for Success. On that page, click the link for one of
the resource categories listed in Section C.1. With the excep-
tion of the PHStat2 link, you will be prompted to download
and save a compressed zip archive file that you later expand
on your system. The PHStat2 link leads to a separate web
page from which you can download the PHStat2 readme file
and the PHStat2 setup file. Using MyMathLab Global
requires that you have an access code for this book. An
access code may have been packaged with this book. If your
book did not come with an access code, you can purchase
access online at www.mymathlab.com/global.
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COLA Sales for normal and end-aisle locations 
(Chapter 10)

COLASPC Day, total number of cans filled, and number of
unacceptable cans (Chapter 14)

COLLEGE BASKETBALL School, coach’s total salary
in $thousands, expenses, and revenues ($thousands)
(Chapters 2, 3, and 12)

CONCRETE1 Sample number and compressive strength
after two days and seven days (Chapter 10)

CRACK Type of crack (0 = unflawed, 1 = flawed) and
crack size (Chapter 10)

CURRENCY Year, coded year, and exchange rates
(against the U.S. dollar) for the Canadian dollar, Japanese
yen, and English pound (Chapter 2)

CUSTSALE Week number, number of customers, and
sales ($thousands) over a period of 15 consecutive weeks
(Chapter 12)

DARKCHOCOLATE Cost ($) per ounce of dark choco-
late bars (Chapters 2 and 8)

DELIVERY Customer number, number of cases, and
delivery time (Chapter 12)

DIGITALCAMERAS Battery life (in shots) for subcom-
pact cameras and compact cameras (Chapter 10)

DINNER Time to prepare and cook dinner (in minutes)
(Chapter 9)

DOMESTICBEER Brand, alcohol percentage, calories, and
carbohydrates in U.S. domestic beers (Chapters 2, 3, and 6)

DOWMARKETCAP Company and market capitalization
($billions), (Chapters 3 and 6)

DRILL Depth, time to drill additional 5 feet, and type of
hole (Chapter 13)

DRINK Amount of soft drink filled in 2-liter bottles
(Chapter 9)

ENERGY State and per capita kilowatt hour use (Chapter 3)

ERRORSPC Number of nonconforming items and number
of accounts processed (Chapter 14)

ERWAITING Emergency room waiting time (in minutes)
at the main facility and at satellite 1, satellite 2, and satellite
3 (Chapter 10)

ESPRESSO Tamp (the distance in inches between the
espresso grounds and the top of the portafilter) and time (the
number of seconds the heart, body, and crema are separated)
(Chapter 12)

FASTFOOD Amount spent on fast food in dollars
(Chapters 8 and 9)

FIVE YEAR CD RATE Five year CD rate in New York and
Los Angeles (Chapter 10)

FORCE Force required to break an insulator (Chapters 3,
8, and 9)

FOULSPC Number of foul shots made and number taken
(Chapter 14)

FUNDTRAN Day, number of new investigations, and
number of investigations closed (Chapter 14)
FURNITURE Days between receipt and resolution of
complaints regarding purchased furniture (Chapters 2, 3, 8,
and 9)
GCROSLYN Address, appraised value ($thousands), loca-
tion, property size (acres), and age (Chapter 13)
GLENCOVE Address, appraised value ($thousands),
property size (acres), and age in Glen Cove, New York
(Chapter 13)
GOLFBALL Distance for designs 1, 2, 3, and 4 (Chap-
ter 10)
GPIGMAT GMAT scores and GPA (Chapter 12)
GRADSURVEY ID number, gender, age (as of last birth-
day), graduate major (accounting, economics and finance,
management, marketing/retailing, other, undecided), current
graduate cumulative grade point average, undergraduate
major (biological sciences, business, computers, engineer-
ing, other), undergraduate cumulative grade point average,
current employment status (full-time, part-time, unem-
ployed), number of different full-time jobs held in the
past 10 years, expected salary upon completion of MBA
($thousands), amount spent for books and supplies this
semester, satisfaction with student advising services on
campus, type of computer owned, text messages per week,
and wealth accumulated to feel rich (Chapters 1, 2, 3, 4, 6,
8, 10, and 11)
GRANULE Granule loss in Boston and Vermont shingles
(Chapters 3, 8, 9, and 10)
HARNSWELL Day and diameter of cam rollers (in
inches) (Chapter 14)
HOSPADM Day, number of admissions, mean processing
time (in hours), range of processing times, and proportion of
laboratory rework (over a 30-day period) (Chapter 14)
HOTEL1 Day, number of rooms studied, number of
nonconforming rooms per day over a 28-day period, and
proportion of nonconforming items (Chapter 14)
HOTEL2 Day and delivery time for subgroups of five
luggage deliveries per day over a 28-day period (Chapter 14)
HOTELPRICES City and cost (in English pounds) of two-
star, three-star, and four-star hotels (Chapters 2 and 3)
HOTELUK City and cost of a hotel room ($) (Chapter 3)
HOUSE1 Selling price ($thousands), assessed value
($thousands), type (new = 0, old = 1), and time period of sale
for 30 houses (Chapters 12 and 13)
HOUSE2 Assessed value ($thousands), size of heating area
(in thousands of square feet), and age (in years) for 15
houses (Chapters 12 and 13)
HOUSE3 Assessed value ($thousands), size (in thousands
of square feet), and presence of a fireplace for 15 houses
(Chapter 13)
ICECREAM Daily temperature (in degrees Fahrenheit)
and sales ($thousands) for 21 days (Chapter 12)
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INSURANCE Processing time in days for insurance poli-
cies (Chapters 3, 8, and 9)
INVOICE Number of invoices processed and amount of
time (in hours) for 30 days (Chapter 12)
INVOICES Amount recorded (in dollars) from sales
invoices (Chapters 8 and 9)
LARGEST BONDS Bond fund and one-year return of
bond funds (Chapter 3)

LUGGAGE Delivery time (in minutes) for luggage in
Wing A and Wing B of a hotel (Chapter 10)

MEASUREMENT Sample, in-line measurement, and ana-
lytical lab measurement (Chapter 10)

MEDREC Day, number of discharged patients, and number
of records not processed for a 30-day period (Chapter 14)

MOISTURE Moisture content of Boston shingles and
Vermont shingles (Chapter 9)

MOVIE Title, box office gross ($millions), and DVD
revenue ($millions) (Chapter 2)

MOVIE ATTENDANCE Year and movie attendance
(billions) (Chapter 2)

MOVIE SHARE Type of movie, number of movies, gross
($millions), and number of tickets (millions) (Chapter 2)

MOVIEGROSS Year and combined gross of movies
($millions) (Chapter 2)

MOVING Labor hours, cubic feet, number of large pieces
of furniture, and availability of an elevator (Chapters 12
and 13)
MUTUAL FUNDS Category, objective, assets ($millions),
fees, expense ratio, 2006 return, three-year return, five-year
return, and risk (Chapter 2)

MYELOMA Patient, measurement before transplant, and
measurement after transplant (Chapter 10)
NATURAL GAS Month, wellhead, price, and residential
price (Chapter 2)
NBA2011 Team, number of wins, field goal (shots made)
percentage (for team and opponent) (Chapter 13)

NBAVALUES Team, annual revenue ($millions), and value
($millions) for NBA franchises (Chapters 2, 3, and 12)

NEIGHBOR Selling price ($thousands), number of rooms,
and neighborhood location (0 = east, 1 = west) (Chapter 13)
NEW HOME PRICES Year and mean price ($thousands)
(Chapter 2)
OIL&GASOLINE Week, price of oil per barrel, and price
of a gallon of gasoline ($) (Chapter 12)
OMNIPOWER Bars sold, price (cents), and promotion
expenses ($) (Chapter 13)
ORDER Time in minutes to fill orders for a population of
200 (Chapter 8)
O-RING Flight number, temperature, and O-ring damage
index (Chapter 12)
PALLET Weight of Boston shingles and weight of Vermont
shingles (Chapters 2, 8, 9, and 10)

PARACHUTE Tensile strength of parachutes from suppliers 1,
2, 3, and 4; the sample means and the sample standard devia-
tions for the four suppliers in rows 8 and 9 (Chapter 10)
PEN Gender, ad, and product rating (Chapter 10)
PERFORM Performance rating before and after motiva-
tional training (Chapter 10)
PETFOOD Shelf space (in feet), weekly sales ($), and aisle
location (0 = back, 1 = front) (Chapters 12 and 13)
PHONE Time (in minutes) to clear telephone line problems
and location (1 = I and 2 = II) (Chapter 10)
PIZZATIME Time period, delivery time for local restau-
rant, and delivery time for national chain (Chapter 10)
POTTERMOVIES Title, first weekend gross ($millions),
U.S. gross ($millions), and worldwide gross ($millions)
(Chapters 2, 3, and 12)
PROPERTYTAXES State and property taxes per capita ($)
(Chapters 2, 3, and 6)
PROTEIN Type of food, calories (in grams), protein,
percentage of calories from fat, percentage of calories from
saturated fat, and cholesterol (mg) (Chapters 2 and 3)
PUMPKIN Circumference and weight of pumpkins
(Chapter 12)
REDWOOD Height (ft.), breast height diameter (in.), and
bark thickness (in.) (Chapters 12 and 13)
RENT Monthly rental cost (in dollars) and apartment size (in
square footage) (Chapter 12)
RESTAURANTS Location, food rating, decor rating, serv-
ice rating, summated rating, coded location (0 = city, 
1 = suburban), and cost of a meal (Chapters 2, 3, 10, 12, 
and 13)
RETURN 2009 UNSTACKED Intermediate government
return in 2009 and short-term corporate return in 2009
(Chapter 2)
RUDYBIRD Day, total cases sold, and cases of Rudybird
sold (Chapter 14)
SEALANT Sample number, sealant strength for Boston shin-
gles, and sealant strength for Vermont shingles (Chapter 14)
SHOPPING1 Product, Costco price ($), and store brand
price ($) (Chapter 10)
SITE Store number, square footage (in thousands of square
feet), and sales ($millions) (Chapter 12)
SOCCERVALUES 2011 Team, country, revenue ($millions),
and value ($millions) (Chapter 12)
SPONGE Day, number of sponges produced, number of
nonconforming sponges, and proportion of nonconforming
sponges (Chapter 14)
SPORTING Sales ($), age, annual population growth,
income ($), percentage with high school diploma, and per-
centage with college diploma (Chapter 12)
SPWATER Sample number and amount of magnesium
(Chapter 14)
STANDBY Standby hours, total staff present, remote
hours, Dubner hours, and labor hours (Chapter 13)
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STARBUCKS Tear, viscosity, pressure, plate gap (Chapter 13)
STEEL Error in actual length and specified length
(Chapters 2, 6, 8, and 9)
STOCK PERFORMANCE Decade and stock perform-
ance (%) (Chapter 2)
STOCKPRICES2010 Week, and closing weekly stock
price for GE, Discovery, and Apple (Chapter 12)
STUDYTIME Gender and study time (Chapter 10)
SUV Miles per gallon for 2011 small SUVs (Chapter 6)
TAX Quarterly sales tax receipts ($thousands) (Chapter 3)
TEA3 Sample number and weight of tea bags in ounces
(Chapter 14)
TEABAGS Weight of tea bags in ounces (Chapters 3, 8,
and 9)
TELESPC Number of orders and number of corrections
over 30 days (Chapter 14)

TENSILE Sample number and strength (Chapter 14)

THICKNESS Thickness, catalyst, pH, pressure, tempera-
ture, and voltage (Chapter 13)

TIMES Times to get ready (Chapter 3)

TRADE Days, number of undesirable trades, and total
number of trades made over a 30-day period (Chapter 14)

TRANSMIT Day and number of errors in transmission
(Chapter 14)

TRANSPORT Days and patient transport times (in min-
utes) (Chapter 14)

TRASHBAGS Weight required to break four brands of trash
bags (Kroger, Glad, Hefty, Tuff Stuff) (Chapter 10)

TROUGH Width of trough (Chapters 3, 8, and 9)

UNDERGRADSURVEY ID number, gender, age (as of last
birthday), class designation, major (accounting, computer
information systems, economics and finance, international
business, management, marketing, other, undecided) graduate
school intention (yes, no, undecided), cumulative grade point
average, current employment status, expected starting salary
($thousands), number of social networking sites registered
for, satisfaction with student advisement services on campus,
amount spent on books and supplies this semester, type of
computer preferred (desktop, laptop, tablet/notebook/
netbook), text messages per week, and wealth accumulated to
feel rich (Chapters 1, 2, 3, 4, 6, 8, 10, and 11)

UTILITY Utilities charges ($) for 50 one-bedroom apart-
ments (Chapter 6)
VB Time (in minutes) for nine students to write and run a
Visual Basic program (Chapter 10)
VEGGIEBURGER Calories and fat in veggie burgers
(Chapters 2 and 3)
WAIT Waiting times and seating times (in minutes) in a
restaurant (Chapter 6)
WARECOST Distribution cost ($thousands), sales
($thousands), and number of orders (Chapters 12 and 13)
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WAREHSE Day, units handled, and employee number
(Chapter 14)
WONDERLIC School, average Wonderlic score of foot-
ball players trying out for the NFL, and graduation rate
(Chapters 2, 3, and 12)

Excel Guide Workbooks
Excel Guide workbooks contain model solutions that can
be reused as templates for solving other problems.The In-
Depth Excel instructions of the Excel Guides feature these
workbooks and the workbooks also document many of the
worksheets created by PHStat2. Worksheets from these
workbooks are the source of many of the illustrations of
Excel results shown in this book.

Workbooks are stored in the .xls format, compatible with
all Excel versions. Most contain a COMPUTE worksheet
(often shown in this book) that presents results as well as
a COMPUTE_FORMULAS worksheet that allows for
the easy inspection of all worksheet formulas used in the
worksheet.

The Excel Guide workbooks for this book are:

Bayes
Binomial
Boxplot
Chapter 2
Chi-Square
Chi-Square Worksheets
CIE Proportion
CIE sigma known
CIE sigma unknown
Correlation
Covariance
Descriptive
Discrete Random Variable
F Two Variances
Levene
Multiple Regression
Normal
NPP
One-Way ANOVA
p Chart
Paired T
Poisson
Pooled-Variance T
Probabilities
Quartiles
R and XBar Chart
Random
Sample Size Mean
Sample Size Proportion
SDS
Separate-Variance T
Simple Linear Regression
StackedAndUnstacked
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T Mean
Variability
Z Mean
Z Proportion
Z Two Proportions

PDF Files
PDF files use the Portable Document Format that can be
viewed in most web browsers and PDF utility programs,
such as Adobe Reader, the free program available for down-
load at get.adobe.com/reader/. Both the Digital Case files
and the online topics files use this format. 

Files for the Digital Case The set of PDF files that sup-
port the end-of-chapter Digital Cases. Some of the Digital
Case PDF files contain attached or embedded Excel and
Minitab files for use with particular case questions. Some
Digital Cases use interactive PDF files that require Adobe
Reader, version X(10) or later, for full functionality.

Online Topics PDF files that contain additional textbook
material. Binomial.pdf and Poisson.pdf, contain the ref-
erence tables associated these discrete probability distri-
butions, discussed in Chapter 5. Chapter14.pdf contains
the full text of Chapter 14, “Statistical Applications in
Quality Management.”
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Other Downloadable Files
Managing Ashland MultiComm Services Running Case
Files The set of data files that support the “Managing
Ashland MultiComm Services” running case. These data
files are also included in the Data Files set and are included
in the alphabetical list on previous pages.

Visual Explorations This Excel add-in is packaged as a
self-extracting zip file that expands to three files. The three
files can be stored in the folder of your choice, but all three
files must be present together in the same folder for the add-
in workbook to function properly.

PHStat2 readme file and PHStat2 setup file Files that
allow you to use the PHStat2 add-in with Microsoft
Windows-based Excel 2003, 2007 or 2010. The readme
file, in PDF format, should be downloaded and read first
to allow you to review all of the technical and setup
requirements for using PHStat2. The setup program, 
a self-extracting .exe f ile, sets up and installs PHStat2 
on your Microsoft Windows system and must be run using
a Windows user account that has administrator privileges.

Sections D.2 and D.3 in Appendix D review the basics
of installing PHStat2 and configuring Excel for use with
PHStat2. The PHStat2 FAQs in Appendix G provide answers
to frequently asked questions about PHStat2.
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D.1 Checking for and Applying Updates
Excel
To check for and apply Excel updates, your system must be connected to the Internet. You can
check and apply updates using one of two methods. If Internet Explorer is the default web
browser on your system, use the Excel “check for updates” feature. In Excel 2010, select
File ➔ Help ➔ Check for Updates and follow the instructions that appear on the web page
that is displayed. In Excel 2007, click the Office Button and then Excel Options (at the bottom
of the Office Button menu window). In the Excel options dialog box, click Resources in the
left pane and then in the right pane click Check for Updates and follow the instructions that
appear on the web page that is displayed.

If the first method fails for any reason, you can manually download Excel and Microsoft
Office updates by opening a web browser and going to office.microsoft.com/officeupdate. On
the web page that is displayed, you can find download links arranged by popularity as well as
by product version. If you use this second method, you need to know the exact version and sta-
tus of your copy of Excel. In Excel 2010, select File ➔ Help and note the information under
the heading “About Microsoft Excel.” In Excel 2007, click the Office Button and then Excel
Options. In the Excel options dialog box, click Resources in the left pane and then in the right
pane note the detail line under the heading “about Microsoft Office Excel 2007.” The numbers
and codes that follow the words “Microsoft Office Excel” indicate the version number and
updates already applied.

If you use Mac Excel, select Help ➔ Check for Updates to begin Microsoft AutoUpdate
for Mac, similar to Microsoft Update, described above, for checking and applying updates.

Special Notes About the Windows Update Service If you use a Microsoft Windows–based
system and have previously turned on the Windows Update service, your system has not necessar-
ily downloaded and applied all Excel updates. If you use Windows Update, you can upgrade for
free to the Microsoft Update service that searches for and downloads updates for all Microsoft
products, including Excel and Office. (You can learn more about the Microsoft Update service by
visiting www.microsoft.com/security/updates/mu.aspx.)

Minitab
To check for and apply Minitab updates, your system must be connected to the Internet. Select
Help ➔ Check for Updates. Follow directions, if any, that appear in the Minitab Software
Update Manager dialog box. If there are no new updates, you will see a dialog box that states
“There are no updates available.” Click OK in that dialog box and then click Cancel in the
Update Manager dialog box to continue with your Minitab session.

D.2 Concise Instructions for Installing PHStat2
If your system can run the Microsoft Windows–based Excel 2003, Excel 2007, or Excel 2010,
you can download, install, and use PHStat2. Before using PHStat2:

• Check for and apply all Excel updates by using the instructions in Section D.1.
• Download and read the PHStat2 readme file for the latest information about PHStat2 (see

Appendix Section C.1). 
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D.1 Checking for and Applying Updates
Excel
To check for and apply Excel updates, your system must be connected to the Internet. You can
check and apply updates using one of two methods. If Internet Explorer is the default web
browser on your system, use the Excel “check for updates” feature. In Excel 2010, select
File ➔ Help ➔ Check for Updates and follow the instructions that appear on the web page
that is displayed. In Excel 2007, click the Office Button and then Excel Options (at the bottom
of the Office Button menu window). In the Excel options dialog box, click Resources in the
left pane and then in the right pane click Check for Updates and follow the instructions that
appear on the web page that is displayed.

If the first method fails for any reason, you can manually download Excel and Microsoft
Office updates by opening a web browser and going to office.microsoft.com/officeupdate. On
the web page that is displayed, you can find download links arranged by popularity as well as
by product version. If you use this second method, you need to know the exact version and sta-
tus of your copy of Excel. In Excel 2010, select File ➔ Help and note the information under
the heading “About Microsoft Excel.” In Excel 2007, click the Office Button and then Excel
Options. In the Excel options dialog box, click Resources in the left pane and then in the right
pane note the detail line under the heading “about Microsoft Office Excel 2007.” The numbers
and codes that follow the words “Microsoft Office Excel” indicate the version number and
updates already applied.

If you use Mac Excel, select Help ➔ Check for Updates to begin Microsoft AutoUpdate
for Mac, similar to Microsoft Update, described above, for checking and applying updates.

Special Notes About the Windows Update Service If you use a Microsoft Windows–based
system and have previously turned on the Windows Update service, your system has not necessar-
ily downloaded and applied all Excel updates. If you use Windows Update, you can upgrade for
free to the Microsoft Update service that searches for and downloads updates for all Microsoft
products, including Excel and Office. (You can learn more about the Microsoft Update service by
visiting www.microsoft.com/security/updates/mu.aspx.)

Minitab
To check for and apply Minitab updates, your system must be connected to the Internet. Select
Help ➔ Check for Updates. Follow directions, if any, that appear in the Minitab Software
Update Manager dialog box. If there are no new updates, you will see a dialog box that states
“There are no updates available.” Click OK in that dialog box and then click Cancel in the
Update Manager dialog box to continue with your Minitab session.

D.2 Concise Instructions for Installing PHStat2
If your system can run the Microsoft Windows–based Excel 2003, Excel 2007, or Excel 2010,
you can download, install, and use PHStat2. Before using PHStat2:

• Check for and apply all Excel updates by using the instructions in Section D.1.
• Download and read the PHStat2 readme file for the latest information about PHStat2 (see

Appendix Section C.1). 
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• Download the PHStat2 setup program (see Appendix Section C.3).
• Run the PHStat2 setup program to install PHStat2 on your system, taking note of the tech-

nical requirements listed in the PHStat2 readme file.
• Configure Excel to use PHStat2 (see Appendix Section D.3).

The PHStat2 setup program copies the PHStat2 files to your system and adds entries in the
Windows registry file on your system. Run the setup program only after first logging on to
Windows using a user account that has administrator privileges. (Running the setup program
with a Windows user account that does not include these privileges will prevent the setup pro-
gram from properly installing PHStat2.)

If your system runs Windows Vista, Windows 7, or certain third-party security programs,
you may see messages asking you to “permit” or “allow” specific system operations as the
setup program executes. If you do not give the setup program the necessary permissions,
PHStat2 will not be properly installed on your computer.

After the setup completes, check the installation by opening PHStat2. If the installation ran
properly, Excel will display a PHStat menu in the Add-Ins tab of the Office Ribbon (Excel 2007
or Excel 2010) or the Excel menu bar (Excel 2003). If you have skipped checking for and apply-
ing necessary Excel updates, or if some of the updates were unable to be applied, when you first
attempt to use PHStat2, you may see a “Compile Error” message that talks about a “hidden
module.” If this occurs, repeat the process of checking for and applying updates to Excel. (If the
bandwidth of the Internet connection is limited, you may need to use another connection.)

As you use PHStat, check the Pearson Education PHStat website, www.pearsonhighered.
com/phstat. For more information about PHStat without going online, read Appendix Section
G.1.

D.3 Configuring Excel for PHStat2 Usage
To configure Excel security settings for PHStat2 usage:

1. In Excel 2010, select File ➔ Options. In Excel 2007, click the Office Button and then
click Excel Options (at the bottom of the Office Button menu window).

In the Excel Options dialog box:

2. Click Trust Center in the left pane and then click Trust Center Settings in the right pane
(see the top of Figure D.1).

In the Trust Center dialog box:

3. Click Add-ins in the next left pane, and in the Add-ins right pane clear all of the check-
boxes (see the bottom left of Figure D.1).

4. Click Macro Settings in the left pane, and in the Macro Settings right pane click Disable
all macros with notification and check Trust access to the VBA object model (see the
bottom right of Figure D.1).

5. Click OK to close the Trust Center dialog box.

Back in the Excel Options dialog box:

6. Click OK to finish.
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D.1 Checking for and Applying Updates
Excel
To check for and apply Excel updates, your system must be connected to the Internet. You can
check and apply updates using one of two methods. If Internet Explorer is the default web
browser on your system, use the Excel “check for updates” feature. In Excel 2010, select
File ➔ Help ➔ Check for Updates and follow the instructions that appear on the web page
that is displayed. In Excel 2007, click the Office Button and then Excel Options (at the bottom
of the Office Button menu window). In the Excel options dialog box, click Resources in the
left pane and then in the right pane click Check for Updates and follow the instructions that
appear on the web page that is displayed.

If the first method fails for any reason, you can manually download Excel and Microsoft
Office updates by opening a web browser and going to office.microsoft.com/officeupdate. On
the web page that is displayed, you can find download links arranged by popularity as well as
by product version. If you use this second method, you need to know the exact version and sta-
tus of your copy of Excel. In Excel 2010, select File ➔ Help and note the information under
the heading “About Microsoft Excel.” In Excel 2007, click the Office Button and then Excel
Options. In the Excel options dialog box, click Resources in the left pane and then in the right
pane note the detail line under the heading “about Microsoft Office Excel 2007.” The numbers
and codes that follow the words “Microsoft Office Excel” indicate the version number and
updates already applied.

If you use Mac Excel, select Help ➔ Check for Updates to begin Microsoft AutoUpdate
for Mac, similar to Microsoft Update, described above, for checking and applying updates.

Special Notes About the Windows Update Service If you use a Microsoft Windows–based
system and have previously turned on the Windows Update service, your system has not necessar-
ily downloaded and applied all Excel updates. If you use Windows Update, you can upgrade for
free to the Microsoft Update service that searches for and downloads updates for all Microsoft
products, including Excel and Office. (You can learn more about the Microsoft Update service by
visiting www.microsoft.com/security/updates/mu.aspx.)

Minitab
To check for and apply Minitab updates, your system must be connected to the Internet. Select
Help ➔ Check for Updates. Follow directions, if any, that appear in the Minitab Software
Update Manager dialog box. If there are no new updates, you will see a dialog box that states
“There are no updates available.” Click OK in that dialog box and then click Cancel in the
Update Manager dialog box to continue with your Minitab session.

D.2 Concise Instructions for Installing PHStat2
If your system can run the Microsoft Windows–based Excel 2003, Excel 2007, or Excel 2010,
you can download, install, and use PHStat2. Before using PHStat2:

• Check for and apply all Excel updates by using the instructions in Section D.1.
• Download and read the PHStat2 readme file for the latest information about PHStat2 (see

Appendix Section C.1). 
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On some systems that have stringent security settings, you might need to modify step 5.
For such systems, in step 5, click Trusted Locations in the left pane and then, in the Trusted
Locations right pane, click Add new location to add the folder path to the PHStat2 add-in (typ-
ically C:\Program Files\PHStat2) and then click OK.

When you open PHStat2, Excel will display a Microsoft Excel Security Notice dialog box
(shown below). Click Enable Macros to enable PHStat2 to open and function.

 

F I G U R E  D . 1
Configuring Excel security settings
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D.4 Using the Visual Explorations Add-in Workbook
To use the Visual Explorations add-in workbook, first download the set of three files that com-
prise Visual Explorations from this book’s companion website (see Appendix C). Place the
three files together in a folder of your choosing. Next, use the Section D.3 instructions for con-
figuring Excel for PHStat2 usage. Then open the Visual Explorations.xla file in Excel and use
the VisualExplorations menu in the Add-Ins tab to select individual procedures.

D.5 Checking for the Presence of the Analysis ToolPak
To check for the presence of the Analysis ToolPak add-in (needed only if you will be using the
Analysis ToolPak Excel Guide instructions):

1. In Excel 2010, select File ➔ Options. In Excel 2007, click the Office Button and then
click Excel Options (at the bottom of the Office Button menu window).

In the Excel Options dialog box:

2. Click Add-Ins in the left pane and look for the entry Analysis ToolPak in the right pane,
under Active Application Add-ins.

3. If the entry appears, click OK.

If the entry does not appear in the Active Application Add-ins list, click Go. In the Add-Ins dia-
log box, check Analysis ToolPak in the Add-Ins available list and click OK. If Analysis ToolPak
does not appear in the list, rerun the Microsoft Office setup program to install this component.

The Analysis ToolPak add-in is not included and is not available for Mac Excel 2008 but is
included in other versions of Mac Excel.
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Column

00000 00001 11111 11112 22222 22223 33333 33334
Row 12345 67890 12345 67890 12345 67890 12345 67890

01 49280 88924 35779 00283 81163 07275 89863 02348
02 61870 41657 07468 08612 98083 97349 20775 45091
03 43898 65923 25078 86129 78496 97653 91550 08078
04 62993 93912 30454 84598 56095 20664 12872 64647
05 33850 58555 51438 85507 71865 79488 76783 31708
06 97340 03364 88472 04334 63919 36394 11095 92470
07 70543 29776 10087 10072 55980 64688 68239 20461
08 89382 93809 00796 95945 34101 81277 66090 88872
09 37818 72142 67140 50785 22380 16703 53362 44940
10 60430 22834 14130 96593 23298 56203 92671 15925
11 82975 66158 84731 19436 55790 69229 28661 13675
12 30987 71938 40355 54324 08401 26299 49420 59208
13 55700 24586 93247 32596 11865 63397 44251 43189
14 14756 23997 78643 75912 83832 32768 18928 57070
15 32166 53251 70654 92827 63491 04233 33825 69662
16 23236 73751 31888 81718 06546 83246 47651 04877
17 45794 26926 15130 82455 78305 55058 52551 47182
18 09893 20505 14225 68514 47427 56788 96297 78822
19 54382 74598 91499 14523 68479 27686 46162 83554
20 94750 89923 37089 20048 80336 94598 26940 36858
21 70297 34135 53140 33340 42050 82341 44104 82949
22 85157 47954 32979 26575 57600 40881 12250 73742
23 11100 02340 12860 74697 96644 89439 28707 25815
24 36871 50775 30592 57143 17381 68856 25853 35041
25 23913 48357 63308 16090 51690 54607 72407 55538
26 79348 36085 27973 65157 07456 22255 25626 57054
27 92074 54641 53673 54421 18130 60103 69593 49464
28 06873 21440 75593 41373 49502 17972 82578 16364
29 12478 37622 99659 31065 83613 69889 58869 29571
30 57175 55564 65411 42547 70457 03426 72937 83792
31 91616 11075 80103 07831 59309 13276 26710 73000
32 78025 73539 14621 39044 47450 03197 12787 47709
33 27587 67228 80145 10175 12822 86687 65530 49325
34 16690 20427 04251 64477 73709 73945 92396 68263
35 70183 58065 65489 31833 82093 16747 10386 59293
36 90730 35385 15679 99742 50866 78028 75573 67257
37 10934 93242 13431 24590 02770 48582 00906 58595
38 82462 30166 79613 47416 13389 80268 05085 96666
39 27463 10433 07606 16285 93699 60912 94532 95632
40 02979 52997 09079 92709 90110 47506 53693 49892
41 46888 69929 75233 52507 32097 37594 10067 67327
42 53638 83161 08289 12639 08141 12640 28437 09268
43 82433 61427 17239 89160 19666 08814 37841 12847
44 35766 31672 50082 22795 66948 65581 84393 15890
45 10853 42581 08792 13257 61973 24450 52351 16602
46 20341 27398 72906 63955 17276 10646 74692 48438
47 54458 90542 77563 51839 52901 53355 83281 19177
48 26337 66530 16687 35179 46560 00123 44546 79896
49 34314 23729 85264 05575 96855 23820 11091 79821
50 28603 10708 68933 34189 92166 15181 66628 58599
51 66194 28926 99547 16625 45515 67953 12108 57846
52 78240 43195 24837 32511 70880 22070 52622 61881
53 00833 88000 67299 68215 11274 55624 32991 17436
54 12111 86683 61270 58036 64192 90611 15145 01748
55 47189 99951 05755 03834 43782 90599 40282 51417
56 76396 72486 62423 27618 84184 78922 73561 52818
57 46409 17469 32483 09083 76175 19985 26309 91536

T A B L E  E . 1
Table of Random
Numbers
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Column 

00000 00001 11111 11112 22222 22223 33333 33334 
Row 12345 67890 12345 67890 12345 67890 12345 67890 

T A B L E  E . 1
Table of Random
Numbers (continued)

58 74626 22111 87286 46772 42243 68046 44250 42439
59 34450 81974 93723 49023 58432 67083 36876 93391
60 36327 72135 33005 28701 34710 49359 50693 89311
61 74185 77536 84825 09934 99103 09325 67389 45869
62 12296 41623 62873 37943 25584 09609 63360 47270
63 90822 60280 88925 99610 42772 60561 76873 04117
64 72121 79152 96591 90305 10189 79778 68016 13747
65 95268 41377 25684 08151 61816 58555 54305 86189
66 92603 09091 75884 93424 72586 88903 30061 14457
67 18813 90291 05275 01223 79607 95426 34900 09778
68 38840 26903 28624 67157 51986 42865 14508 49315
69 05959 33836 53758 16562 41081 38012 41230 20528
70 85141 21155 99212 32685 51403 31926 69813 58781
71 75047 59643 31074 38172 03718 32119 69506 67143
72 30752 95260 68032 62871 58781 34143 68790 69766
73 22986 82575 42187 62295 84295 30634 66562 31442
74 99439 86692 90348 66036 48399 73451 26698 39437
75 20389 93029 11881 71685 65452 89047 63669 02656
76 39249 05173 68256 36359 20250 68686 05947 09335
77 96777 33605 29481 20063 09398 01843 35139 61344
78 04860 32918 10798 50492 52655 33359 94713 28393
79 41613 42375 00403 03656 77580 87772 86877 57085
80 17930 00794 53836 53692 67135 98102 61912 11246
81 24649 31845 25736 75231 83808 98917 93829 99430
82 79899 34061 54308 59358 56462 58166 97302 86828
83 76801 49594 81002 30397 52728 15101 72070 33706
84 36239 63636 38140 65731 39788 06872 38971 53363
85 07392 64449 17886 63632 53995 17574 22247 62607
86 67133 04181 33874 98835 67453 59734 76381 63455
87 77759 31504 32832 70861 15152 29733 75371 39174
88 85992 72268 42920 20810 29361 51423 90306 73574
89 79553 75952 54116 65553 47139 60579 09165 85490
90 41101 17336 48951 53674 17880 45260 08575 49321
91 36191 17095 32123 91576 84221 78902 82010 30847
92 62329 63898 23268 74283 26091 68409 69704 82267
93 14751 13151 93115 01437 56945 89661 67680 79790
94 48462 59278 44185 29616 76537 19589 83139 28454
95 29435 88105 59651 44391 74588 55114 80834 85686
96 28340 29285 12965 14821 80425 16602 44653 70467
97 02167 58940 27149 80242 10587 79786 34959 75339
98 17864 00991 39557 54981 23588 81914 37609 13128
99 79675 80605 60059 35862 00254 36546 21545 78179

100 72335 82037 92003 34100 29879 46613 89720 13274

Source: Partially extracted from the Rand Corporation, A Million Random Digits with 100,000 Normal Deviates
(Glencoe, IL, The Free Press, 1955).
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T A B L E  E . 2
The Cumulative Standardized Normal Distribution
Entry represents area under the cumulative standardized 
normal distribution from to Zq-

Cumulative Probabilities

Z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09

-6.0 0.000000001
-5.5 0.000000019
-5.0 0.000000287
-4.5 0.000003398
-4.0 0.000031671
-3.9 0.00005 0.00005 0.00004 0.00004 0.00004 0.00004 0.00004 0.00004 0.00003 0.00003
-3.8 0.00007 0.00007 0.00007 0.00006 0.00006 0.00006 0.00006 0.00005 0.00005 0.00005
-3.7 0.00011 0.00010 0.00010 0.00010 0.00009 0.00009 0.00008 0.00008 0.00008 0.00008
-3.6 0.00016 0.00015 0.00015 0.00014 0.00014 0.00013 0.00013 0.00012 0.00012 0.00011
-3.5 0.00023 0.00022 0.00022 0.00021 0.00020 0.00019 0.00019 0.00018 0.00017 0.00017
-3.4 0.00034 0.00032 0.00031 0.00030 0.00029 0.00028 0.00027 0.00026 0.00025 0.00024
-3.3 0.00048 0.00047 0.00045 0.00043 0.00042 0.00040 0.00039 0.00038 0.00036 0.00035
-3.2 0.00069 0.00066 0.00064 0.00062 0.00060 0.00058 0.00056 0.00054 0.00052 0.00050
-3.1 0.00097 0.00094 0.00090 0.00087 0.00084 0.00082 0.00079 0.00076 0.00074 0.00071
-3.0 0.00135 0.00131 0.00126 0.00122 0.00118 0.00114 0.00111 0.00107 0.00103 0.00100
-2.9 0.0019 0.0018 0.0018 0.0017 0.0016 0.0016 0.0015 0.0015 0.0014 0.0014
-2.8 0.0026 0.0025 0.0024 0.0023 0.0023 0.0022 0.0021 0.0021 0.0020 0.0019
-2.7 0.0035 0.0034 0.0033 0.0032 0.0031 0.0030 0.0029 0.0028 0.0027 0.0026
-2.6 0.0047 0.0045 0.0044 0.0043 0.0041 0.0040 0.0039 0.0038 0.0037 0.0036
-2.5 0.0062 0.0060 0.0059 0.0057 0.0055 0.0054 0.0052 0.0051 0.0049 0.0048
-2.4 0.0082 0.0080 0.0078 0.0075 0.0073 0.0071 0.0069 0.0068 0.0066 0.0064
-2.3 0.0107 0.0104 0.0102 0.0099 0.0096 0.0094 0.0091 0.0089 0.0087 0.0084
-2.2 0.0139 0.0136 0.0132 0.0129 0.0125 0.0122 0.0119 0.0116 0.0113 0.0110
-2.1 0.0179 0.0174 0.0170 0.0166 0.0162 0.0158 0.0154 0.0150 0.0146 0.0143
-2.0 0.0228 0.0222 0.0217 0.0212 0.0207 0.0202 0.0197 0.0192 0.0188 0.0183
-1.9 0.0287 0.0281 0.0274 0.0268 0.0262 0.0256 0.0250 0.0244 0.0239 0.0233
-1.8 0.0359 0.0351 0.0344 0.0336 0.0329 0.0322 0.0314 0.0307 0.0301 0.0294
-1.7 0.0446 0.0436 0.0427 0.0418 0.0409 0.0401 0.0392 0.0384 0.0375 0.0367
-1.6 0.0548 0.0537 0.0526 0.0516 0.0505 0.0495 0.0485 0.0475 0.0465 0.0455
-1.5 0.0668 0.0655 0.0643 0.0630 0.0618 0.0606 0.0594 0.0582 0.0571 0.0559
-1.4 0.0808 0.0793 0.0778 0.0764 0.0749 0.0735 0.0721 0.0708 0.0694 0.0681
-1.3 0.0968 0.0951 0.0934 0.0918 0.0901 0.0885 0.0869 0.0853 0.0838 0.0823
-1.2 0.1151 0.1131 0.1112 0.1093 0.1075 0.1056 0.1038 0.1020 0.1003 0.0985
-1.1 0.1357 0.1335 0.1314 0.1292 0.1271 0.1251 0.1230 0.1210 0.1190 0.1170
-1.0 0.1587 0.1562 0.1539 0.1515 0.1492 0.1469 0.1446 0.1423 0.1401 0.1379
-0.9 0.1841 0.1814 0.1788 0.1762 0.1736 0.1711 0.1685 0.1660 0.1635 0.1611
-0.8 0.2119 0.2090 0.2061 0.2033 0.2005 0.1977 0.1949 0.1922 0.1894 0.1867
-0.7 0.2420 0.2388 0.2358 0.2327 0.2296 0.2266 0.2236 0.2206 0.2177 0.2148
-0.6 0.2743 0.2709 0.2676 0.2643 0.2611 0.2578 0.2546 0.2514 0.2482 0.2451
-0.5 0.3085 0.3050 0.3015 0.2981 0.2946 0.2912 0.2877 0.2843 0.2810 0.2776
-0.4 0.3446 0.3409 0.3372 0.3336 0.3300 0.3264 0.3228 0.3192 0.3156 0.3121
-0.3 0.3821 0.3783 0.3745 0.3707 0.3669 0.3632 0.3594 0.3557 0.3520 0.3483
-0.2 0.4207 0.4168 0.4129 0.4090 0.4052 0.4013 0.3974 0.3936 0.3897 0.3859
-0.1 0.4602 0.4562 0.4522 0.4483 0.4443 0.4404 0.4364 0.4325 0.4286 0.4247
-0.0 0.5000 0.4960 0.4920 0.4880 0.4840 0.4801 0.4761 0.4721 0.4681 0.4641

0Z–∞
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T A B L E  E . 2
The Cumulative Standardized Normal Distribution (continued) 
Entry represents area under the cumulative standardized 
normal distribution from to Zq-

Cumulative Probabilities 

Z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09

APPENDIX E Tables 573

0.0 0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359
0.1 0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753
0.2 0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141
0.3 0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517
0.4 0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879
0.5 0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224
0.6 0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7518 0.7549
0.7 0.7580 0.7612 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852
0.8 0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133
0.9 0.8159 0.8186 0.8212 0.8238 0.8264 0.8289 0.8315 0.8340 0.8365 0.8389
1.0 0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621
1.1 0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830
1.2 0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015
1.3 0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177
1.4 0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319
1.5 0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441
1.6 0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545
1.7 0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633
1.8 0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706
1.9 0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767
2.0 0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817
2.1 0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857
2.2 0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890
2.3 0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916
2.4 0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936
2.5 0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952
2.6 0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964
2.7 0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974
2.8 0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981
2.9 0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986
3.0 0.99865 0.99869 0.99874 0.99878 0.99882 0.99886 0.99889 0.99893 0.99897 0.99900
3.1 0.99903 0.99906 0.99910 0.99913 0.99916 0.99918 0.99921 0.99924 0.99926 0.99929
3.2 0.99931 0.99934 0.99936 0.99938 0.99940 0.99942 0.99944 0.99946 0.99948 0.99950
3.3 0.99952 0.99953 0.99955 0.99957 0.99958 0.99960 0.99961 0.99962 0.99964 0.99965
3.4 0.99966 0.99968 0.99969 0.99970 0.99971 0.99972 0.99973 0.99974 0.99975 0.99976
3.5 0.99977 0.99978 0.99978 0.99979 0.99980 0.99981 0.99981 0.99982 0.99983 0.99983
3.6 0.99984 0.99985 0.99985 0.99986 0.99986 0.99987 0.99987 0.99988 0.99988 0.99989
3.7 0.99989 0.99990 0.99990 0.99990 0.99991 0.99991 0.99992 0.99992 0.99992 0.99992
3.8 0.99993 0.99993 0.99993 0.99994 0.99994 0.99994 0.99994 0.99995 0.99995 0.99995
3.9 0.99995 0.99995 0.99996 0.99996 0.99996 0.99996 0.99996 0.99996 0.99997 0.99997
4.0 0.999968329
4.5 0.999996602
5.0 0.999999713
5.5 0.999999981
6.0 0.999999999

0 Z–∞
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T A B L E  E . 3
Critical Values of t

For a particular number of degrees of freedom, entry represents 
the critical value of t corresponding to the cumulative probability 

and a specified upper-tail area .1a211 - a2
Cumulative Probabilities

0.75 0.90 0.95 0.975 0.99 0.995

Degrees of 
Freedom

Upper-Tail Areas

0.25 0.10 0.05 0.025 0.01 0.005

1 1.0000 3.0777 6.3138 12.7062 31.8207 63.6574
2 0.8165 1.8856 2.9200 4.3027 6.9646 9.9248
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8409
4 0.7407 1.5332 2.1318 2.7764 3.7469 4.6041
5 0.7267 1.4759 2.0150 2.5706 3.3649 4.0322

6 0.7176 1.4398 1.9432 2.4469 3.1427 3.7074
7 0.7111 1.4149 1.8946 2.3646 2.9980 3.4995
8 0.7064 1.3968 1.8595 2.3060 2.8965 3.3554
9 0.7027 1.3830 1.8331 2.2622 2.8214 3.2498

10 0.6998 1.3722 1.8125 2.2281 2.7638 3.1693

11 0.6974 1.3634 1.7959 2.2010 2.7181 3.1058
12 0.6955 1.3562 1.7823 2.1788 2.6810 3.0545
13 0.6938 1.3502 1.7709 2.1604 2.6503 3.0123
14 0.6924 1.3450 1.7613 2.1448 2.6245 2.9768
15 0.6912 1.3406 1.7531 2.1315 2.6025 2.9467

16 0.6901 1.3368 1.7459 2.1199 2.5835 2.9208
17 0.6892 1.3334 1.7396 2.1098 2.5669 2.8982
18 0.6884 1.3304 1.7341 2.1009 2.5524 2.8784
19 0.6876 1.3277 1.7291 2.0930 2.5395 2.8609
20 0.6870 1.3253 1.7247 2.0860 2.5280 2.8453

21 0.6864 1.3232 1.7207 2.0796 2.5177 2.8314
22 0.6858 1.3212 1.7171 2.0739 2.5083 2.8188
23 0.6853 1.3195 1.7139 2.0687 2.4999 2.8073
24 0.6848 1.3178 1.7109 2.0639 2.4922 2.7969
25 0.6844 1.3163 1.7081 2.0595 2.4851 2.7874

26 0.6840 1.3150 1.7056 2.0555 2.4786 2.7787
27 0.6837 1.3137 1.7033 2.0518 2.4727 2.7707
28 0.6834 1.3125 1.7011 2.0484 2.4671 2.7633
29 0.6830 1.3114 1.6991 2.0452 2.4620 2.7564
30 0.6828 1.3104 1.6973 2.0423 2.4573 2.7500

31 0.6825 1.3095 1.6955 2.0395 2.4528 2.7440
32 0.6822 1.3086 1.6939 2.0369 2.4487 2.7385
33 0.6820 1.3077 1.6924 2.0345 2.4448 2.7333
34 0.6818 1.3070 1.6909 2.0322 2.4411 2.7284
35 0.6816 1.3062 1.6896 2.0301 2.4377 2.7238

36 0.6814 1.3055 1.6883 2.0281 2.4345 2.7195
37 0.6812 1.3049 1.6871 2.0262 2.4314 2.7154
38 0.6810 1.3042 1.6860 2.0244 2.4286 2.7116
39 0.6808 1.3036 1.6849 2.0227 2.4258 2.7079
40 0.6807 1.3031 1.6839 2.0211 2.4233 2.7045

41 0.6805 1.3025 1.6829 2.0195 2.4208 2.7012
42 0.6804 1.3020 1.6820 2.0181 2.4185 2.6981
43 0.6802 1.3016 1.6811 2.0167 2.4163 2.6951
44 0.6801 1.3011 1.6802 2.0154 2.4141 2.6923
45 0.6800 1.3006 1.6794 2.0141 2.4121 2.6896

46 0.6799 1.3002 1.6787 2.0129 2.4102 2.6870
47 0.6797 1.2998 1.6779 2.0117 2.4083 2.6846
48 0.6796 1.2994 1.6772 2.0106 2.4066 2.6822

0 t
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T A B L E  E . 3
Critical Values of t
(continued) 

Cumulative Probabilities

0.75 0.90 0.95 0.975 0.99 0.995 

Degrees of 
Freedom

Upper-Tail Areas 

0.25 0.10 0.05 0.025 0.01 0.005 

575

49 0.6795 1.2991 1.6766 2.0096 2.4049 2.6800
50 0.6794 1.2987 1.6759 2.0086 2.4033 2.6778

51 0.6793 1.2984 1.6753 2.0076 2.4017 2.6757
52 0.6792 1.2980 1.6747 2.0066 2.4002 2.6737
53 0.6791 1.2977 1.6741 2.0057 2.3988 2.6718
54 0.6791 1.2974 1.6736 2.0049 2.3974 2.6700
55 0.6790 1.2971 1.6730 2.0040 2.3961 2.6682

56 0.6789 1.2969 1.6725 2.0032 2.3948 2.6665
57 0.6788 1.2966 1.6720 2.0025 2.3936 2.6649
58 0.6787 1.2963 1.6716 2.0017 2.3924 2.6633
59 0.6787 1.2961 1.6711 2.0010 2.3912 2.6618
60 0.6786 1.2958 1.6706 2.0003 2.3901 2.6603

61 0.6785 1.2956 1.6702 1.9996 2.3890 2.6589
62 0.6785 1.2954 1.6698 1.9990 2.3880 2.6575
63 0.6784 1.2951 1.6694 1.9983 2.3870 2.6561
64 0.6783 1.2949 1.6690 1.9977 2.3860 2.6549
65 0.6783 1.2947 1.6686 1.9971 2.3851 2.6536

66 0.6782 1.2945 1.6683 1.9966 2.3842 2.6524
67 0.6782 1.2943 1.6679 1.9960 2.3833 2.6512
68 0.6781 1.2941 1.6676 1.9955 2.3824 2.6501
69 0.6781 1.2939 1.6672 1.9949 2.3816 2.6490
70 0.6780 1.2938 1.6669 1.9944 2.3808 2.6479

71 0.6780 1.2936 1.6666 1.9939 2.3800 2.6469
72 0.6779 1.2934 1.6663 1.9935 2.3793 2.6459
73 0.6779 1.2933 1.6660 1.9930 2.3785 2.6449
74 0.6778 1.2931 1.6657 1.9925 2.3778 2.6439
75 0.6778 1.2929 1.6654 1.9921 2.3771 2.6430

76 0.6777 1.2928 1.6652 1.9917 2.3764 2.6421
77 0.6777 1.2926 1.6649 1.9913 2.3758 2.6412
78 0.6776 1.2925 1.6646 1.9908 2.3751 2.6403
79 0.6776 1.2924 1.6644 1.9905 2.3745 2.6395
80 0.6776 1.2922 1.6641 1.9901 2.3739 2.6387

81 0.6775 1.2921 1.6639 1.9897 2.3733 2.6379
82 0.6775 1.2920 1.6636 1.9893 2.3727 2.6371
83 0.6775 1.2918 1.6634 1.9890 2.3721 2.6364
84 0.6774 1.2917 1.6632 1.9886 2.3716 2.6356
85 0.6774 1.2916 1.6630 1.9883 2.3710 2.6349

86 0.6774 1.2915 1.6628 1.9879 2.3705 2.6342
87 0.6773 1.2914 1.6626 1.9876 2.3700 2.6335
88 0.6773 1.2912 1.6624 1.9873 2.3695 2.6329
89 0.6773 1.2911 1.6622 1.9870 2.3690 2.6322
90 0.6772 1.2910 1.6620 1.9867 2.3685 2.6316

91 0.6772 1.2909 1.6618 1.9864 2.3680 2.6309
92 0.6772 1.2908 1.6616 1.9861 2.3676 2.6303
93 0.6771 1.2907 1.6614 1.9858 2.3671 2.6297
94 0.6771 1.2906 1.6612 1.9855 2.3667 2.6291
95 0.6771 1.2905 1.6611 1.9853 2.3662 2.6286

96 0.6771 1.2904 1.6609 1.9850 2.3658 2.6280
97 0.6770 1.2903 1.6607 1.9847 2.3654 2.6275
98 0.6770 1.2902 1.6606 1.9845 2.3650 2.6269
99 0.6770 1.2902 1.6604 1.9842 2.3646 2.6264

100 0.6770 1.2901 1.6602 1.9840 2.3642 2.6259

110 0.6767 1.2893 1.6588 1.9818 2.3607 2.6213

120 0.6765 1.2886 1.6577 1.9799 2.3578 2.6174

q 0.6745 1.2816 1.6449 1.9600 2.3263 2.5758
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T A B L E  E . 4

Critical Values of x2

For a particular number of degrees of freedom, entry represents the critical value of 
corresponding to the cumulative probability and a specified upper-tail area .1a211 - a2 x2

Cumulative Probabilities

0.005 0.01 0.025 0.05 0.10 0.25 0.75 0.90 0.95 0.975 0.99 0.995

Degrees of
Freedom

Upper-Tail Areas ( )A

0.995 0.99 0.975 0.95 0.90 0.75 0.25 0.10 0.05 0.025 0.01 0.005

1 0.001 0.004 0.016 0.102 1.323 2.706 3.841 5.024 6.635 7.879
2 0.010 0.020 0.051 0.103 0.211 0.575 2.773 4.605 5.991 7.378 9.210 10.597
3 0.072 0.115 0.216 0.352 0.584 1.213 4.108 6.251 7.815 9.348 11.345 12.838
4 0.207 0.297 0.484 0.711 1.064 1.923 5.385 7.779 9.488 11.143 13.277 14.860
5 0.412 0.554 0.831 1.145 1.610 2.675 6.626 9.236 11.071 12.833 15.086 16.750

6 0.676 0.872 1.237 1.635 2.204 3.455 7.841 10.645 12.592 14.449 16.812 18.548
7 0.989 1.239 1.690 2.167 2.833 4.255 9.037 12.017 14.067 16.013 18.475 20.278
8 1.344 1.646 2.180 2.733 3.490 5.071 10.219 13.362 15.507 17.535 20.090 21.955
9 1.735 2.088 2.700 3.325 4.168 5.899 11.389 14.684 16.919 19.023 21.666 23.589

10 2.156 2.558 3.247 3.940 4.865 6.737 12.549 15.987 18.307 20.483 23.209 25.188

11 2.603 3.053 3.816 4.575 5.578 7.584 13.701 17.275 19.675 21.920 24.725 26.757
12 3.074 3.571 4.404 5.226 6.304 8.438 14.845 18.549 21.026 23.337 26.217 28.299
13 3.565 4.107 5.009 5.892 7.042 9.299 15.984 19.812 22.362 24.736 27.688 29.819
14 4.075 4.660 5.629 6.571 7.790 10.165 17.117 21.064 23.685 26.119 29.141 31.319
15 4.601 5.229 6.262 7.261 8.547 11.037 18.245 22.307 24.996 27.488 30.578 32.801

16 5.142 5.812 6.908 7.962 9.312 11.912 19.369 23.542 26.296 28.845 32.000 34.267
17 5.697 6.408 7.564 8.672 10.085 12.792 20.489 24.769 27.587 30.191 33.409 35.718
18 6.265 7.015 8.231 9.390 10.865 13.675 21.605 25.989 28.869 31.526 34.805 37.156
19 6.844 7.633 8.907 10.117 11.651 14.562 22.718 27.204 30.144 32.852 36.191 38.582
20 7.434 8.260 9.591 10.851 12.443 15.452 23.828 28.412 31.410 34.170 37.566 39.997

21 8.034 8.897 10.283 11.591 13.240 16.344 24.935 29.615 32.671 35.479 38.932 41.401
22 8.643 9.542 10.982 12.338 14.042 17.240 26.039 30.813 33.924 36.781 40.289 42.796
23 9.260 10.196 11.689 13.091 14.848 18.137 27.141 32.007 35.172 38.076 41.638 44.181
24 9.886 10.856 12.401 13.848 15.659 19.037 28.241 33.196 36.415 39.364 42.980 45.559
25 10.520 11.524 13.120 14.611 16.473 19.939 29.339 34.382 37.652 40.646 44.314 46.928

26 11.160 12.198 13.844 15.379 17.292 20.843 30.435 35.563 38.885 41.923 45.642 48.290
27 11.808 12.879 14.573 16.151 18.114 21.749 31.528 36.741 40.113 43.194 46.963 49.645
28 12.461 13.565 15.308 16.928 18.939 22.657 32.620 37.916 41.337 44.461 48.278 50.993
29 13.121 14.257 16.047 17.708 19.768 23.567 33.711 39.087 42.557 45.722 49.588 52.336
30 13.787 14.954 16.791 18.493 20.599 24.478 34.800 40.256 43.773 46.979 50.892 53.672

For larger values of degrees of freedom (df ) the expression may be used and the resulting upper-tail area can be found
from the cumulative standardized normal distribution (Table E.2).

Z = 22x2 - 221df 2 - 1

0 χ2

1 – � 
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Number of Observations 
in Sample/Subgroup (n) d2 d3 D3 D4 A2

2 1.128 0.853 0 3.267 1.880
3 1.693 0.888 0 2.575 1.023
4 2.059 0.880 0 2.282 0.729
5 2.326 0.864 0 2.114 0.577
6 2.534 0.848 0 2.004 0.483
7 2.704 0.833 0.076 1.924 0.419
8 2.847 0.820 0.136 1.864 0.373
9 2.970 0.808 0.184 1.816 0.337

10 3.078 0.797 0.223 1.777 0.308
11 3.173 0.787 0.256 1.744 0.285
12 3.258 0.778 0.283 1.717 0.266
13 3.336 0.770 0.307 1.693 0.249
14 3.407 0.763 0.328 1.672 0.235
15 3.472 0.756 0.347 1.653 0.223
16 3.532 0.750 0.363 1.637 0.212
17 3.588 0.744 0.378 1.622 0.203
18 3.640 0.739 0.391 1.609 0.194
19 3.689 0.733 0.404 1.596 0.187
20 3.735 0.729 0.415 1.585 0.180
21 3.778 0.724 0.425 1.575 0.173
22 3.819 0.720 0.435 1.565 0.167
23 3.858 0.716 0.443 1.557 0.162
24 3.895 0.712 0.452 1.548 0.157
25 3.931 0.708 0.459 1.541 0.153

Source: Reprinted from ASTM-STP 15D by kind permission of the American Society for Testing and Materials.

T A B L E  E . 8
Control Chart Factors

584 APPENDICES
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T A B L E  E . 9
The Standardized Normal Distribution

Entry represents area under the standardized normal 
distribution from the mean to Z

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

0.0 .0000 .0040 .0080 .0120 .0160 .0199 .0239 .0279 .0319 .0359
0.1 .0398 .0438 .0478 .0517 .0557 .0596 .0636 .0675 .0714 .0753
0.2 .0793 .0832 .0871 .0910 .0948 .0987 .1026 .1064 .1103 .1141
0.3 .1179 .1217 .1255 .1293 .1331 .1368 .1406 .1443 .1480 .1517
0.4 .1554 .1591 .1628 .1664 .1700 .1736 .1772 .1808 .1844 .1879
0.5 .1915 .1950 .1985 .2019 .2054 .2088 .2123 .2157 .2190 .2224
0.6 .2257 .2291 .2324 .2357 .2389 .2422 .2454 .2486 .2518 .2549
0.7 .2580 .2612 .2642 .2673 .2704 .2734 .2764 .2794 .2823 .2852
0.8 .2881 .2910 .2939 .2967 .2995 .3023 .3051 .3078 .3106 .3133
0.9 .3159 .3186 .3212 .3238 .3264 .3289 .3315 .3340 .3365 .3389

1.0 .3413 .3438 .3461 .3485 .3508 .3531 .3554 .3577 .3599 .3621
1.1 .3643 .3665 .3686 .3708 .3729 .3749 .3770 .3790 .3810 .3830
1.2 .3849 .3869 .3888 .3907 .3925 .3944 .3962 .3980 .3997 .4015
1.3 .4032 .4049 .4066 .4082 .4099 .4115 .4131 .4147 .4162 .4177
1.4 .4192 .4207 .4222 .4236 .4251 .4265 .4279 .4292 .4306 .4319
1.5 .4332 .4345 .4357 .4370 .4382 .4394 .4406 .4418 .4429 .4441
1.6 .4452 .4463 .4474 .4484 .4495 .4505 .4515 .4525 .4535 .4545
1.7 .4554 .4564 .4573 .4582 .4591 .4599 .4608 .4616 .4625 .4633
1.8 .4641 .4649 .4656 .4664 .4671 .4678 .4686 .4693 .4699 .4706
1.9 .4713 .4719 .4726 .4732 .4738 .4744 .4750 .4756 .4761 .4767

2.0 .4772 .4778 .4783 .4788 .4793 .4798 .4803 .4808 .4812 .4817
2.1 .4821 .4826 .4830 .4834 .4838 .4842 .4846 .4850 .4854 .4857
2.2 .4861 .4864 .4868 .4871 .4875 .4878 .4881 .4884 .4887 .4890
2.3 .4893 .4896 .4898 .4901 .4904 .4906 .4909 .4911 .4913 .4916
2.4 .4918 .4920 .4922 .4925 .4927 .4929 .4931 .4932 .4934 .4936
2.5 .4938 .4940 .4941 .4943 .4945 .4946 .4948 .4949 .4951 .4952
2.6 .4953 .4955 .4956 .4957 .4959 .4960 .4961 .4962 .4963 .4964
2.7 .4965 .4966 .4967 .4968 .4969 .4970 .4971 .4972 .4973 .4974
2.8 .4974 .4975 .4976 .4977 .4977 .4978 .4979 .4979 .4980 .4981
2.9 .4981 .4982 .4982 .4983 .4984 .4984 .4985 .4985 .4986 .4986

3.0 .49865 .49869 .49874 .49878 .49882 .49886 .49889 .49893 .49897 .49900
3.1 .49903 .49906 .49910 .49913 .49916 .49918 .49921 .49924 .49926 .49929
3.2 .49931 .49934 .49936 .49938 .49940 .49942 .49944 .49946 .49948 .49950
3.3 .49952 .49953 .49955 .49957 .49958 .49960 .49961 .49962 .49964 .49965
3.4 .49966 .49968 .49969 .49970 .49971 .49972 .49973 .49974 .49975 .49976
3.5 .49977 .49978 .49978 .49979 .49980 .49981 .49981 .49982 .49983 .49983
3.6 .49984 .49985 .49985 .49986 .49986 .49987 .49987 .49988 .49988 .49989
3.7 .49989 .49990 .49990 .49990 .49991 .49991 .49992 .49992 .49992 .49992
3.8 .49993 .49993 .49993 .49994 .49994 .49994 .49994 .49995 .49995 .49995
3.9 .49995 .49995 .49996 .49996 .49996 .49996 .49996 .49996 .49997 .49997

0 Z

APPENDIX E Tables 585
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586

F.1 Enhancing Workbook Presentation
You can enhance workbook presentation by using common formatting commands and rear-
ranging the order of the worksheets and chart sheets in a workbook.

Table F.1 presents the shortcuts for worksheet formatting operations used to create the
Excel Guide workbooks and the results shown throughout this book. These shortcuts can be
found in the Home tab of the Excel Office Ribbon (see Figure F.1).

A P P E N D I X  F Additional Excel Procedures

Number Operation Name Use

1 Font Face and Font Size Changes the text font face and size for cell entries
and chart labels. Worksheets shown in this book
have been formatted as Calibri 11. Many DATA
worksheets have been formatted as Arial 10.

Boldface Toggles on (or off) boldface text style for the
currently selected object.

Italic Toggles on (or off) italic text style for the
currently selected object.

Borders Displays a gallery of choices that permit drawing
lines (borders) around a cell or cell range.

Fill Color Displays a gallery of choices for the background
color of a cell. Immediately to the right of Fill
Color is the related Font Color (not used in any
example in this book).

Align Text Aligns the display of the contents of a worksheet
cell. Three buttons are available: Align Text Left,
Center, and Align Text Right.

Merge & Center Merges (combines) adjacent cells into one cell
and centers the display of the contents of that cell.
In Excel 2007, this button is also a drop-down list
that offers additional Merge and Unmerge
choices.

Percent Formats the display of a number value in a cell as
a percentage. The value 1 displays as 100%, the
value 0.01 displays as 1%. To the immediate left
of Percent is Currency, which formats values as
dollars and cents. Do not confuse Currency
formatting with the symbol used to identify
absolute cell references (discussed in Section
EG1.7).

Increase Decimal and
Decrease Decimal

Adjusts the number of decimal places to display 
a number value in a cell.

Format Displays a gallery of choices that affect the row
height and column width of a cell. The most
common usage is to select a column and then
select Format ➔ AutoFit Column Width.

T A B L E  F . 1
Shortcuts to Common
Formatting
Operations

2

3

4

5

6

7

8

9

10
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APPENDIX F Additional Excel Procedures 587

Use the Move or Copy command to rearrange the order of the worksheets and chart sheets
in a workbook. To move or copy a worksheet, right-click the worksheet sheet tab and click
Move or Copy in the shortcut menu that appears. In the Move or Copy dialog box, select the
destination workbook from the To book drop-down list—select (new book) to place the work-
sheet in a new workbook—and select a position for the worksheet in the Before sheet list. If
making a copy, also check Create a copy. Click OK to complete the move or copy operation.

Worksheet cell formatting can also be done through the Format Cells command. When
editing a worksheet, right-click a cell and then click Format Cells from the shortcut menu. In
the Format Cells dialog box that appears, you can perform all the formatting operations
discussed in Table F.1 and more.

F.2 Useful Keyboard Shortcuts
In Excel, certain keys or keystroke combinations (one or more keys held down as you press
another key) are keyboard shortcuts that act as alternate means of executing common opera-
tions. Table F.2 presents some common shortcuts that represent some of the common Excel
operations described in this book. (Keystroke combinations are shown using a plus sign, as in
Ctrl+C, which means “while holding down the Ctrl key, press the C key.”)

 

F I G U R E  F . 1
Home tab of the Excel
Office Ribbon (with number
labels keyed to Table F.1)

Key Operation

Backspace Erases typed characters to the left of the current position, one
character at a time.

Delete Erases characters to the right of the cursor, one character at a time.

Enter or Tab Finalizes an entry typed into a worksheet cell. Implied by the use of
the verb enter in the Excel Guides.

Esc Cancels an action or a dialog box. Equivalent to the dialog box
Cancel button.

F1 Displays the Excel help system.

Ctrl+C Copies the currently selected worksheet entry or chart label.

Ctrl+V Pastes the currently copied object into the currently selected
worksheet cell or chart label.

Ctrl+X Cuts the currently selected worksheet entry or chart label. You cut,
and not delete, something in order to paste it somewhere else.

Ctrl+B Toggles on (or off) boldface text style for the currently selected object.

Ctrl+I Toggles on (or off) italic text style for the currently selected object.

Ctrl+F Finds a Find what value.

Ctrl+H Replaces a Find what value with the Replace with value.

Ctrl+Z Undoes the last operation.

Ctrl+Y Redoes the last operation.

Ctrl+` Toggles on (or off) formulas view of worksheet.

Ctrl+Shift+Enter Enters an array formula.

Note: Using the copy-and-paste keyboard shortcut, Ctrl+C and Ctrl+V, to copy formulas from one worksheet
cell to another is subject to the same type of adjustment as discussed in Section EG1.7.

T A B L E  F . 2
Useful Keyboard
Shortcuts
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F.3 Verifying Formulas and Worksheets
If you use formulas in your worksheets, you should review and verify formulas before you use
their results. To view the formulas in a worksheet, press Ctrl+` (grave accent key). To restore
the original view, the results of the formulas, press Ctrl+` a second time.

As you create and use more complicated worksheets, you might want to visually examine
the relationships among a formula and the cells it uses (called the precedents) and the cells that
use the results of the formula (the dependents). Select Formulas ➔ Trace Precedents (or
Trace Dependents). When you are finished, clear all trace arrows by selecting Formulas ➔
Remove Arrows.

F.4 Chart Formatting
Excel incorrectly formats the charts created by the In-Depth Excel instructions. Use the for-
matting adjustments in Table F.3 to properly format charts you create. Before applying these
adjustments, relocate a chart to its own chart sheet. To do so, right-click the chart background
and click Move Chart from the shortcut menu. In the Move Chart dialog box, click New Sheet,
enter a name for the new chart sheet, and click OK.

Layout Tab Selection Notes

Chart Title ➔ Above Chart In the box that is added to the chart, 
double-click Chart Title and enter an
appropriate title.

Axes Titles ➔ Primary Horizontal 
Axis Title ➔ Title Below Axis

In the box that is added to the chart, double-
click Axis Title and enter an appropriate title.

Axes Titles ➔ Primary Vertical Axis
Title ➔ Rotated Title

In the box that is added to the chart, double-
click Axis Title and enter an appropriate
title.

Axes Titles ➔ Secondary Horizontal ➔
Axis Title ➔ None and 
Axes Titles ➔ Secondary Vertical Axis 
Title ➔ Rotated Title

Only for charts that contain secondary axes.

Legend ➔ None Turns off the chart legend.

Data Labels ➔ None Turns off the display of values at plotted
points or bars in the charts.

Data Table ➔ None Turns off the display of a summary table on
the chart sheet.

Axes ➔ Primary Horizontal Axis ➔
Show Left to Right Axis (or Show
Default Axis, if listed)

Turns on the display of the X axis.

Axes ➔ Primary Vertical Axis ➔
Show Default Axis

Turns on the display of the Y axis.

Gridlines ➔ Primary Horizontal
Gridlines ➔ None

Turns off the improper horizontal gridlines.

Gridlines ➔ Primary Vertical 
Gridlines ➔ None

Turns off the improper vertical gridlines.

T A B L E  F . 3
Excel Chart Formatting
Adjustments
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Use all of the adjustments in Table F.3, unless a particular set of charting instructions tells
you otherwise. To apply the adjustments, you must be open to the chart sheet that contains the
chart to be adjusted. All adjustments are made by first selecting the Layout tab (under the
Chart Tools heading). If a Layout tab selection cannot be made, the adjustment does not apply
to the type of chart being adjusted. (Excel hides or disables chart formatting choices that do not
apply to a particular chart type.)

Occasionally, when you open to a chart sheet, the chart is either too large to be fully seen
or too small, surrounded by a chart frame mat that is too large. Click the Zoom Out or Zoom
In buttons, located in the lower-right portion of the Excel window frame, to adjust the display.

F.5 Creating Histograms for Discrete Probability Distributions
You can create a histogram for a discrete probability distribution based on a discrete 
probabilities table. For example, to create a histogram based on the Figure 5.2 binomial 
probabilities worksheet, open to the COMPUTE worksheet of the Binomial workbook. 
Select the cell range B14:B18, the probabilities in the Binomial Probabilities Table, and:

1. Select Insert ➔ Column and select the first 2-D Column gallery choice (Clustered
Column).

2. Right-click the chart background and click Select Data.

In the Select Data Source dialog box:

3. Click Edit under the Horizontal (Categories) Axis Labels heading.

4. In the Axis Labels dialog box, enter =COMPUTE!A14:A18 the cell range of the X axis
values. (This cell range must be entered as a formula in the form =SheetName!CellRange.)
Then, click OK to return to the Select Data Source dialog box.

5. Click OK.

In the chart:

6. Right-click inside a bar and click Format Data Series in the shortcut menu.

In the Format Data Series dialog box:

7. Click Series Options in the left pane. In the Series Options right pane, change the Gap
Width slider to Large Gap. Click Close.

Relocate the chart to a chart sheet and adjust the chart formatting by using the instructions in
Section F.4.

F.6 Pasting with Paste Special
Pasting data from one worksheet to another can sometimes cause unexpected side effects.
When the two worksheets are in different workbooks, a simple paste creates an external link to
the original workbook. This can lead to errors later if the first workbook is unavailable when
the second one is being used. Even pasting between worksheets in the same workbook can lead
to problems if what is being pasted is a cell range of formulas.

To avoid such side effects, use Paste Special in these special situations. To use this 
operation, copy the original cell range as you would do normally and select the cell or cell 
range to be the target of the paste. Right-click the target and click Paste Special from the 
shortcut menu. In the Paste Special dialog box (shown on the next page), click Values and then 
click OK. For the first case, Paste Special Values pastes the current values of the cells in the 
first workbook and not formulas that use cell references to the first workbook. For the second 
case, Paste Special Values pastes the current evaluation of the formulas copied and not the 
formulas themselves.
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If you use PHStat2 and have data for a procedure in the form of formulas, use Paste Special
Values to create columns of equivalent values before using the procedure. (PHStat2 will not
work properly if data for a procedure are in the form of formulas.) Paste Special can paste other
types of information, including cell formatting information. For a full discussion of Paste
Special, see the Excel help system.
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G.1 PHStat2 FAQs
What is PHStat2?
PHStat2 is software that makes operating Windows-based
Microsoft Excel as distraction free as possible. As a student
studying statistics, you can focus mainly on learning statis-
tics and not worry about having to fully master Excel first.
PHStat2 contains just about all the statistical methods taught
in an introductory statistics course that can be illustrated
using Excel.

Which versions of Excel are compatible with PHStat2?
PHStat2 works with Excel 2003 and 32-bit versions of Excel
2007 and Excel 2010. PHStat2 does not work with any Excel
version for the Mac. (Mac users can use virtualizing software
to run Microsoft Windows and Excel 2003, 2007, or 2010 on
their systems in order to use PHStat2.)

How do I get started using PHStat2?
Read the instructions in Section D.2 and complete the check-
list. As that section states, be sure to completely review the 
PHStat2 readme file before attempting to add PHStat2 to your 
system.

Where can I find help if I have problems setting up
PHStat2?
If you need help when you set up PHStat2, first review the
“Troubleshooting PHStat2” section of the downloadable
PHStat2 readme file. If you require additional assistance,
visit the PHStat2 website (www.pearsonhighered.com/
phstat) and go to the web page for your version (see next
question) to see if there is any additional information to help
you. If necessary, click the Contact Pearson Technical
Support to contact Pearson Education Customer Technical
Support. (Technical Support staff cannot answer questions
about the statistical applications of PHStat2 or questions
about specific PHStat2 procedures.)

How can I identify which PHStat2 version I have?
Open Microsoft Excel with PHStat2 and select PHStat ➔
Help for PHStat. In the dialog box that appears, note the
XLA and DLL version numbers. If you downloaded and
installed the PHStat2 version designed for this book, both of
these numbers will not be lower than 3.3.

How can I be sure that my version of PHStat2 is up-to-
date?
The PHStat2 setup program that you can download as part
of the online resources for this book (see Appendix C) will
always be the most up-to-date version for use with this book.
Slight revisions of PHStat2 may occur during the lifetime of
this edition. Those revisions will be noted on the PHStat2

website (www.pearsonhighered.com/phstat) and reflected
in the copy of the PHStat2 setup program you can 
download.

Where can I find tips for using PHStat2?
While your classmates and instructor can be the best sources
of tips, you can check the website www.pearsonhighered.
com/phstat for FAQs or the Help file downloadable with
PHStat. 

G.2 Excel FAQs
What does “Compatibility Mode” in the title bar mean?
Excel displays “Compatibility Mode” when the workbook
you are currently using has been previously stored using
the .xls file format that is compatible with all Excel ver-
sions. Compatibility Mode does not affect Excel function-
ality but will cause Excel to review your workbook for
exclusive-to-Excel-2007-or-2010 formatting properties
and objects the next time you save the workbook. (To pre-
serve exclusive features in Excel 2010, select File ➔ Save
As and select Excel Workbook (*.xlsx) from the Save as
type drop-down list. To preserve exclusive features in
Excel 2007, click the Office Button, move the mouse
pointer over Save As, and in the Save As gallery, click
Excel Workbook to save the workbook in the .xlsx file
format.)

If you open any of the Excel data or Excel Guide 
work-books for this book, you will see “Compatibility 
Mode,” as all workbooks for this book have been stored 
using the .xls format. Generally, it makes little difference 
whether you use compatibility mode or not. The one 
exception is when working with PivotTables, as explained 
in Section EG2.7.)

In Excel 2010, how can I specify the custom settings that
you recommend?
Select File ➔ Options. In the Excel Options dialog box,
click Formulas in the left pane, and in the Formulas right
pane, click Automatic under Workbook Calculation and
verify that all check boxes are checked except Enable itera-
tive calculation, R1C1 reference style, and Formulas
referring to empty cells.

In Excel 2007, how can I specify the custom settings that
you recommend?
Click the Office Button and then click Excel Options. In
the Excel Options dialog box, click Formulas in the left
pane, and in the Formulas right pane, click Automatic
under Workbook Calculation and verify that all check boxes

A P P E N D I X  G PHStat2, Excel, and Minitab FAQs

Z07_LEVI0923_06_SE_APPG.QXD  7/24/15  6:33 PM  Page 591

43



592 APPENDICES

are checked except Enable iterative calculation, R1C1 ref-
erence style, and Formulas referring to empty cells.

What Excel security settings will allow the PHStat2 
or Visual Explorations add-in to function properly?
Use the instructions in Appendix Section D.3 for configur-
ing Excel for PHStat2 for both add-ins.

I do not see the menu for the Visual Explorations (or
PHStat2) add-in that I opened. Where is it?
Unlike earlier versions of Excel that allowed add-ins to add
menus to the menu bar, Excel 2007 and 2010 places all add-
in menus under the Add-ins tab. In order to see the menu,
click Add-ins and then click the name of the add-in menu.

How can I install the Analysis ToolPak?
Close Excel and rerun the Microsoft Office or Microsoft
Excel setup program. When the setup program runs, choose
the option that allows you to add components which will be
labeled either as Change or Add or Remove Features. (If
you use Windows 7, open the Programs and Features
Control Panel applet, select the entry for your version or
Office or Excel, and then click Change at the top of the list
of programs.)

In the Installation Options screen, double-click Microsoft
Office Excel and then double-click Add-ins. Click the

Analysis ToolPak drop-down list button and select Run
from My Computer. (You may need access to the original
Microsoft Office setup program to complete this task.)
Upon successful installation, you will see Data Analysis as
a choice in the Analysis group of the Data tab when you
next open Excel.

G.3 FAQs for Minitab
Can I use Minitab Release 14 or 15 with this book?
Yes, you can use the Minitab Guide instructions, written for
Minitab 16, with Release 14 or 15. For certain methods, there
may be minor differences in labeling of dialog box elements.
Any difference that is not minor is noted in the instructions.

Can I save my Minitab worksheets or projects for 
use with Release 14 or 15?
Yes. Select either Minitab14 or Minitab 15 (for a work-
sheet) or Minitab 14 Project (*.MPJ) or Minitab 15 
Project (*.MPJ) (for a project) from the Save as type drop-
down list in the save as dialog box. See Section MG1.3 for 
more information about using the Save Worksheet As and Save 
Project As dialog boxes.
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Self-Test Solutions and Answers to
Selected Even-Numbered Problems
The following represent worked-out solutions to Self-Test Problems and brief answers to most of the even-numbered problems in the text. For
more detailed solutions, including explanations, interpretations, and Excel and Minitab results, see the Student Solutions Manual.

CHAPTER 1

1.2 Grande, medium, and small sizes represent different categories.

1.4 (a) The number of books is a numerical variable that is discrete
because the outcome is a count. (b) The number of liters of milk is a
numerical variable that is continuous because any value within a range of
values can occur. (c) Whether a phone can make international calls is a
categorical variable because the answer can only be yes or no. (d) Same
answer as in (b). (e) Same answer as in (a). (f) Same answer as in (b).

1.6 (a) Categorical (b) Numerical, continuous (c) Numerical, discrete
(d) Numerical, discrete (e) Categorical.

1.8 (a) Numerical, continuous (b) Numerical, discrete (c) Numerical,
continuous (d) Categorical.

1.10 The underlying variable, ability of the students, may be continuous,
but the measuring device, the test, does not have enough precision to
distinguish between the two students.

1.20 (a) All 3,727 full-time first-year students at the university. (b) The
2,821 students who responded to the survey. (c) The proportion of all
3,727 students who studied with other students. (d) The proportion of the
sample of 2,821 responding students who studied with other students.

1.22 (a) Adults living in the United States, aged 18 and older.(b) The 1,000
or more adults living in the United States, aged 18 and older, who were
selected in the sample. (c) Because the 74% is based on the sample, it is
a statistic. (d) Because the 40% is based on the sample, it is a statistic.

1.26 (a) Continous, categorical, categorical, continuous.

1.28 Gender, graduate major, undergraduate major, employment status,
satisfaction with MBA advisory services, and preferred type of computer
are categorical variables. Age, graduate grade point average, undergraduate
grade point average, number of full-time jobs, expected starting salary,
spending for textbooks and supplies, advisory rating, number of text
messages sent in a typical week, and the amount of wealth needed to feel
rich are numerical variables.

CHAPTER 2
2.6 (a) Table of frequencies for all student responses. 

(b) Table based on total percentages:

Table based on row percentages:

ENJOY SHOPPING
FOR CLOTHING
FOR YOURSELF

GENDER

Male Female Total

Yes 20.15 25.69 45.84
No 29.78 24.38 54.16
Total 49.93 50.07 100.00

Table of column percentages

ENJOY SHOPPING
FOR CLOTHING
FOR YOURSELF

GENDER

Male Female Total

Yes 40.35 51.31 45.84
No 59.65 48.69 54.16
Total 100 100 100

Table of row percentages

ENJOY SHOPPING
FOR CLOTHING
FOR YOURSELF

GENDER

Male Female Total

Yes 43.95 56.05 100
No 54.99 45.01 100
Total 49.93 50.07 100

2.10 (a) Table of total percentages:
(b) Females are more prone to say yes than males.

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 14 9 2 25
Female 6 6 3 15
Totals 20 15 5 40

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 35.0% 22.5% 5.0% 62.5%
Female 15.0 15.0 7.5 37.5
Totals 50.0 37.5 12.5 100.0

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 56.0% 36.0% 8.0% 100.0%
Female 40.0 40.0 20.0 100.0
Totals 50.0 37.5 12.5 100.0

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 70.0% 60.0% 40.0% 62.5%
Female 30.0 40.0 60.0 37.5
Totals 100.0 100.0 100.0 100.0

Table based on column percentages;

2.8 (a) The percentages are 17.18, 5.21, 22.28, and 55.33. (b) More
than half the oil consumed is from countries other than the U.S., Japan,
and developed Europe. More than 20% is consumed by the U.S. and
slightly less than 20% is consumed by developed Europe.
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(c) The bulbs produced by Manufacturer B have a longer life, as the
cumulative percentages (less than type) are uniformly lower for B than 
for A.

2.24 (b) The Pareto chart is best for portraying these data because 
it not only sorts the frequencies in descending order but also provides 
the cumulative line on the same chart. (c) You can conclude that
friends/family account for the largest percentage, 40%. When news 
media, online user reviews and other are added to friends/family, this
accounts for 83%.

2.26 (b) 88%. (d) The Pareto chart allows you to see which sources
account for most of the electricity.

2.28 (b) Since electricity consumption is spread over many types of
appliances, a bar chart may be best in showing which types of appliances
used the most electricity. (c) Clothes washers, air conditioning and
lighting are the major categories of consumption.

2.30 (b) A higher percentage of females enjoy shopping for 
clothing.

2.32 The percentage of online retailers who require three or more 
clicks to be removed from an e-mail list has increased drastically from 
2008 to 2009.

2.12 The percentage of online retailers who require three or more clicks to
be removed from an e-mail list has increased drastically from 2008 to 2009.

2.14 73 78 78 78 85 88.

2.16 (a) The boundaries are: 21.6 30.067 38.533 47 55.467 63.933 72.4
80.867 89.333 97.8 (b) 8.467 (c) 25.83, 34.30, 42.77, 51.23, 59.70, 68.17,
76.63, 85.10, 93.57.

2.18 (a) Electricity Costs Frequency Percentage

$90 up to $99 3 7.5
$100 up to $119 6 15
$120 up to $139 5 12.5
$140 up to $159 11 27.5
$160 up to $179 7 17.5
$180 up to $199 5 12.5
$200 up to $219 3 7.5

(b) Electricity Cumulative
Costs Frequency Percentage %

$ 99 3 7.5 7.5
$119 6 15 22.5
$139 5 12.5 35
$159 11 27.5 62.5
$179 7 17.5 80
$199 5 12.5 92.5
$219 3 7.5 100

(c) The majority of utility charges are clustered between $140 and $180.

2.20 (a) 

(b)  

Stem
unit: 10

11 5 
12 17
13 2
14 1
15 1 8
16 0 1 2 8
17 0 2 3 8
18 0 4
19
20 7 8
21 2 6 7

Stem
unit: 10

22 1 2 7 7
23
24
25 0
26
27
28
29
30
31 6
32

Stem
unit: 10

33 0 5
34
35
36
37
38
39
40
41

(b) The results are concentrated between $160 and $227.

2.38 (c) The majority of utility charges are clustered between $140 and $159.

2.40 The property taxes per capita appear to be right-skewed, with
approximately 90% falling between $399 and $1,700 and the remaining
10% falling between $1,700 and $2,100. The center is at about $1,000.

2.42 (c) All the troughs will meet the company’s requirements of between
8.31 and 8.61 inches wide.

2.44 No, the scatter does not show any pattern. There  does not seem to be
a relationship between X and Y.

2.46 (b) Yes, there is a strong positive relationship between X and Y. As X
increases, so does Y.

2.48 (c) There appears to be very little relationship between the first weekend
gross and either the U.S. gross or the worldwide gross of Harry Potter movies.

2.50 (a) and (c) There appears to be a positive relationship between the
coaches’ salary and revenue. Yes, this is borne out by the data.

2.52 (b) There is a great deal of variation in the returns from decade to
decade. Most of the returns are between 5% and 15%. The 1950s, 1980s,
and 1990s had exceptionally high returns, and only the 1930s and 2000s
had negative returns.

2.36 (a)

2.34 50 74 74 76 81 89 92.

Bulb Life (hrs) Frequency % Frequency
Cumulative 
%age freq.

650–749 3 10 10.00
750–849 5 16.67 26.67
850–949 20 66.67 93.33
950–1049 2 6.67 100.00
Total 30 100

Bulb Life (hrs) Frequency % Frequency
Cumulative 
%age freq.

750–849 2 5 5.00
850–949 8 20 25.00
950–1049 16 40 65.00
1050–1149 9 22.5 87.50
1150–1249 5 12.5 100.00
Total 40 100

Width Frequency Percentage

8.310–8.359 5 12.5
8.360–8.409 6 15
8.410–8.459 20 50
8.460–8.509 9 22.5
8.510–8.609 0 0

Width Cumulative Frequency

8.310 12.5
8.360 27.5
8.410 77.5
8.460 100
8.510 100

(c) All the troughs will meet the company’s requirements of between 8.31
and 8.61 inches wide.

2.22 (a) (b) Manufacturer A

Manufacturer B
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2.54 (b) There has been a slight decline in movie attendance between 2001
and 2010. During that time, movie attendance increased from 2002 to 2004
but then decreased to a level below that in 2001.

2.56 (a)
(b) Although the ratio of fee-yes to fee-no bond funds for intermediate
government category seems to be about 2-to-3 (19% to 31%), the ratio for
above-average-risk intermediate government bond funds is closer to 1-to-1
(8.9% to 9.4%). While the group “intermediate government funds that do
not charge a fee” has nearly equal numbers of above average risk, average
risk, and below risk funds, the group “short term corporate bond funds that
do not charge a fee” contains about 50% more below-average-risk funds
than above-average-risk ones. The pattern of risk percentages differs
between the fee-yes and fee-no funds in each of bond fund categories. 
(c) The results for type, fee, and risk, in the two years are similar.

(b) If the owner is interested in finding out the percentage of males and
females who order dessert or the percentage of those who order a beef
entrée and a dessert among all patrons, the table of total percentages is
most informative. If the owner is interested in the effect of gender on
ordering of dessert or the effect of ordering a beef entrée on the ordering
of dessert, the table of column percentages will be most informative.
Because dessert is usually ordered after the main entrée, and the owner
has no direct control over the gender of patrons, the table of row
percentages is not very useful here. (c) It is apparent from the column
percentages that customers who order the beef entrée are more likely to
order dessert.

2.84 (a) 23575R15 accounts for over 80% of the warranty claims. 
(b) 91.82% of the warranty claims are from the ATX model. (c) Tread
separation accounts for 73.23% of the warranty claims among the ATX
model. (d) The number of claims is evenly distributed among the three
incidents; other/unknown incidents account for almost 40% of the claims,
tread separation accounts for about 35% of the claims, and blowout
accounts for about 25% of the claims.

2.86 (c) The alcohol percentage is concentrated between 4% and 6%, 
with the largest concentration between 4% and 5%. The calories are
concentrated between 140 and 160. The carbohydrates are concentrated
between 12 and 15. There are outliers in the percentage of alcohol in 

2.58 (a)

Count 

of Risk

Fees

No No 

Total

Yes Yes 

Total

Grand 

TotalCategory Average High Low Average High Low

Large cap 95 76 80 251 79 51 69 199 450
Mid-cap 33 41 23 97 22 45 10 77 174
Small cap 52 84 16 152 30 58 4 92 244
Grand 

Total
180 201 119 500 131 154 83 368 868

GENDER
DESSERT
ORDERED Male Female Total

Yes 29.41 70.59 100.00
No 53.03 46.97 100.00
Total 45.00 55.00 100.00

GENDER
DESSERT
ORDERED Male Female Total

Yes 22.22 43.64 34.00
No 77.78 56.36 66.00
Total 100.00 100.00 100.00

BEEF ENTRÉE
DESSERT 
ORDERED Yes No Total

Yes 38.68 61.32 100.00
No 25.85 74.15 100.00
Total 29.25 70.75 100.00

GENDER
DESSERT
ORDERED Male Female Total

Yes 10.00 24.00 34.00
No 35.00 31.00 66.00
Total 45.00 55.00 100.00

BEEF ENTRÉE
DESSERT 
ORDERED Yes No Total

Yes 35.04 22.97 26.50
No 64.96 77.03 73.50
Total 100.00 100.00 100.00

(b) Large-cap funds without fees are fairly evenly spread in risk, while
large-cap funds with fees are more likely to have average or low risk.
Mid-cap and small-cap funds, regardless of fees, are more likely to have
average or high risk.

2.78 (c) Among the main categories as in (a), the publisher gets the
largest portion of revenue, followed by the bookstore. When we consider
the subcategories as well, as done in (b), manufacturing costs, followed
by marketing and promotion and then author, gets the largest share of the
revenues.

2.80 (b) The pie chart may be best since with only three categories, it
enables you to see the portion of the whole in each category. (d) The pie
chart may be best since, with only four categories it enables you to see the
portion of the whole in each category. (e) The online content is not copy-
edited or fact-checked as carefully as print content. Only 41% of the
online content is copy-edited as carefully as print content and only 57%
of the online content is fact-checked as carefully as the print content.

2.82 (a)

BEEF ENTRÉE
DESSERT
ORDERED Yes No Total

Yes 10.25 16.25 26.50
No 19.00 54.50 73.50
Total 29.25 70.75 100.00
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both tails. The outlier in the lower tail is due to the non-alcoholic beer
O’Doul’s with only a 0.4% alcohol content. There are a few beers with
alcohol content as high as around 11.5%. There are a few beers with
calorie content as high as 330 and carbohydrates as high as 32.1. There is
a strong positive relationship between percentage alcohol and calories,
and calories and carbohydrates and a moderately positive relationship
between percentage alcohol and carbohydrates.

2.88 (c) The one-year CD rate is concentrated above 1.20. The five-year
CD rate is concentrated between 2.2 and 2.5. In general, the five-year CD
has the higher yield. There does not appear to be any relationship between
the one-year CD rate and the five-year CD rate at the various banks.

2.90 (a) Frequency (Boston)

Weight (Boston) Frequency Percentage

3,015 but less than 3,050 2 0.54%
3,050 but less than 3,085 44 11.96
3,085 but less than 3,120 122 33.15
3,120 but less than 3,155 131 35.60
3,155 but less than 3,190 58 15.76
3,190 but less than 3,225 7 1.90
3,225 but less than 3,260 3 0.82
3,260 but less than 3,295 1 0.27

(b) Frequency (Vermont)

Weight (Vermont) Frequency Percentage

3,550 but less than 3,600 4 1.21%
3,600 but less than 3,650 31 9.39
3,650 but less than 3,700 115 34.85
3,700 but less than 3,750 131 39.70
3,750 but less than 3,800 36 10.91
3,800 but less than 3,850 12 3.64
3,850 but less than 3,900 1 0.30

Calories Frequency Percentage Limit
Percentage
Less Than

50 but less than 100 3 12% 100 12%
100 but less than 150 3 12 150 24
150 but less than 200 9 36 200 60
200 but less than 250 6 24 250 84
250 but less than 300 3 12 300 96
300 but less than 350 0 0 350 96
350 but less than 400 1 4 400 100

Cholesterol Frequency Percentage Limit
Percentage
Less Than

0 but less than 50 2 8% 50 8%
50 but less than 100 17 68 100 76
100 but less than 150 4 16 150 92
150 but less than 200 1 4 200 96
200 but less than 250 0 0 250 96
250 but less than 300 0 0 300 96
300 but less than 350 0 0 350 96
350 but less than 400 0 0 400 96
400 but less than 450 0 0 450 96
450 but less than 500 1 4 500 100

The sampled fresh red meats, poultry, and fish vary from 98 to 397 calories
per serving, with the highest concentration between 150 to 200 calories. One

Grade X Grade Y

Mean 575.25 574.1667
Standard deviation 3.774917 2.639444

protein source, spareribs, with 397 calories, is more than 100 calories above
the next-highest-caloric food. The protein content of the sampled foods
varies from 16 to 33 grams, with 68% of the values falling between 24 and
32 grams. Spareribs and fried liver are both very different from other foods
sampled—the former on calories and the latter on cholesterol content.

2.94 (b) There is a downward trend in the amount filled. (c) The amount
filled in the next bottle will most likely be below 1.894 liter. (d) The
scatter plot of the amount of soft drink filled against time reveals the
trend of the data, whereas a histogram only provides information on the
distribution of the data.

CHAPTER 3
3.2 (a)
(b) Range 
(c) Z scores: 

None of the Z scores are larger than 3.0
or smaller than or smaller than . There is no outlier. (d) Since the
mean is larger than the median, the distribution is right skewed.

3.4 (a)
(b)
(c) None
of the Z scores is larger than 3.0 or smaller than There is no outlier.
(d) Since the mean is larger than the median, the distribution is right-
skewed.

3.6

(a)

-3.0.
Z scores: 0.958662, -0.5162, -0.88492, -0.76201, 1.204473.
Range = 17, S2 = 66.2, S = 8.136338, CV = -1017.04.

Mean = -0.8, median = -5, mode = NA.

-3.03.0
-1.38527, 1.523798, 0.554109.

 -0.09235, -1.06204, 0.554109, -0.09235,
S = 3.093773, CV = 42.46354%.=  9, S2 = 9.571429,

Mean = 7.285715, median = 7, mode = 7.

2.92 (c)

(d) 0.54% of the Boston shingles pallets are underweight, and 0.27% are
overweight. 1.21% of the Vermont shingles pallets are underweight, and
3.94% are overweight.

Grade X Grade Y, Altered

Mean 575.25 574.8333
Standard deviation 3.774917 3.430258

(c)

(b) If quality is measured by the average inner diameter, Grade X tires
provide slightly better quality because X’s mean is closer to the expected
value, 575 mm. If, however, quality is measured by consistency, Grade Y
provides better quality because, even though Y’s mean is slightly larger
than the mean for Grade X, Y’s standard deviation is much smaller. The
range in values for Grade Y is 7 mm compared to the range in values for
Grade X, which is 8 mm.

When the sixth Y tire measures 570 mm rather than 578 mm, Y’s mean
inner diameter becomes 574.83 mm, which is closer to the norm than X’s
mean inner diameter, and Y’s standard deviation increases from 2.64 mm
to 3.43 mm, which is still less than that of X. So, in this case, Y’s tires are
providing better quality in terms of the mean inner diameter as well as
less variation among the tires than X’s.

3.8 (a)

(b)   

(c) The mean amount is lower than the median, so the data is left skewed.
(d) The mean cost is $6.88 and the median cost is $6.92. So there are few
people spending very little on lunch which makes the range quite high.

Coefficient of variation = 25.795%

Range = 5.67

Standard deviation = 1.774

Median = 6.915

Mean = 6.878

Z08_LEVI0923_06_SE_ANS.QXD  1/16/12  3:30 PM  Page 596

48



Self-Test Solutions and Answers to Selected Even-Numbered Problems 597

3.28 (a)3.10 (a)
(b)

and Z scores are 

(c) Since the mean is less than
the median, the data is left-skewed. (d) The distributions of MPG for
sedans is right-skewed whereas that of the small SUVs is left-skewed. The
mean MPG of sedans (27.214) is much higher than that of small SUVs
(19.53). The median is slightly larger (24.5 for sedans and 21 for SUVs)
and the modes are actually equal (22). The spread (in terms of SD and
variance) is more for sedans but almost equal in terms of range. There is
not any obvious outlier in MPG among the data for either type of cars.

3.12 (a) . (b)
standard 
There is no outlier because none of the Z scores has an absolute value that
is greater than 3.0. (c) The mean cost is higher than the median, so the
data is right skewed.

3.14 (a) . (b)
(c) The data is right skewed 

as median is less than mean. Spread is high, in terms of range as well as
the variance The mean cost is higher than the median, so the data is 
right skewed. (d) (a) (b)

. (c) With the change
in data, the median is unaffected but the mean increases from 82 to 99.
The range and variance has also jumped due to the introduction of this
high outlier.

3.16 (a) (b)

(c) As the mean is higher than the median the data is right skewed.
(d) Now the average and median waiting time are both higher than that
for Bank A branch. The variability is also higher. Overall Bank A seems
to be superior to B in respect of waiting time.

3.18 (a) 5.5, 9. 1.75. (b) 3, 5.5, 7, 9, 12. (c) The data is right-skewed 
as is closer to the median than (d) In Problem 3.2 (d), because
mean = median, the distribution is symmetric. The box part of the graph 
is symmetric, but the tails show right-skewness.

3.20 (a) (b) (c) The data is right-skewed as
is closer to the median than (d) The conclusions are similar in

both cases.

3.22 (a) interquartile 
(b) (c) The boxplot shows that the data 
is more concentrated below the median. The spread above the median is
more. Spread, in terms of interquartile range, is quite high.

3.24 (a) (b) 16, 19, 21, 
22, 26. (c) The boxplot shows that the data is more concentrated above
median and below the third-quartile. The spread below the median and
above the first quartile is more. Spread, in terms of interquartile range, 
is quite low.

3.26 (a) Commercial district five-number summary: 0.38 3.2 4.5 5.55
6.46. Residential area five-number summary: 3.82 5.64 6.68 8.73 10.49.
(b) Commercial district: The distribution is left-skewed. Residential 
area: The distribution is slightly right-skewed. (c) The central 
tendency of the waiting times for the bank branch located in the
commercial district of a city is lower than that of the branch 
located in the residential area. There are a few long waiting times for the
branch located in the residential area, whereas there are a few
exceptionally short waiting times for the branch located in the
commercial area.

interquartile range = 1.5.Q1 = 19, Q3 = 22,

0.55, 0.5975, 0.79, 1.085, 1.51.
range = 0.24375.Q1 = 0.5975, Q3 = 1.085,

Q3.Q1

-8, -7, -5, 7 , 9.-7, 7 , 7.

Q3.Q1

standard deviation = 4.335512, range = 6.67, CV = 29.26615.
Variance = 2.082189,Mean = 7.114667, median = 6.68.

variance = 3100.4, standard deviation = 55.68124
Range = 148,Mean = 99, median = 77.

standard deviation = 18.08498327.0667,
Range = 48, variance =Mean = 82.33333, median = 77

deviation = 0.353213816, range = 0.96, CV = 39.50937542.
Variance = 0.12476,Mean = 0.894, median = 0.78

-3.19278, 0.424939, 0.424939, -0.6087.
-0.09188, -0.09188, 0.597211, 0.769483, 0.252666, 0.252666,

-0.09188, 0.424939, 0.424939, 1.114028,29.7172%,
range = 25, coefficient of variation =S2 = 33.6952, S = 5.80476,

Mean = 19.53333333, median = 21, mode = 22.

Average of 

3-Year Return Risk

Type
Above 

Average Average
Below 

Average
Grand 
Total

Intermediate
government

5.6515 5.7862 4.8214 5.4367

Short-term 
corporate

-0.0440 2.6355 3.2294 2.1156

Grand total 3.1966 4.1583 3.9484 3.7761

(b)

StdDev of 
3-Year Return Risk

Type
Above 

Average Average Below Average Grand Total

Intermediate
government

2.4617 1.1457 1.2784 1.8066

Short-term
corporate

3.6058 1.7034 1.4886 2.6803

Grand total 4.1197 2.1493 1.6001 2.8227

Average of Return
2008 Risk

Type Fees
Above 
Average Average

Below 
Average Grand Total

Intermediate
government

No 9.0294 6.9053 4.0368 6.5709

Yes 3.8863 7.1700 4.5444 4.9937

Intermediate
government total

6.5358 6.99656 4.200 5.9576

Short-term
corporate

No 10.7315 -1.6174 0.4600 -3.2607

Yes -10.2000 -1.6250 0.7250 -3.5941

Short-term 
corporate total

-10.6252 -1.6140 0.492 -3.3237

Grand total -0.8612 2.5450 2.1661 1.316

(c) Across the three different risk levels, intermediate government funds
have the highest average three-year returns but the lowest standard
deviation. (d) Similarly to the 2006–2008 three-year returns, intermediate
government funds have the highest average three-year returns but the
lowest standard deviation across the three different risk levels.

3.30 (a)

StdDev of Return
2008 Risk

Type Fees
Above 
Average Average

Below 
Average Grand Total

Intermediate
government

No 5.6635 3.6998 3.5178 4.7322

Yes 6.5778 2.8744 3.2055 5.0712

Intermediate
government total

6.5675 3.3870 3.3694 4.8999

Short-term
corporate

No 8.6070 4.0613 3.3503 7.1587

Yes 7.2928 5.4013 3.5790 6.9786

Short-term 
corporate total

8.2199 4.3480 3.3220 7.0874

Grand total 11.2319 5.8231 3.8020 7.6530

(b)

(c) The intermediate government funds have the highest average 2008
returns but the lowest standard deviation among all different
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3.60 (a), (b)

Calories Fat

Mean 108.3333 3.375
Median 110 3.25
Standard deviation 19.4625 1.7597
Sample variance 378.7879 3.0966
Range 70 5.5
First quartile 90 1.5
Third quartile 120 5
Interquartile range 30 3.5
Coefficient of variation 17.97% 52.14%

combinations of risk level and whether there is a fee charged with the
exception that they have the highest average 2008 returns and the highest
standard deviation among the below average risk funds that do not charge
a fee. (d) In contrast to the 2008 returns, the intermediate government
funds have the lowest average 2009 returns for all combinations of risk
level and whether the funds charged a fee with the except of the below
average risk funds that do not charge a fee where the intermediate
government funds have the highest average 2008 returns. Unlike the 2008
returns, the intermediate government funds have the lowest standard
deviations only among the above average risk funds that do not charge a
fee, the average risk funds that either charge a fee or do not charge a fee,
and the below average risk funds that charge a fee.

3.32 (a) Population mean, (b) Population standard
deviation, 

3.34 (a) 68%. (b) 95%. (c) Not calculable, 75%, 88.89%. (d) to
or to 19.2.

3.36 (a)

(b) 64.71%, 98.04%, and 100% of these states have mean per capita
energy consumption within 1, 2, and 3 standard deviations of the mean,
respectively. (c) This is consistent with 68%, 95%, and 99.7%, according 

to the empirical rule. (d) (a)

(b) 66%, 98%, and 100% of these states have a mean 
per capita energy consumption within 1, 2, and 3 standard deviations of
the mean, respectively. (c) This is consistent with 68%, 95%, and 99.7%,
according to the empirical rule.

3.38 (a) coefficient of (b) The
relationship is perfectly collinear. for this data, so the relationship
is perfect.

3.40 (a)

(b)

(c) The correlation coefficient is more valuable for expressing the
relationship between calories and sugar because it does not depend on the
units used to measure calories and sugar. (d) There is a strong positive
linear relationship between calories and sugar.

3.42 (a) (b) (c) There is a positive
linear relationship between the coaches’ salary and revenue.

3.56 (a) 3rd quartile =
63. (b)

(c) The distribution is 
right-skewed because there are a few policies that require an
exceptionally long period to be approved. (d) The mean approval 
process takes 43.89 days, with 50% of the policies being approved in 
less than 45 days. 50% of the applications are approved between 18 
and 63 days. About 67% of the applications are approved between 18.6
and 69.2 days.

3.58 (a)
The mean and median width are both 8.42 inches. The range of the widths
is 0.186 inch, and the average scatter around the mean is 0.0461 inch.
(b) 8.312, 8.404, 8.42, 8.459, 8.498. (c) Even though the mean = median,
the left tail is slightly longer, so the distribution is slightly left-skewed.
(d) All the troughs in this sample meet the specifications.

S = 0.0461.Mean = 8.421, median = 8.42, range = 0.186,

standard deviation = 25.28, CV = 57.61%.
Range = 76, interquartile range = 45, variance = 639.2564,
Mean = 43.89, median = 45, 1st quartile = 18,

r = 0.7903cov1X, Y2 = 4,473,270.3

r =
cov 1X, Y2

SX  
SY

=
133.3333

146.9042213.38772 = 0.8391.

cov1X, Y2 =
a

n

i=1
1Xi -  X  21Yi - Y 2

n - 1
=

800
6

= 133.3333.

Y = 3X
correlation = 1.Covariance = 59.35537,

3,773.34.

 

711,905,533.6

50
= 14,238,110.67, standard deviation = 114,238,110.67 =

Mean =
642,887

50
= 12,857.74, variance =

standard deviation = 114,959,700.52 = 3,867.78.14,959,700.52,

Mean =
662,960

51
= 12,999.22, variance =

762,944,726.6

51
=

-2.8m + 4s
m - 4s

s = 1.656217.
m = 5.916667. (c) The distribution of calories and total fat are symmetrical.

(d)

(e) The number of calories of the veggie burgers centers around 110, and
its distribution is symmetrical. The amount of fat centers around 3.3 grams
per serving, and its distribution is symmetrical. There is a positive linear
relationship between calories and fat.

3.62 (a) Boston: 0.04, 0.17, 0.23, 0.32, 0.98; Vermont: 0.02, 0.13, 0.20,
0.28, 0.83. (b) Both distributions are right-skewed. (c) Both sets of
shingles did quite well in achieving a granule loss of 0.8 gram or less.
Only two Boston shingles had a granule loss greater than 0.8 gram. The
next highest to these was 0.6 gram. These two values can be considered
outliers. Only 1.176% of the shingles failed the specification. Only one of
the Vermont shingles, had a granule loss greater than 0.8 gram. The next
highest was 0.58 gram. Thus, only 0.714% of the shingles failed to meet
the specification.

3.64 (a) The correlation between calories and protein is 0.4644. 
(b) The correlation between calories and cholesterol is 0.1777. 
(c) The correlation between protein and cholesterol is 0.1417. 
(d) There is a weak positive linear relationship between calories 
and protein, with a correlation coefficient of 0.46. The positive linear
relationships between calories and cholesterol and between protein 
and cholesterol are very weak.

3.66 (a), (b)

r =
cov 1X, Y2

SX SY
= 0.6969.

Property Taxes per Capita ($)

Mean 1,040.863
Median 981
Standard deviation 428.5385
Sample variance 183,645.2
Range 1,732
First quartile 713
Third quartile 1,306
Interquartile range 593
Coefficient of variation 41.17%

(c), (d) The distribution of the property taxes per capita is right-skewed,
with a mean value of $1,040.83, a median of $981, and an average spread
around the mean of $428.54. There is an outlier in the right tail at $2,099,
while the standard deviation is about 41.17% of the mean. 25% of the
states have property tax that falls below $713 per capita, and 25% have
property taxes that are higher than $1,306 per capita.

CHAPTER 4
4.2 (a) Simple events include selecting a blue ball. (b) Selecting a 
blue ball. (c) The sample space consists of the 14 blue balls and the 
7 yellow balls.
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4.42

4.44 Not all the orders are equally likely
because the teams have a different probability of finishing first through fifth.

4.46
4.48 .

4.50 4,950.

4.60 (a)

56
n! = 6! = 720.

5! = (5)(4)(3)(2)(1) = 120.

(8)(4)(3)(3) = 288.4.4 (a) (b)
(c) (d)

4.6 (a) Mutually exclusive, not collectively exhaustive. (b) Not 
mutually exclusive, not collectively exhaustive. (c) Mutually exclusive,
not collectively exhaustive. (d) Mutually exclusive, collectively
exhaustive.

4.8 (a) Selection of a full-time employed student. (b) Selection of a full-
time employed male student. (c) A full-time employed male student being
or an unemployed male student. Yes, two characteristics are present here:
being female and being employed full-time.

4.10 (a) A respondent who answers quickly. (b) A respondent who
answers quickly who is over 70 years old. (c) A respondent who does
not answer quickly. (d) A respondent who answers quickly and is over
70 years old is a joint event because it consists of two characteristics,
answering quickly and being over 70 years old.

4.12 (a) (b) (c)
(d) The probability

of “is engaged with their workplace or is a U.S. worker” includes the
probability of “is engaged with their workplace” plus the probability of
“is a U.S. worker” minus the joint probability of “is engaged with their
workplace and is a U.S. worker.”

4.14 (a) (b)
(c) (d)

4.16 (a) (b)
(c) (d) Because events
A and B are independent.

4.18 .

4.20 Because and events A and B
are not independent.

4.22 (a) (b) (c)
which is not equal to 

Therefore, answers quickly and
age are not independent.

4.24 (a) (b) (c)
(d)

4.26 (a) (b) (c) Because
and

the two events are not independent.

4.28 (a) 0.0045. (b) 0.012. (c) 0.0059. (d) 0.0483.

4.30 0.1692

4.32 (a) 0.736. (b) 0.997.

4.34 (a)

(b)

4.36 (a)

(b)

4.38

4.40 3*3*5*5*4*6 = 5400

310 = 59,049.

10.036210.30612>0.0307 = 0.3589

P1B ƒdefective2 = P1defective ƒB2 P1B2>P1defective2 =
10.009210.48982 = 0.0307.

P1defective ƒC2 P1C2 = 10.075210.20412 + 10.036210.30612 +
P1defective2 = P1defective ƒA2 P1A2 + P1defective ƒB2 P1B2 +

P1A2 = 0.2041. P1B2 = 0.3061. P1C2 = 0.4898.

P1O2 = 0.175 + 0.15 = 0.325.

P1B¿|O2 =
10.5210.32

10.5210.32 + 10.25210.72 = 0.4615.

P1Needs warranty repair2 = 0.04,
P1Needs warranty repair|Manufacturer based in U.S.2 = 0.0417

0.015>0.4 = 0.0375.0.025>0.6 = 0.0417.

1,649>1,895 = 0.8702.0.1298.
246>1,895 =1,345>1,895 = 0.7098.550>1,895 = 0.2902.

quickly|between 12 and 502 = 0.536.
P(Answersquickly) = 1,243>2,000 = 0.6215
P1Answers707>1,000 = 0.707.536>1,000 = 0.536.

P1A2P1B2 = 0.16,P1A and B2 = 0.2

0.78

P(A>B) = P1A2 = 1>3,40>60 = 2>3 = 0.67.
20>60 = 1>3 = 0.33.10>30 = 1>3 = 0.33.

1,085/1,085 = 1.00.781/1,085
76/1,085.514/ 1,085.

1,895>3,790 - 550>3,790 = 2,141>3790 = 0.5649.
796>3,790 +1,895>3,790 = 0.50.796/3,790 = 0.21.

9>10 = 0.9.35>100 = 7>20 = 0.35.
10>100 = 1>10 = 0.1.60>100 = 3>5 = 0.6.

(c)

(d) for each method of play.

5.6 (a) 3.56. (b) 3.17.

5.8 (a) (b)
. (c) Based on the expected value criteria, you would choose the

common stock fund. However, the common stock fund also has a standard
deviation more than three times higher than that for the corporate bond fund.
An investor should carefully weigh the increased risk. (d) If you chose the
common stock fund, you would need to assess your reaction to the small
possibility that you could lose virtually all of your entire investment.

5.10 (a) 0.0466000. (b) 0.800154. (c) 0.009008.

5.12 (a) 0.000044. (b) 0.0049. (c) 0.8980. (d) 0.102.

5.14 (a) 0.0834. (b) 0.2351. (c) 0.6169. (d) 0.3831.

5.16 Given and 

(a)

(b) P(X = 0) =
n!

x!(n - x)!
 px(1 - p)n-x =

3!
0!3!

 (0.848)010.15223 = 0.0035.

P(X = 3) =
n!

x!(n - x)!
 px(1 - p)n-x =

3!
3!0!

 (0.848)310.15220 = 0.6098.

n = 3,p = 0.848

$195.22
 sY =sX = $57.22; E1Y2 = $63.01.E1X2 = $66.20;

-$0.167

X P(X)

$ - 1 21>36
$ + 1 15>36

X P(X)

$ - 1 21>36
$ + 1 15>36

X P(X)

$ - 1 30>36
$ + 4 6>36

5 .4 (a)

(b)

Age

Goals 18–25 26–40 Total

Getting Rich 405 310 715
Other 95 190 285
Total 500 500 1,000

(b) Simple event: “Has a goal of getting rich.” Joint event: “Has a goal
of getting rich and is between 18–25 years old.” (c) P(Has a goal of getting
rich) (d) P(Has a goal of getting rich and is in the
26–40-year-old group) (e) Not independent.

4.62 (a) 0.158. (b) 0.04. (c) 0.5587.

4.64 (a) 0.4712. (b) Because the probability that a fatality involved a
rollover, given that the fatality involved an SUV, a van, or a pickup is
0.4712, which is almost twice the probability that a fatality involved a
rollover with any vehicle type, at 0.24, SUVs, vans, and pickups are
generally more prone to rollover accidents.

CHAPTER 5
5.2 (a) The expected number of television sets sold every day is 3.46. 
(b) Standard deviation = 1.5324.

= 310>1000 = 0.31.
= 715>1,000 = 0.715.
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6.6 (a) 0.04779. (b) 16.1553. (c) 22.5249. (d) and 

6.8 (a)

(b)

(c)

thousand miles, or

39,920 miles. (d) The smaller standard deviation makes the absolute 
Z values larger. (a)

(b)

(c)
thousand miles, or 41,600 miles.

6.10 (a) 89.22%. (b) 0.6503. (c) 95.46. (d) The percentile value of 85 is
61.24, and the percentile value of 65 in the other exam is 95.22. Scoring
65 is better, and so Option 2 is better.

6.12 (a) 99.18%. (b) 78.74%. (c) 5.48%. (d) 0.9. 

6.14 With 39 values, the smallest of the standard normal quantile values
covers an area under the normal curve of 0.025. The corresponding 
Z value is . The middle (20th) value has a cumulative area of 0.50 
and a corresponding Z value of 0.0. The largest of the standard normal
quantile values covers an area under the normal curve of 0.975, and its
corresponding Z value is

6.16 (a)
interquartile range 

The mean is slightly less than the median. The range is much less
than 6S, and the interquartile range is less than 1.33S. (b) The normal
probability plot does not appear to be highly skewed. The data may be
symmetrical but not normally distributed.

6.18 (a)

There are 62.75%, 78.43%, and 94.12% of the observations that 
fall within 1, 1.28, and 2 standard deviations of the mean, 
respectively, as compared to the approximate theoretical 66.67%, 80%,
and 95%. Because the mean is slightly larger than the median, the
interquartile range is slightly larger than 1.33 times the standard
deviation, and the range is much smaller than 6 times the standard
deviation, the data appear to deviate slightly from the normal distribution.
(b) The normal probability plot suggests that the data appear to be
slightly right-skewed.

6.20 (a)
Because the interquartile range is close to 1.33S

and the range is also close to 6S, the data appear to be approximately
normally distributed. (b) The normal probability plot suggests that the
data appear to be approximately normally distributed.

6.22 (a) Five-number summary: 82 127 148.5 168 213; 

The mean is very close to the median. The five-
number summary suggests that the distribution is approximately
symmetric around the median. The interquartile range is very close to
1.33S. The range is about $50 below 6S. In general, the distribution of 
the data appears to closely resemble a normal distribution. (b) The normal
probability plot confirms that the data appear to be approximately
normally distributed.

6.30 (a) 0.4772. (b) 0.9544. (c) 0.0456. (d) 1.8835. (e) 1.8710 and 2.1290.

6.32 (a) 50%. (b) P(749.97 Y 1330.03) = 50.49%. P(763.34
Y 1336.66) = 50%. There is minor change in the limits.

6.34 (a) Waiting time will more closely resemble an exponential
distribution. (b) Seating time will more closely resemble a 

…
………

deviation = 31.69.
mode = 130, range = 131, interquartile range = 41, standard 147.06,

mean =

0.0023, 61S2 = 0.0102.
Interquartile range = 0.0025, S = 0.0017, range = 0.008, 1.331S2=

interquartile range = 593,1.33(S) = 569.9562.6(S) = 2,571.2310,
Mean = 1,040.863, median = 981, range = 1,732, 

3.0551.
= 2.5, 1.33(2.2971) =6S = 6(2.2971) = 13.7826,

Mean = 21.12, median = 22, S = 2.2971, range = 10,

+1.96.

-1.96

X = 50 - 0.841102 = 41.60.0228 + 11.0 - 0.84132 = 0.1815.

+ P1Z 7 1.002 =P1X 6 302 + P1X 7 602 = P1Z 6 -2.002
6 Z 6 02 = 0.4452.P134 6 X 6 502 = P1-1.60

=
X - 50

12
,  X = 50 - 0.841122 = 39.92Z = -0.84

0.20,P1Z 6 -0.842 �0.0475 + 11.0 - 0.79672 = 0.2508.

P1X 6 302 + P1X 7 602 = P1Z 6 -1.672 + P1Z 7 0.832 =
P134 6 X 6 502 = P1-1.33 6 Z 6 02 = 0.4082.

+ 23.451.-23.451(c)

.

(d)

5.18 (a) 0.354275. (b) 0.0470665. (c) 0.0008913. (d) 0.112599.

5.20 (a) 0.05213. (b) 0.02964. (c) 0.91823.

5.22 (a)

(b) 

(c)

(d)

5.24 (a) (b)
(c)

5.26 (a) 0.0458. (b) 0.74465.  (c) 0.81974. (d) 288.

5.28 (a) 0.2618. (b) 0.8478. (c) Because Ford had a lower mean rate of
problems per car in 2009 compared to Dodge, the probability of a
randomly selected Ford having zero problems and the probability of no
more than two problems are both higher than Dodge.

5.30 (a) 0.2441. (b) 0.8311. (c) Because Dodge had a lower mean rate of
problems per car in 2009 compared to 2008, the probability of a randomly
selected Dodge having zero problems and the probability of no more than
two problems are both lower in 2009 than in 2008.

5.36 (a) 0.64. (b) 0.64. (c) 0.3020. (d) 0.0060. (e) The assumption of
independence may not be true.

5.38 (a) If and 
(b) If and 

5.40 (a) 0.3585. (b) 0.7358. (c) 0.2642. (d) (e) There is a substantial
reduction in the probability of defective parts in the batches of 20.

5.42 (a) (b)
(c) (d)
(e)

5.44 (a) If and 
(b) If and (c) If and

(d) Based on the results in (a)–(c), the
probability that the Standard & Poor’s 500 Index will increase if there is an
early gain in the first five trading days of the year is very likely to be close
to 0.90 because that yields a probability of 80.97% that at least 34 of the 
39 years the Standard & Poor’s 500 Index will increase the entire year.

5.46 (a) 0.001238. (b) 0.2552. (c) The mean number of buyers is 40.
Standard 

CHAPTER 6
6.2 (a) 0.907347. (b) 0.092653. (c) 0.961. (d) and  .

6.4 (a) (b) 1.03643. (c) (d) .1.43953-0.818626.-1.28155.

+1.03944-1.03944

deviation = 2.828.

n = 39, P(X Ú 34) = 0.8097.
p = 0.90n = 39, P(X Ú  34) = 0.0109.p = 0.70

n = 39, P(X Ú  34) = 0.00000121.p = 0.50

P(X Ú 10) = 0.9721.
P(X … 10) = 0.0719.P(X = 15) = 0.1599.
s = 2np(1 - r) = 2.0861.m = np = 13.6

1.

n = 12, P(X Ú 9) = 0.6488.p = 0.75
P(X Ú 9) = 0.0730.n = 12,p = 0.50

P(X Ú 2) = 0.8662.
P(X Ú  1) = 0.9704.P(X = 0) = 0.0296.

= 0.2945.

P(X = 4 or X = 5) = P(X = 4) + P(X = 5) =
e-6(6)4

4!
+

e-61625
5!

P1X Ú 52 = 1 - P1X 6 52 = 1 - 0.2851 = 0.7149.

P(X = 5) =
e-61625

5!
= 0.1606.

 = 0.2851.

+ 0.133853
 = 0.002479 + 0.014873 + 0.044618 + 0.089235

 =
e-6(6)0

0!
+

e-6(6)1

1!
+

e-6(6)2

2!
+

e-6(6)3

3!
+

e-61624
4!

+P(X = 4)
P(X 6 5) = P(X = 0) + P(X = 1) + P(x = 2) + P(X = 3)

= 1310.848) (0.152)  = 0.6218

E1X2 = np = 310.8482 = 2.544  sX = 1np11 - p2
=

3!
2!1!

 (0.848)2(0.152)1 +
3!

3!0!
 (0.848)310.15220 = 0.9377

P1X Ú 22 = P1X = 22 + P1X = 32
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normal distribution. (c) Both the histogram and normal probability 
plot suggest that waiting time more closely resembles an exponential
distribution. (d) Both the histogram and normal probability plot suggest
that seating time more closely resembles a normal distribution.

6.36 (a) 0.841345. (b) 0.873451. (c) 0.02275. (d) Top 90-th percentile of
average user = 71.97. P(Y > 71.97) = 0.7638.

CHAPTER 7
7.2 Sample without replacement: Read from left to right in three-digit
sequences and continue unfinished sequences from the end of the row to
the beginning of the next row:
Row 05: 338 505 855 551 438 855 077 186 579 488 767 833 170
Rows 05–06: 897
Row 06: 340 033 648 847 204 334 639 193 639 411 095 924
Rows 06–07: 707
Row 07: 054 329 776 100 871 007 255 980 646 886 823 920 461
Row 08: 893 829 380 900 796 959 453 410 181 277 660 908 887
Rows 08–09: 237
Row 09: 818 721 426 714 050 785 223 801 670 353 362 449
Rows 09–10: 406
Note: All sequences above 902 and duplicates are discarded.

7.4 A simple random sample would be less practical for personal
interviews because of travel costs (unless interviewees are paid to go to a
central interviewing location).

7.6 Here all members of the population are equally likely to be selected,
and the sample selection mechanism is based on chance. But selection of
two elements is not independent; for example, if A is in the sample, we
know that B is also and that C and D are not.

7.8 (a)

Row 16: 2323 6737 5131 8888 1718 0654 6832 4647 6510 4877
Row 17: 4579 4269 2615 1308 2455 7830 5550 5852 5514 7182
Row 18: 0989 3205 0514 2256 8514 4642 7567 8896 2977 8822
Row 19: 5438 2745 9891 4991 4523 6847 9276 8646 1628 3554
Row 20: 9475 0899 2337 0892 0048 8033 6945 9826 9403 6858
Row 21: 7029 7341 3553 1403 3340 4205 0823 4144 1048 2949
Row 22: 8515 7479 5432 9792 6575 5760 0408 8112 2507 3742
Row 23: 1110 0023 4012 8607 4697 9664 4894 3928 7072 5815
Row 24: 3687 1507 7530 5925 7143 1738 1688 5625 8533 5041
Row 25: 2391 3483 5763 3081 6090 5169 0546
Note: All sequences above 5,000 are discarded. There were no repeating
sequences.

(b) 089 

(c) With the single exception of invoice 0989, the invoices selected in the
simple random sample are not the same as those selected in the
systematic sample. It would be highly unlikely that a simple random
sample would select the same units as a systematic sample.

7.10 Before accepting the results of a survey of college students, you
might want to know, for example: Who funded the survey? Why was it
conducted? What was the population from which the sample was
selected? What sampling design was used? What mode of response was
used: a personal interview, a telephone interview, or a mail survey? Were
interviewers trained? Were survey questions field-tested? What questions
were asked? Were the questions clear, accurate, unbiased, and valid? What
operational definition of “vast majority” was used? What was the
response rate? What was the sample size?

4089 4189 4289 4389 4489 4589 4689 4789 4889 4989
3089 3189 3289 3389 3489 3589 3689 3789 3889 3989
2089 2189 2289 2389 2489 2589 2689 2789 2889 2989
1089 1189 1289 1389 1489 1589 1689 1789 1889 1989

189   289   389   489   589   689   789   889   989

7.12 (a) The four types of survey errors are coverage error, nonresponse
error, sampling error, and measurement error. (b) When people who answer
the survey tell you what they think you want to hear, rather than what they
really believe, this is the halo effect, which is a source of measurement
error. Also, every survey will have sampling error that reflects the chance
differences from sample to sample, based on the probability of particular
individuals being selected in the particular sample.

7.14 Before accepting the results of the survey, you might want to know, for
example: Who funded the study? Why was it conducted? What was the
population from which the sample was selected? What sampling design was
used? What mode of response was used: a personal interview, a telephone
interview, or a mail survey? Were interviewers trained? Were survey
questions field-tested? What other questions were asked? Were the questions
clear, accurate, unbiased, and valid? What was the response rate? What was
the margin of error? What was the sample size? What frame was used?

7.16 (a) 0.0272. (b) 0.2335. (c) 0.02012. (d) 0.65.

7.18 (a) Both means are equal to 6. This property is called unbiasedness.
(c) The distribution for has less variability. The larger sample size
has resulted in sample means being closer to 

7.20 (a) When because the mean is larger than the median, the
distribution of the sales price of new houses is skewed to the right, and so
is the sampling distribution of although it will be less skewed than the
population. (b) If you select samples of the shape of the
sampling distribution of the sample mean will be very close to a normal
distribution, with a mean of $272,400 and a standard deviation of $9,000.
(c) 0.9989. (d) 0.3611

7.22 (a) (b) (c) It is
assumed that the average number of withdrawals follows a normal 

distribution. (d)

7.24 (a) 0.25. (b) 0.05164.

7.26 (a)

(b)

(c)

(d) Increasing the sample size by a factor of 4 decreases the standard
error by a factor of 2.

(a)
(b)
(c)

7.28 (a) 0.0678. (b) 0.5856. (c) 0.0002. (d) (a) 0.1562. (b) 0.5020. 
(c) 0.009.

7.30 (a) 0.0013. (b) 0.0004. (c) Therefore, 
value � 86.

7.32 (a) 0.0336. (b) 0.0000. (c) Increasing the sample size by a factor of 
5 decreases the standard error by a factor of The sampling distribution
of the proportion becomes more concentrated around the true proportion
of 0.59 and, hence, the probability in (b) becomes smaller than that in (a).

7.44 (a) 0.433. (b) 0.7745. (c) 0.0013. (d) 0.1586. (e) 0.93.

15.

P (p 7 0.8615) = 0.90.

P1p 7 0.552 = P1Z 7 2.402 = 1.0 - 0.9918 = 0.0082.
P1p 7 0.552 = P1Z 7 -2.042 = 1.0 - 0.0207 = 0.9793.
P1p 7 0.552 = P1Z 7 1.962 = 1.0 - 0.9750 = 0.0250.

P1p 7 0.552 = P1Z 7 1.202 = 1.0 - 0.8849 = 0.1151.

p = 0.49, sp = A
p11 - p2

n
= A

0.4911 - 0.492
100

= 0.05

P1p 7 0.552 = P1Z 7 -1.0212 = 1.0 - 0.1539 = 0.8461.

p = 0.60, sp = A
p11 - p2

n
= A

0.611 - 0.62
100

= 0.04899.

P1p 7 0.552 = P1Z 7 0.982 = 1.0 - 0.8365 = 0.1635.

p = 0.501, sp = A
p11 - p2

n
= A

0.50111 - 0.5012
100

= 0.05

X ~N128, 
6

249
= 0.85712 , P1X … 28.72142 = 0.8.

P1X … 29.00992 = 0.8.P1X Ú 302 = 0.04779.

n = 100,
X

n = 2,

m.
n = 3
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7.46 (a) 0.9522. (b) 0.70. (c) 0.771.

7.48 (a) 0.5319. (b) 0.9538. (c) 0.9726.

CHAPTER 8
8.2

8.4Yes, it is true because 5% of intervals will not include the population mean.

8.6 (a)You would compute the mean first because you need the mean to
compute the standard deviation. If you had a sample, you would compute the
sample mean. If you had the population mean, you would compute the
population standard deviation. (b) If you have a sample, you are computing
the sample standard deviation, not the population standard deviation needed
in Equation (8.1). If you have a population and have computed the population
mean and population standard deviation, you don’t need a confidence interval
estimate of the population mean because you already know the mean.

8.8 Length 

8.10 (a)

(b) No, the manufacturer cannot support a claim that the bulbs have a
mean of 400 hours. Based on the data from the sample, a mean of 
400 hours would represent a distance of 4 standard deviations above the
sample mean of 350 hours. (c) No. Because is known and , from
the Central Limit Theorem, you know that the sampling distribution of 
is approximately normal. (d) The confidence interval is narrower, based on
a population standard deviation of 80 hours rather than the original standard

deviation of 100 hours. 

Based on the smaller standard deviation, a mean of 400 hours
would represent a distance of 5 standard deviations above the sample
mean of 350 hours. No, the manufacturer cannot support a claim that the
bulbs have a mean life of 400 hours.

8.12 (a) 2.3060. (b) 3.3554. (c) 2.0395. (d) 1.9977. (e) 1.8331.

8.14
The outlier changes the mean and increases the standard

deviation by a large amount and hence the length of the interval becomes
very large.

8.16 (a) (b) The quality
improvement team can be 95% confident that the population mean
turnaround time is between 29.44 hours and 34.56 hours. (c) The project
was a success because the initial turnaround time of 68 hours does not fall
within the interval.

8.18 (a) (b) You can be 95% confident that the
population mean amount spent for lunch at a fast-food restaurant is
between $5.64 and $8.42.

8.20 (a)

(b) The interval indicates that with a probability of 0.95, the MPG of
small SUVs will lie between 19 and 22. (c) The results of 8.19 (a) and
8.20 (a) indicate that with 0.95 probability, the mileage of a family sedan
will be more than that of a small SUV.

8.22 (a) (b) The number of days is approximately
normally distributed. (c) No, the outliers skew the data. (d) Because the
sample size is fairly large, at the use of the t distribution is
appropriate.

8.24 (a) (b) Assumption required is
normality of the cost. (c) Using the answer to 3.12, the data is right
skewed, so the assumption is not very justified here.

0.641321273 … m … 1.146678727.

n = 50,

31.12 … m … 54.96.

interval = X ; t # S

2n
= (19.1375913 … m … 22.32907537).

5.64 … m … 8.42.

32 ; (2.0096)(9)>150; 29.44 … m … 34.56

… 5.46332818.
1.53667182 … m-1.599707192 … m … 13.26637386,

m … 369.6.

330.4 …X ; Z # s1n
= 350 ; 1.96 # 80

164
,

X
n = 64s

X ; Z # s1n
= 350 ; 1.96 # 100

164
; 325.50 … m … 374.50.

= 2 Z # s1n
= 2 * 1.95 *

s

1100
 = 0.39 s.

119.12 … m … 130.88.

8.26

8.28 (a)

; (b) The manager in charge of

promotional programs concerning residential customers can infer that the
proportion of households that would purchase an additional telephone
line if it were made available at a substantially reduced installation cost is
somewhere between 0.22 and 0.32, with 99% confidence.

8.30 (a) (b) No, you cannot, because the interval
estimate includes 0.50 (50%). (c) Yes, you 
can, because the interval is above 0.50 (50%). (d) The larger the sample
size, the narrower the confidence interval, holding everything else
constant.

8.32 (a) (b) (c) Many more
people think that e-mail messages are easier to misinterpret.

8.34

8.36

8.38 (a) We require means Use 

(b) We require which means Use 

employees. 

8.40

8.42 (a) (b)

8.44 (a) (b) (c) (d) When there is more
variability in the population, a larger sample is needed to accurately
estimate the mean.

8.46 (a) (b)
(c) (d) (a)

(b) (c)

8.48 (a) If you conducted a follow-up study to estimate the population
proportion of individuals who view oil companies favorably, you would
use in the sample size formula because it is based on past
information on the proportion. (b)

8.54 The 99% confidence interval for average number of customers is 

Hence, So there is less 

than 1% chance of getting a daily count of less than 951. So the strategy
seems to be effective.

8.56 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.58 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.60 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.62 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.64 (a) (b)

8.66 (a) (b) With 95% confidence, the population
mean width of troughs is somewhere between 8.41 and 8.43 inches. 

8.41 … m … 8.43.

$1,581.24 …   m …  1,727.30.  n = 27.

(n = 423)
n = 423.

n = 110.0.2027 … p … 0.3973.$36.66 … m … $40.42.

(n = 423)
n = 423.

n = 97.0.3037 … p … 0.4963.$25.80 … m … $31.24.

(n = 121)
n = 121.

n = 35.0.284 … p … 0.676.8.049 … m … 11.351.

(n = 784)
n = 784.

n = 25.0.530 … p … 0.820.14.085 … m … 16.515.

951.0363 … m … 996.9637.974 ; 2.575 
52

234
.

n = 574.
p = 0.84

n = 626.n = 1,479.
n = 1,937.p = 0.07; 0.0542 … p … 0.0858.p … 0.2143.

p = 0.19; 0.1657 …p = 0.28; 0.2522 … p … 0.3078.

n = 554.n = 385.n = 246.

n = 97.n = 167.

n = 385.

n = 246n Ú 245.86.1.96 
200

2n
… 25,

n = 384.n Ú 384.16.1.96 
200

2n
… 20,

n = 601.

n = 27.

0.5099 … p … 0.5498.0.784 … p … 0.816.

0.5062 … p … 0.5338.
0.4762 … p … 0.5638.

0.2189 … p … 0.3211.2.58 A
0.2710.732

500

p =
X

n
=

135
500

= 0.27,  p ; ZA
p11 - p2

n
= 0.27 ;

0.263153 … p … 0.436847.
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(c) The assumption is valid as the width of the troughs is approximately
normally distributed.

8.68 (a) (b) (c) The
amounts of granule loss for both brands are skewed to the right, but the
sample sizes are large enough. (d) Because the two confidence intervals
do not overlap, you can conclude that the mean granule loss of Boston
shingles is higher than that of Vermont shingles.

CHAPTER 9
9.2 so is accepted.

9.4 Reject if or if 

9.6

9.8

9.10 Defendant is guilty; Defendant is innocent. A Type I error
would be not convicting a guilty person. A Type II error would be
convicting an innocent person.

9.12 20 minutes is adequate travel time between
classes. 20 minutes is not adequate travel time
between classes.

9.14 (a) (b) and p-value = 0.008 < 0.05. At the 

5% level, there is evidence that the mean life is different from 375 hours.
The p-value of 0.008 indicates that getting a value lower than by
chance from the null distribution has a 0.8% chance. (c) Interval = 

(d) As the 

95% confidence interval does not include the target population mean
, the conclusion of (a) and (b) are validated.

9.16 (a) (b) and p-value = 0.0558 > 0.05. 

At the 5% level, there is no evidence that the mean amount is different
from 1.0 gallon. The p-value of 0.0558 indicates that getting a value lower
than by chance from the null distribution has a 5.58% chance.

(c) Interval (0.989814, 

1.000186). (d) As the 95% confidence interval includes the target
population mean (=1.0), the conclusion of (a) and (b) are validated.

9.18

9.20

9.22 No, you should not use a t test because the original population is left-
skewed, and the sample size is not large enough for the t test to be valid.

9.24 (a) . Decision rule: Reject 

Test statistic: Decision: 

Since |t-stat | < 2.0301, do not reject . There is not enough evidence to
conclude that the population mean waiting time is different from 3.7 minutes
at the 0.05 level of significance. (b) The sample size of 36 is large enough to
apply the central limit theorem and, hence, you do not need to be concerned
about the shape of the population distribution when conducting the t-test in (a).

9.26 (a) Decision rule: 

Test statistic: t =
(2.55 - 2.50)

0.14
10

= 3.5714291.9842 d.f. = 99

H0 if |t-stat| > H0: m = 2.50 vs. H1: m Z 2.50.

H0

t =
(3.57 - 3.7)

0.8
6

= -0.975.2.0301 d.f. = 35

H0 if |t-stat| > H0: m = 3.7 vs. H1: m Z 3.7

;2.1315.

tSTAT = 4.00.

a1.0 - 1.65 =
0.022

7
, 1.0 + 1.65 

0.022
7
b =

-1.591

Z =
(0.995 - 1.0)

 
0.022

7

= -1.591

(=375)

a360 - 1.65 
50
8

, 360 + 1.65 
50
8
b = (349.6875, 370.3125).

-2.4

Z =
(360 - 375)

50
8

= -2.4

H1: m Z 20 minutes.
H0: m = 20 minutes.

H1:H0:

p-value = 0.1676.

p-value = 0.0456.

ZSTAT 7 2.58.ZSTAT 6 -2.58H0

H0|1.21| 6 1.96

0.1975 … m … 0.2385.0.2425 … m … 0.2856.

Decision: Since |t-stat| > 1.9842 and the p-value of
0.00055 < 0.05, we reject . There is enough evidence to conclude that
the mean retail value is different from $2.50. (b) The p-value is 0.00055.
If the population mean is indeed $2.50, the probability of obtaining a
sample mean that is more than $0.14 away from $2.50 is 0.00055.

9.28 (a) Because do not reject 
There is not enough evidence to conclude that the mean amount spent
for lunch at a fast food restaurant, is different from $6.50. (b) The p-value is
0.4069. If the population mean is $6.50, the probability of observing a sample
of nine customers that will result in a sample mean farther away from the
hypothesized value than this sample is 0.4069. (c) The distribution of the
amount spent is normally distributed. (d) With a small sample size, it is
difficult to evaluate the assumption of normality. However, the distribution
may be symmetric because the mean and the median are close in value.

9.30 (a) Since do not
reject There is no evidence that the mean amount is different from 2
liters. (b) (d) Yes, the data appear to have met the
normality assumption. (e) The amount of fill is decreasing over time, so
the pattern moves towards underweight bottles. The analysis is invalid
since it didn't take the sequential nature of production into account.

9.32 (a) Because reject There is
enough evidence to conclude that mean widths of the troughs is different
from 8.46 inches. (b) The population distribution is normal. (c) Although
the distribution of the widths is left-skewed, the large sample size means
that the validity of the t test is not seriously affected although the data is
left skewed, the large sample size allows you to use the t distribution.

9.34 (a) The mean weight of the tea bags is exactly 5.50 grams so there is
no evidence in favour of the amount being different from 5.5 grams at any
level of significance. (b) There is a definite increasing pattern in the
weight of the teabags, so the analysis gives a misleading picture regarding
the tea-bag-filling operation which seems to be out of order.

9.36

9.38

9.40

9.42

9.44

9.46 (a) There is no evidence to conclude that the
mean hours is less than 36.5 hours. (b) If the population
mean is indeed 36.5, the probability of obtaining a sample mean that is
more than 2 hours lower from 36.5 is 0.0756.

9.48 (a) Because 
reject reject 

(b) The probability of getting a sample mean of 32 minutes or less if the
population mean is 68 minutes is 0.0000. 

9.50 (a) (b) A Type I error occurs when
you conclude that the mean number of customers increased above 900 when
in fact the mean number of customers is not greater than 900. A Type II error
occurs when you conclude that the mean number of customers is not greater
than 900 when in fact the mean number of customers has increased above
900. (c) Because or 
reject There is enough evidence to conclude the population mean
number of customers is greater than 900. (d) The probability that the
sample mean is 900 customers or more when the null hypothesis is 
true is 0.0000.

9.52

9.54 Do not reject 

9.56 (a) Because
or do not reject H0.0.0704  7 0.05,ZSTAT = 1.47 6 1.645

ZSTAT = 1.4726, p-value = 0.0704.

H0.

p = 0.44.

H0.
p-value = 0.0000 6 0.01,tSTAT = 4.4947 7 2.4448

H0: m … 900; H1: m 7 900.

H0.p-value = 0.0000 6 0.01,H0.-28.2843 6 -2.4049,
tSTAT =tSTAT = (32 - 68)>9>150 = -28.2843.

p-value = 0.0756.
tSTAT = 0.0756 7 1.6766.

tSTAT = -2.5280.

tSTAT = 2.7638.

p-value = 0.9162.

p-value = 0.0838.

p-value = 0.0228.

H0.tSTAT = -5.9355 6 -2.0106,

p-value = 0.91.
H0.

|t-stat| 6 2.68 and the p-value of 0.91 7 0.01

H0.-2.306 6 tSTAT = 0.8754 6 2.306,

H0

p-value = 0.00055.
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There is no evidence to show that more than 19.2% of students 
at your university use the Mozilla Foundation web browser. 
(b) Because 
reject There is evidence to show that more than 19.2% of students at
your university use the Mozilla Foundation web browser. (c) The sample
size had a major effect on being able to reject the null hypothesis. (d) You
would be very unlikely to reject the null hypothesis with a sample of 20.

9.58 Decision rule: Reject H0 if
or 

Because we accept There is no evidence to
conclude that the proportion of students is different from 0.60.

9.60 (a) No more than 8% of students at your school are
omnivores. More than 8% of students at your school are
omnivores. (b) Because

or reject 
There is enough evidence to show that the percentage of omnivores at
your school is greater than 8%.

9.70 (a) Buying a site that is not profitable. (b) Not buying a profitable 
site. (c) Type I. (d) If the executives adopt a less stringent rejection criterion
by buying sites for which the computer model predicts moderate or large
profit, the probability of committing a Type I error will increase. Many
more of the sites the computer model predicts that will generate moderate
profit may end up not being profitable at all. On the other hand, the less
stringent rejection criterion will lower the probability of committing a Type
II error because more potentially profitable sites will be purchased.

9.72 (a) Because reject (b)
(c) Because do not reject (d) Because

do not reject (e) Because
do not reject 

9.74 (a) Because do not reject (b) The data
are from a population that is normally distributed. (d) With the exception of
one extreme value, the data are approximately normally distributed. (e) There
is insufficient evidence to state that the waiting time is less than five minutes.

9.76 (a) Because do not reject 
(b) If the null hypothesis is true, the probability 
of obtaining a of or more extreme is 0.0748. (c) Because

reject (d) If 
the null hypothesis is true, the probability of obtaining a of or
more extreme is 0.0021. (e) The data in the population are assumed to be
normally distributed. (g) Both boxplots suggest that the data are skewed
slightly to the right, more so for the Boston shingles. However, the very
large sample sizes mean that the results of the t test are relatively
insensitive to the departure from normality.

9.78 (a) reject (b) (c)
reject (d) (e) Because of the large sample

sizes, you do not need to be concerned with the normality assumption.

CHAPTER 10
10.2 (a) (b) (c) 1.7341. (d) Because

reject 

10.4

10.6 and

There is not enough evidence in favour of 
.m1 7 m2

tSTAT = 2.5621 6 2.8214.

S2
p =
1n1 - 12S2

1 + 1n2 - 12S2
2

1n1 - 12 + 1n2 - 12 =
6 # 42 + 3 # 52

6 + 3
= 19

0.9081 … m1 - m2 … 13.0919.

H0.tSTAT = 3.3075 7 1.7341,
df = 18.t = 3.3075.

p-value = 0.0000.H0.-27.19,
tSTAT =p-value = 0.0000.H0.tSTAT = -21.61,

-3.10tSTAT

p-value = 0.0021.H0.tSTAT = -3.10 6 -1.6973,
-1.47tSTAT

p-value = 0.0748.
H0.tSTAT = -1.47 7 -1.6896,

H0.tSTAT = -1.69 7 -1.7613,

H0.ZSTAT = -1.61 7 -1.645,
H0.-2.0010 6 tSTAT = 0.75 6 2.0010,

H0.ZSTAT = -0.32 7  -1.645,
p-value = 0.0019.H0.tSTAT = 3.248 7 2.0010,

H0.p-value = 0.0001316 6 0.05,ZSTAT = 3.6490 7 1.645
ZSTAT = 3.6490 7 1.645; p-value = 0.0001316.

H1: p 7 0.08.
H0: p … 0.08.

H0.ZSTAT = 1.4434 6 1.96,

ZSTAT =
10.65 - 0.62

A
0.611 - 0.62

200

= 1.4434

p = 0.65.|ZSTAT | 7 1.96
H0: p = 0.60 vs. H1: p Z 0.60.

H0.
ZSTAT = 2.9451 > 1.645,ZSTAT = 2.9451,  p-value = 0016.

10.8 (a) Because or 
reject There is evidence that the mean amount of Goldfish crackers
eaten by children is higher for those who watched food ads than for those
who did not watch food ads. (b) (c) The results
cannot be compared because (a) is a one-tail test and (b) is a confidence
interval that is comparable only to the results of a two-tail test.

10.10 (a) where Populations: 
Decision rule: If or

reject 

Test statistic:

Decision: Because do not reject 
There is not enough evidence to conclude that the mean computer anxiety
experienced by males and females is different. (b)
(c) In order to use the pooled-variance t test, you need to assume that the
populations are normally distributed with equal variances.

10.12 (a) Because reject (b)
(c) The populations of waiting times are approximately normally

distributed. (d)

10.14 (a) Because reject There is
evidence of a difference in the mean surface hardness between untreated
and treated steel plates. (b) This implies that obtaining
an absolute difference as large as 9.06 by chance is very unlikely. (c) You
need to assume that the population distribution of hardness of both
untreated and treated steel plates is normally distributed.
(d)

10.16 (a) We test against The data is 

n1 = 50 n2 = 50

S1 = 26.9 S2 = 30.2

d.f. = 98, 

As |t-stat| > 2.6269, the critical value, we reject . So there is evidence
of a difference in the mean cell phone usage between the two age groups.
(b) As the sample size from each population is large (more than 30), we
do not need any other assumption.

10.18

10.20 (a) BecausetSTAT =
1X1 - X22-1m1 - m22

SpA
1
n1

+
1
n2

- 1.4294.

df = 19.

H0

tSTAT =
1X1 - X22-1m1 - m22

SpA
1
n1

+
1
n2

= -20.631.

S2
p =

(n1 - 1)S2
1 + (n2 - 1)S2

2

(n1 - 1) + (n2 - 1)
= 817.825

X2 = 239X1 = 121

H1: m1 Z m2H0: m1 = m2

Confidence interval = (2.063342, 16.06026).

p-value = 0.0012.

H0.ƒ tSTAT ƒ = 3.539 7 2.0345,

-4.2292 … m1 - m2 … -1.4268.
0.0003.

p-value =H0.tSTAT = -4.1343 6 -2.0484,

p-value = 0.0648.

H0.-1.974 6 tSTAT = 1.859 6 1.974,

 =
140.26 - 36.852 - 0

A140.8489a 1
100

+
1

72
b

= 1.859.

 tSTAT =
1X1 - X22 - 1m1 - m22

AS 2
p a 1

n1
+

1
n2
b

 =
1992113.3522 + 171219.4222

99 + 71
= 140.8489

 S 2
p =

1n1 - 121S 2
12 + 1n2 - 121S 2

22
1n1 - 12 + 1n2 - 12

H0.tSTAT 7 1.974,
tSTAT 6 -1.974df = 170.H1: m1 Z m2.

1 = Males, 2 = Females.H0: m1 = m2,

5.79 … m1 - m2 … 11.81.

H0.
p-value = 0.0000 6 0.05,tSTAT = 5.7883 7 1.6581

the critical value, we accept So there is not H0.tSTAT = -1.4294 6 2.1448,
enough evidence of a difference in the mean ratings between the two 
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brands. (b) You need to assume that the distribution of the differences
between the two rations is approximately normal. (c)
This implies that obtaining an absolute difference as large as 1.625 by
chance has a 16% probability. (d) Confidence 

So the first population’s mean 

rating can be greater or less than the second.

10.22 (a) Because or 
do not reject There is not enough evidence to

conclude that there is a difference between the mean prices between
Costco and store brands. (b) You must assume that the distribution of the
differences between the prices is approximately normal. (c)

You are 95% confident that the mean difference between the
prices is between -$1.612 and $1.66. (d) The results in (a) and (c) are the
same. The hypothesized value of 0 for the difference in the price of
shopping items between Costco and store brands is within the 95%
confidence interval.

10.24 (a) Because do not reject There is not
enough evidence to conclude that the mean bone marrow microvessel
density is higher before the stem cell transplant than after the stem cell
transplant. (b) The probability that the t statistic for the
mean difference in microvessel density is 1.8425 or more is 5.75% if the
mean density is not higher before the stem cell transplant than after the
stem cell transplant. (c) You are 95% confident
that the mean difference in bone marrow microvessel density before and
after the stem cell transplant is somewhere between and 200.55.
(d) that the distribution of the difference before and after the stem cell
transplant is normally distributed.

10.26 (a) Because reject There is
evidence that the mean strength is lower at two days than at seven days.
(b) The population of differences in strength is approximately normally
distributed. (c)

10.28 (a) Because is below the critical bound of 2.575,
do not reject (b)

10.30 (a) Populations: 
(b) Because reject There is sufficient
evidence to conclude that the population proportion of large online
retailers who require three or more clicks to be removed from an e-mail
list is greater in 2009 than in 2008. (c) Yes, the result in (b) makes it
appropriate to claim that the population proportion of large online
retailers who require three or more clicks to be removed from an e-mail
list is greater in 2009 than in 2008.

10.32 (a) Decision rule: If 
reject 

Test statistic: 

reject There is evidence of a difference in
the proportion who believe that e-mail messages should be answered
quickly between the two age groups. (b) The
probability of obtaining a difference in proportions that gives rise to a test
statistic below or above is 0.0000 if there is no
difference in the proportion of people in the two age groups who believe
that e-mail messages should be answered quickly.

10.34 (a) Because reject There is evidence
of a difference in the proportion of adults and users ages 12–17 who
oppose ads. (b) The probability of obtaining a
difference in proportions that is 0.16 or more in either direction is 0.0000

p-value = 0.0000.

H0.ZSTAT = 7.2742 7 1.96,

+7.8837-7.8837

p-value = 0.0000.

H0.ZSTAT = 7.8837 7 2.58,

ZSTAT =
1p1 - p22 - 1p2 - p22
Ap11 - p2a 1

n1
+

1
n2
b

=
10.707 - 0.5362 - 0

A0.621511 - 0.62152a 1

1,000
+

1

1,000
b

.

p =
X1 + X2

n1 + n2
=

707 + 536
1,000 + 1,000

= 0.6215

H0.
ƒZSTAT ƒ 7 2.58,H0: p1 = p2. H1: p1 Z p2.

H0.ZSTAT = 4.70472 7 1.645
1 = 2009, 2 = 2008.H0: p1 … p2.  H1: p1 7 p2.

-0.19418 … p1 - p2 … 0.134184.H0.
ZSTAT = -0.3467

p = 0.000.

H0.tSTAT = -9.3721 6 -2.4258,

-28.26

-28.26 … mD … 200.55.

p-value = 0.0575.

H0.tSTAT = 1.8425 6 1.943,

mD … $1.66.
-$1.612 …

H0.0.9743 7 0.05,
p-value =-2.2622 6 tSTAT = 0.0332 6 2.2622

tSpA
1
n1

+
1
n2

= 1-4.0633, 0.81332.
interval = 1X1 - X22 ;

p-value = 0.1626.
if there is no difference between the proportion of adults and users ages
12–17 who oppose ads.

10.36 (a) 2.21. (b) 2.48 (c) 3.55.

10.38 (a) Population B: (b) 1.7857.

10.40

10.42 Because is less than F critical, do not reject 

10.44 (a) Since do not reject 
(b) F We accept 

10.46 (a)

Decision rule: If reject 

Test statistic: 

Decision: Because reject There is 
evidence to conclude that the two population variances are different. 
(b) (c) The test assumes that each of the two
populations is normally distributed. (d) Based on (a) and (b), a 
separate-variance t test should be used.

10.48 (a) Because or 
reject There is evidence of a difference in the variability of the battery 
life between the two types of digital cameras. (b) The
probability of obtaining a sample that yields a test statistic more extreme than
5.1802 is 0.0002 if there is no difference in the two population variances. 
(c) The test assumes that each of the two populations are normally distributed.
(d) Based on (a) and (b), a separate-variance t test should be used.

10.50 Because or 
reject There is evidence of a difference in the variance of the yield at
the two time periods.

10.52 (a) (b) (c)
(d)

10.54 (a) 3. (b) 20. (c) 23.

10.56 (a) Reject if (b) Because 
accept (c) There are degrees of freedom in the numerator and

degrees of freedom in the denominator. The
critical value is, (d) To perform the Tukey-Kramer procedure,
the critical range is 8.55. 

10.58 (a) and

Because the p-value is approximately 0 and 
reject There is sufficient evidence of a difference in the mean strength
of the four brands of trash bags. 

(b)

From the Tukey-Kramer procedure, there is a difference in mean strength
between Kroger and Tuffstuff, Glad and Tuffstuff, and Hefty and Tuffstuff.
(c) ANOVA output for Levene’s test for homogeneity of variance:

MSW =
SSW

n - c
=

198.2
36

= 5.5056.

MSA =
SSA

c - 1
=

24.075
3

= 8.025.

 = 4.446.

Critical range = QaA
MSW

2
a 1

nj
+

1
nj¿
b = 3.79A

13.7639
2

a 1
10

+
1

10
b

H0.
FSTAT = 48.1084 7 2.8663,

F0.05,3,36 = 2.8663.

FSTAT =
MSA

MSW
=

662.1583
13.76389

= 48.1084.

MSW =
SSW

n - c
=

495.5
36

= 13.76389.

MSA =
SSA

c - 1
=

1,986.475

3
= 662.1583.

H1: At least one mean is different.
H0: mA = mB = mC = mD

Qu = 3.96.
n - c = 24 - 4 = 20

c = 4H0.
FSTAT = 2.86 6 4.94,FSTAT 7 4.94.H0

FSTAT = 5.44.
MSW = 4.286.MSA = 23.33.SSW = 120.

H0.
p-value = 0.0156 6 0.05,FSTAT = 2.7684 7 2.2693,

p-value = 0.0002.
H0.

p-value = 0.0002 6 0.05,FSTAT = 5.1802 7 2.34

0.0022.p-value =

H0.FSTAT = 2.008 7 1.556,

FSTAT =
S 2

1

S 2
2

=
(13.35)2

(9.42)2
= 2.008.

H0.FSTAT 7 1.556,

H0: s
2
1 = s2

2. H1: s
2
1 Z s2

2.

H0.critical = 3.83.
H0.FSTAT = 1.5064 6 3.09,

H0.FSTAT

dfnumerator = 24, dfdenominator = 20.

S2 = 25.
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Because and do
not reject There is insufficient evidence to conclude that the variances
in strength among the four brands of trash bags are different. (d) From the
results in (a) and (b), Tuffstuff has the lowest mean strength and should be
avoided.

10.60 (a) Because reject (b)
Advertisements A and B are different from Advertisements 

C and D. Advertisement E is only different from Advertisement D. 
(c) Because do not reject There is no
evidence of a significant difference in the variation in the ratings among
the five advertisements. (d) The advertisements underselling the pen’s
characteristics had the highest mean ratings, and the advertisements
overselling the pen’s characteristics had the lowest mean ratings. Therefore,
use an advertisement that undersells the pen’s characteristics and avoid
advertisements that oversell the pen’s characteristics.

10.62 (a) Because the p-value for this test, 0.922, is greater than the level
of significance, (or the computed F test statistic, 0.0817, is less
than the critical value ), you cannot reject the null hypothesis.
You conclude that there is insufficient evidence of a difference in the
mean yield between the three methods used in the cleansing step.
(b) Because there is no evidence of a difference between the methods,
you should not develop any multiple comparisons. (c) Because the p-value
for this test, 0.8429, is greater than the level of significance, 
(or the computed F test statistic, 0.1728, is less than the critical value,

), you cannot reject the null hypothesis. You conclude that
there is insufficient evidence of a difference in the variation in the yield
between the three methods used in the cleansing step. (d) Because there
is no evidence of a difference in the variation between the methods, the
validity of the conclusion reached in (a) is not affected.

10.64 (a) Because reject 
(b) (using 30 degrees of freedom). Designs 3 and 4
are different from Designs 1 and 2. Designs 1 and 2 are different from
each other. (c) The assumptions are that the samples are randomly and
independently selected (or randomly assigned), the original populations
of distances are approximately normally distributed, and the variances are
equal. (d) Because do not reject There is no
evidence of a significant difference in the variation in the distance among
the four designs. (e) The manager should choose Design 3 or 4.

10.76 (a) $0.59 coffee: (or 
), so reject There is evidence that reducing the price to

$0.59 has increased mean daily customer count. $0.79 coffee:
(or ), so reject 

There is evidence that reducing the price to $0.79 has increased mean daily
customer count. (b) Because or 

do not reject There is not enough evidence of a
difference in the variance of the daily customer count for $0.59 and $0.79
coffee. Because or 

do not reject There is insufficient evidence of a
difference in the mean daily customer count for $0.59 and $0.79 coffee.
(c) Since both $0.59 and $0.79 coffee increased daily customer count, 
you should recommend that the price of coffee should be reduced.
However, since there is no significant difference in the mean daily
customer count between the two prices, you should price the coffee at
$0.79 per 12-ounce cup.

10.78 (a) We test 
value So there is no difference in the variability of F15, 86.critical

H0: s
2
G = s2

B , F = 290002>264662 = 1.2 6 2.3 =

H0.0.4500 7 0.05,
p-value =-2.0484 6 tSTAT = 0.7661 6 2.0484

H0.0.5906 7 0.05,
p-value =FSTAT = 1.3407 6 2.9786,

H0.p-value = 0.0277 6 0.05tSTAT = 2.0894 7 1.7613

H0.0.0069 6 0.05
p-value =tSTAT = 2.8167 7 1.7613

H0.FSTAT = 2.093 6 2.92,

Critical range = 5.27
H0.FSTAT = 53.03 7 2.92,

F = 3.6823

a = 0.05

F = 3.6823
a = 0.05

H0.FSTAT = 1.927 6 2.76,

4.67.
Critical range =H0.FSTAT = 12.56 7 2.76,

H0.
FSTAT = 1.4576 6 2.8663,p-value = 0.2423 7 0.05

F0.05,3,36 = 2.8663.

FSTAT =
MSA

MSW
=

8.025
5.5056

= 1.4576.
salaries between master black belts and green belts. (b) As the
variabilities are equal, a pooled-variance t test is appropriate. (c) We 
test vs. The pooled variance one sided

the critical t value. So we reject There is
evidence that the mean salary of master black belts is greater than the
mean salary of green belts.

10.80 (a) We test So there is
evidence of a difference in the variances of the age of students at the
western school and at the eastern school. (b) The result in (a) implies 
that one has to use the unequal variance test procedure. (c) It 
is more appropriate to use separate-variance t-test. (d)

There is no evidence of a difference in the variances of the
years of spreadsheet usage of students at the Western school and at the
Eastern school. (e) As variances are equal, we use the pooled-variance t-
test. so reject There is enough evidence of a
difference in the mean years of spreadsheet usage of students at the
Western school and at the Eastern school.

10.82 (a) Because reject There is enough
evidence to conclude that the introductory computer students required
more than a mean of 10 minutes to write and run a program in Visual
Basic. (b) Because do not reject There is
not enough evidence to conclude that the introductory computer students
required more than a mean of 10 minutes to write and run a program 
in Visual Basic. (c) Although the mean time necessary to complete the
assignment increased from 12 to 16 minutes as a result of the increase 
in one data value, the standard deviation went from 1.8 to 13.2, which
reduced the value of t statistic. (d) Because do
not reject There is not enough evidence to conclude that the population
variances are different for the Introduction to Computers students and
computer majors. Hence, the pooled-variance t test is a valid test to
determine whether computer majors can write a Visual Basic program in
less time than introductory students, assuming that the distributions of the
time needed to write a Visual Basic program for both the Introduction to
Computers students and the computer majors are approximately normally
distributed. Because reject There is enough
evidence that the mean time is higher for Introduction to Computers
students than for computer majors. (e) If the true
population mean amount of time needed for Introduction to Computer
students to write a Visual Basic program is no more than 10 minutes, the
probability of observing a sample mean greater than the 12 minutes in the
current sample is 0.0362%. Hence, at a 5% level of significance, you can
conclude that the population mean amount of time needed for
Introduction to Computer students to write a Visual Basic program is
more than 10 minutes. As illustrated in part (d), in which there is not
enough evidence to conclude that the population variances are different
for the Introduction to Computers students and computer majors, the
pooled-variance t test performed is a valid test to determine whether
computer majors can write a Visual Basic program in less time than
introductory students, assuming that the distribution of the time needed to
write a Visual Basic program for both the Introduction to Computers
students and the computer majors are approximately normally distributed.

10.84 From the boxplot and the summary statistics, both distributions are
approximately normally distributed. There is
insufficient evidence to conclude that the two population variances are
significantly different at the 5% level of significance. 

At the 5% level of significance, there is sufficient evidence to
reject the null hypothesis of no difference in the mean life of the bulbs
between the two manufacturers. You can conclude that there is a significant
difference in the mean life of the bulbs between the two manufacturers.

10.86 Playing a game on a video game system: Because 
and reject There is evidence thatH0.p-value = 0.0000 6 0.05,1.96

ZSTAT = 15.74 7

-1.99.
tSTAT = -5.084 6

FSTAT = 1.056 6 1.89.

p-value = 0.000362.

H0.tSTAT = 4.0666 7 1.7341,

H0.
FSTAT = 1.2308 6 3.8549,

H0.tSTAT = 1.3636 6 1.8595,

H0.tSTAT = 3.3282 7 1.8595,

H0.tSTAT = -5.747 6 -2.6,

=  F119, 92.
F = 1.22 6 1.63

H0: m
2
W = s2

E , F = 10.56 7 1.6 = F92, 119.

H0.tSTAT = -4.97 6 -2.36,
H0: m

2
G 6 m2

B.H0: m
2
G = m2

B
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there is a difference between boys and girls in the proportion who played
a game on a video game system. Reading a book for fun: Because

and reject 
There is evidence that there is a difference between boys and girls in the
proportion who have read a book for fun. Gave product advice to parents:
Because and
do not reject There is insufficient evidence that there is a difference
between boys and girls in the proportion who gave product advice 
to parents. Shopped at a mall: Because 
and reject There is evidence that there 
is a difference between boys and girls in the proportion who shopped 
at a mall.

10.88 The normal probability plots suggest that the two populations are
not normally distributed. An F test is inappropriate for testing the
difference in two variances. The sample variances for Boston and
Vermont shingles are 0.0203 and 0.015, respectively. Because

or reject 
There is sufficient evidence to conclude that there is a difference in the
mean granule loss of Boston and Vermont shingles.

10.90 Population large-cap blend, 2 = small-cap blend, 
3 = mid-cap blend, 4 = Large-cap blend, 5 = diversified emerging
markets; Three-year return: Levene test: Since the

do not reject There is insufficient
evidence to show a difference in the variance of the three-year return
among the 5 different types of mutual funds at a 5% level of significance.

Since the p-value is virtually zero, reject There is
sufficient evidence to show a difference in the mean three-year returns
among the five different types of mutual funds at a 5% level of
significance. Critical range = 2.83. Groups 3 and 4. (Mid-cap blend and
large-cap blend) have lower three-year returns than diversified emerging
markets. All other comparisons are not significant. Five-year return:
Levene test: Since the do not
reject There is insufficient evidence to show a difference in the
variance of the five-year return among the 5 different types of mutual
funds at a 5% level of significance. Since the p-value is
virtually zero, reject There is sufficient evidence to show a difference
in the mean five-year returns among the five different types of mutual
funds at a 5% level of significance. Critical At the 5%
level of significance, there is sufficient evidence that the mean five-year
returns of the diversified emerging market funds is significantly higher
than the others. Also, the mean five-year returns of the large-cap 
blend funds are significantly lower than that of the foreign large-cap
funds. Ten-year return: Levene test: Since the

do not reject There is insufficient evidence
to show a difference in the variance of return among the five different
types of mutual funds at a 5% level of significance. 
Since the p-value is virtually zero, reject There is sufficient evidence
to show a difference in the mean 10-year returns among the five 
different types of mutual funds at a 5% level of significance. Critical

At the 5% level of significance, there is sufficient
evidence that the mean 10-year returns of the diversified emerging market
funds is significantly higher than the others. Expense ratio: Levene test:

Since the do not reject There
is insufficient evidence to show a difference in the variance in expense
ratios among the 5 different types of mutual funds at a 5% level of
significance. Since the 
reject There is sufficient evidence to show a difference in the mean
expense ratio among the five different types of mutual funds at a 5% level
of significance. Critical At the 5% level of significance,
there is sufficient evidence that the mean expense ratio of the
diversified emerging market funds is significantly higher than the 
foreign large-cap funds.

range = 0.479.

H0.
0.0064 6 0.05,p-value =FSTAT = 4.1069.

H0.0.05,p-value = 0.6716 7FSTAT = 0.59.

range = 3.3372.

H0.
FSTAT = 11.9951.

H0.p-value = 0.5407 7 0.05,
FSTAT = 0.7854.

range = 2.3171.

H0.
FSTAT = 62.4531

H0.
p-value = 0.4349 7 0.05,FSTAT = 0.9671.

H0.FSTAT = 14.3127.

H0.0.7971 7 0.05,p-value =
FSTAT = 0.4148.

1 = foreign

H0.p-value = 0.0028 6 a = 0.05,tSTAT = 3.015 7 1.967

H0.p-value = 0.0000 6 0.05,
ZSTAT = -6.7026 6 -1.96

H0.
p-value = 0.4576 7 0.05,-1.96 6 ZSTAT = 0.7427 6 1.96

H0.p-value = 0.0357 6 0.05,ZSTAT = -2.1005 6 -1.96

CHAPTER 11
11.2 (a) For and (b) For and

11.4 (a) All (b) At 
Not significant. 

11.6 (b) Because reject There is enough
evidence to conclude that there is a significant difference between the
proportion of retail websites that require three or more clicks to be
removed from an email list in 2009 as compared to 2008. p-value

The probability of obtaining a test statistic of 28.9102 or larger
when the null hypothesis is true is 0.0000. (c) You should not compare the
results in (a) to those of Problem 10.30 (b) because that was a one-tail test.

11.8 (a) Because 

reject There is evidence of
a difference in the proportion who believe that e-mail messages should be
answered quickly between the two age groups. (b) p-value The
probability of obtaining a difference in proportions that gives rise to a test
statistic greater than 62.152 is 0.0000 if there is no difference in the pro-
portion of people in the two age groups who believe that e-mail messages
should be answered quickly. (c) The results of (a) and (b) are exactly the same
as those of Problem 10.32. The in (a) and the Z in Problem 10.32 (a) satisfy
the relationship that and the p-value in 
(b) is exactly the same as the p-value computed in Problem 10.32 (b).

11.10 (a) Since reject There is evidence
that there is a significant difference between the proportion of adults and
users ages 12–17 who oppose ads on websites. (b) p-value The
probability of obtaining a test statistic of 52.9144 or larger when the null
hypothesis is true is 0.0000.

11.12 (a) The expected frequencies for the first row are 22.46, 31.45,
44.93, and 56.16. The expected frequencies for the second row are 27.54,
38.55, 55.07, and 68.84. (b) Chi-Sq p-
Since the p-value is less than 0.05, the test is not significant at that level. 

11.14 (a) Because the calculated test statistic 
reject and conclude that there is a difference in the proportion who
oppose ads on websites between the age groups. (b) The p-value is
virtually 0. The probability of a test statistic greater than 48.6268 or more
is approximately 0 if there is no difference between the age groups in the
proportion who oppose ads on websites.

11.16 (a) At least one proportion differs.H0: p1 = p2 = p3. H1:

H0

x2
STAT = 48.6268 7 9.4877,

value = 0.105.DF = 3,= 6.141,

0.0000.

H0.x2
STAT = 52.9144 7 3.841,

x2 = 62.152 = Z2 = (7.8837)2,
x2

= 0.0000.

H0.(293 - 378.522>378.5 = 62.152 7 6.635,

1707 - 621.522>621.5 +621.5+ 1464 - 378.522>378.5 +1536 - 621.522>
x2

STAT =H0: p1 = p2. H1: p1 Z p2.

0.0000.
=

H0.x2
STAT = 28.9102 7 3.841,

x2
1 = 2.70.a = 0.1,x2

STAT = 0.6667.fe = 37.5.

a = 0.025, x2 = 2.705543.
df = 1a = 0.05, xa

2 = 2.072251.df = 1

f0 fe ( f0 - fe) ( f0 - fe )
2>fe

48 42.667 5.333 0.667
152 157.333 -5.333 0.181

56 42.667 13.333 4.166
144 157.333 -13.333 1.130

24 42.667 -18.667 8.167
176 157.333 18.667 2.215

16.526

Decision rule: If reject 

Test statistic: 

Decision: Because reject There is a
significant difference in the age groups with respect to major grocery
shopping day. (b) p-value The probability that the test statistic
is greater than or equal to 16.526 is 0.0003, if the null hypothesis is true.

= 0.0003.

H0.x2
STAT = 16.526 7 5.9915,

x2
STAT = a

all cells

(f0 - fe)

fe
= 16.526.

H0.x2
STAT 7 5.9915,df = (c - 1) = (3 - 1) = 2.
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11.18 (a) Because reject There is evidence
of a difference in the percentage who often listen to rock music among
the age groups. (b)

11.20

11.22 reject and conclude that there is
evidence of a relationship between the type of dessert ordered and the
type of entrée ordered.

11.24 (a) There is no relationship between the commuting time of
company employees and the level of stress-related problems observed
on the job. There is a relationship between the commuting time of
company employees and the level of stress-related problems observed
on the job.

H1:

H0:

H0x2
STAT = 92.1028 7 16.919,

df = (r - 1)(c - 1) = (4 - 1)(5 - 1) = 12.

p-value = 0.0388.

H0.x2
STAT = 6.50 7 5.9915, CHAPTER 12

12.2 (a) Yes. (b) Yes. (c) No. (d) Yes.

12.4 (a) The scatter plot shows a positive linear relationship. (b) For each
increase in shelf space of an additional foot, predicted weekly sales are
estimated to increase by $7.40. (c)

or $204.20.

12.6 (b) (c) For every cubic foot increase in the
amount moved, predicted labor hours are estimated to increase by 0.0501.
(d) 22.67 labor hours.

12.8 (b) The regression equation is Horsepower.
(c) If horsepower increases by 1 unit, a car’s MPG performance is
expected to decrease by 0.0314 units. (c) .

12.10 (b) (c) For each increase of one million
dollars of box office gross, the predicted DVD revenue is estimated to increase
by $0.3839 million. (d)

million.

12.12 means 84.21% of total variation is

explained by the regression.

12.14 implies 66.67% of total

variation is explained by the regression equation.

12.16 (a) 68.4% of the variation in sales 

can be explained by the variation in shelf space. 

(b)

(c) Based on (a) and (b), the model should be useful for predicting sales.

12.18 (a) 88.92% of the variation in labor hours can be
explained by the variation in cubic feet moved. (b)
(c) Based on (a) and (b), the model should be very useful for predicting
the labor hours.

12.20 (a) . 34.6% of the total variance is explained by the
linear regression. (b) (c) Going by 34.6% coefficient of
determination, it does not seem that horsepower is a good predictor of
MPG, since it explains only 34.6% of the total variation.

12.22 (a) 54.52% of the variation in DVD revenue can be
explained by the variation in box office gross. (b) The
variation of DVD revenue around the prediction line is $15.3782 million.
The typical difference between actual DVD revenue and the predicted
DVD revenue using the regression equation is approximately $15.3782
million. (c) Based on (a) and (b), the model is useful for predicting DVD
revenue. (d) Other variables that might explain the variation in DVD
revenue could be the amount spent on advertising, the timing of the
release of the DVDs, and the type of movie.

12.24 A residual analysis of the data indicates a pattern, with sizable
clusters of consecutive residuals that are either all positive or all negative.
This pattern indicates a violation of the assumption of linearity. A
curvilinear model should be investigated.

12.26 There does not appear to be a pattern in the residual plot. The
assumptions of regression do not appear to be seriously violated.

12.28 The histogram is slightly left-skewed, thus possibly violating normality
assumption. The residual versus fit plot indicates at least one outlier.

SYX = 15.3782.
r2 = 0.5452.

S = 1.46302.
r2 = 34.6%

SYX = 5.0314
r2 = 0.8892.

SYX = A
SSE

n - 2
= S

a
n

i=1
(Yi - YNi)

2

n - 2
= A

9,490

10
= 30.8058.

r2 =
SSR

SST
=

20,535

30,025
= 0.684.

SSR = 36 - 12 = 24. r2 =
24
36

= 0.6667

SST = 76. r2 =
64
76

= 0.8421

=  $39.2658
YN = b0 + b1 X. YN = 10.473 + 0.3839(75)

b0 = 10.473, b1 = 0.3839.

YN = 23.85

MPG = 29.5 - 0.0314

b0 = -2.37, b1 = 0.0501

204.2,
YN = 145 + 7.4X = 145 + 7.4(8) =

f0 fe 1f0 - fe2 1f0 - fe22>fe

9 12.1379 -3.1379 0.8112
17 20.1034 -3.1034 0.4791
18 11.7586 6.2414 3.3129
5 5.2414 -0.2414 0.0111
8 8.6810 -0.6810 0.0534
6 5.0776 0.9224 0.1676

18 14.6207 3.3793 0.7811
28 24.2155 3.7845 0.5915
7 14.1638 -7.1638 3.6233

9.8311

Decision rule: If reject 

Test statistic: 

Decision: Because do not reject There is
insufficient evidence to conclude that there is a relationship between the
commuting time of company employees and the level of stress-related
problems observed on the job. (b) Because 
reject There is enough evidence at the 0.05 level to conclude that
there is a relationship.

11.26 Strictly speaking, the proportion reading a book for relaxation is
not significantly different across the age groups at 5% level. Results in (a)
and (b) differ due to the fact that the other variables (watching TV,
listening to music) differ across age groups, which is masked if these
variables are combined into a single category.

11.30 (a) Because do not reject There is
insufficient evidence to conclude that there is a relationship between a
student’s gender and pizzeria selection. (b) Because 

do not reject There is insufficient evidence to conclude that 
there is a relationship between a student’s gender and pizzeria selection. 
(c) Because do not reject There is insufficient
evidence to conclude that there is a relationship between price and pizzeria
selection. (d) The probability of a sample that gives a
test statistic equal to or greater than 4.956 is 8.39% if the null hypothesis of
no relationship between price and pizzeria selection is true.

11.32 (a) Because do not reject There is
not enough evidence to conclude that there is a relationship between the
attitudes of employees toward the use of self-managed work teams and
employee job classification. (b) Because do
not reject There is insufficient evidence to conclude that there is a
relationship between the attitudes of employees toward vacation time
without pay and employee job classification.

H0.
x2

STAT = 3.294 6 12.592,

H0.x2
STAT = 11.895 6 12.592,

p-value = 0.0839.

H0.x2
STAT = 4.956 6 5.991,

H0.3.841,
x2

STAT = 2.624 6

H0.x2
STAT = 0.412 6 3.841,

H0.
x2

STAT = 9.831 7 9.488,

H0.x2
STAT = 9.8311 6 13.277,

x2
STAT = ©

all cells

1f0 - fe22
fe

= 9.8311.

H0.x2
STAT 7 13.277,
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of significance, there is evidence of a linear relationship between U.S. gross
and worldwide gross.

12.54 (a) There appears to be a moderate positive linear
relationship between the average Wonderlic score of football players
trying out for the NFL and the graduation rate for football players at
selected schools. (b) Reject

At the 0.05 level of significance, there is a significant linear
relationship between the average Wonderlic score of football players
trying out for the NFL and the graduation rate for football players at
selected schools. (c) There is a significant linear relationship between the
average Wonderlic score of football players trying out for the NFL and
the graduation rate for football players at selected schools, but the
positive linear relationship is only moderate.

12.56 (a) (b)

12.58 (a)

(b)

(c) Part (b) provides a prediction interval for the individual response
given a specific value of the independent variable, and part (a) provides
an interval estimate for the mean value, given a specific value of the
independent variable. Because there is much more variation in predicting
an individual value than in estimating a mean value, a prediction interval
is wider than a confidence interval estimate.

12.60

New Obs Fit SE Fit 95% CI 95% PI

1 23.819 0.348 (23.087, 24.550) (20.659, 26.978)

Values of Predictors for New Observations

New Obs  Horsepower

1 180

12.62 (a) (b)
(c) Part (b) provides a prediction interval for an individual response

given a specific value of X, and part (a) provides a confidence interval esti-
mate for the mean value, given a specific value of X. Because there is much
more variation in predicting an individual value than in estimating a mean,
the prediction interval is wider than the confidence interval.

12.74 (a) (b) For each additional case, the
predicted delivery time is estimated to increase by 0.14 minutes.
(c) 45.84. (d) No, 500 is outside the relevant range of the data used to fit
the regression equation. (e) (f) There is no obvious pattern
in the residuals, so the assumptions of regression are met. The model
appears to be adequate. (g) reject 
(h)

12.76 (a) (b) For each additional
thousand dollars in assessed value, the estimated selling price of a house
increases by $1.7817 thousand. The estimated selling price of a house
with a 0 assessed value is thousand. However, this
interpretation is not meaningful because the assessed value cannot be
below 0. (c)

thousand dollars. (d) So 92.56%r2 = 0.9256.1.78171(170) = 180.5475
-122.3439 +YN = -122.3439 + 1.78171X =

$ - 122.3439

b0 = -122.3439, b1 = 1.7817.

41.56 … YX=150 … 50.12.44.88 … mY|X=150 … 46.80.
H0.tSTAT = 24.88 7 2.1009;

r2 = 0.972.

b0 = 24.84, b1 = 0.14.

374.4318.
124.4653 … YX=150 …217.4561 … mY|X=150 … 281.441.

131.00 … YX=8 … 277.40.

= 204.2 ; 2.2281130.81211 + 0.1373

YN ; ta>2SYX11 + hi

178.76 … mY|X=8 … 229.64.

= 204.2 ; 2.2281130.81210.1373

YN = 145 + 7.4182 = 204.2 YN ; ta>2SYX1hi

(8.778, 17.221).(9.99, 16.01).

H0.
tSTAT = 3.9485, p-value = 0.0004 6 0.05.

r = 0.5497.

12.30 Based on the residual plot, there appears to be a nonlinear pattern
in the residuals. A curvilinear model should be investigated. There is
some right-skewness in the residuals, and there is some violation of the
equal-variance assumption.

12.32 (a) An increasing linear relationship exists. (b) There is evidence of
a strong positive autocorrelation among the residuals.

12.34 (a) No, because the data were not collected over time. (b) If a
single store had been selected and studied over a period of time, you
would compute the Durbin-Watson statistic.

12.36 (a)

(b) or
$72,908. (c) There is no evidence of a pattern in the residuals over time.

(d) There is no 

evidence of positive autocorrelation among the residuals. (e) Based on a
residual analysis, the model appears to be adequate.

12.38 (a) (b) $2,505.40. (d)
so there is no evidence of positive autocorrelation among

the residuals. (e) The plot shows some nonlinear pattern, suggesting 
that a nonlinear model might be better. Otherwise, the model appears 
to be adequate.

12.40 (a) 1.8571. (b) (c) Since 
the null hypothesis of no linear relationship cannot be rejected. 

12.42 (a) Reject There

is evidence of a linear relationship between shelf space and sales. 

(b)

12.44 (a) reject There is evidence of a
linear relationship between the number of cubic feet moved and labor
hours. (b)

12.46 (a) At 1% level of significance there is evidence of linear
relationship between horsepower of a car and its MPG performance. 
(b)

12.48 (a) or because the p-value is virtually
reject There is evidence of a linear relationship between

box office gross and sales of DVDs. (b)

12.50 (a) (% daily change in BGU) (% daily change in
Russell 1000 index). (b) If the Russell 1000 gains 10% in a year, BGU is
expected to gain an estimated 30%. (c) If the Russell 1000 loses 20% in a
year, BGU is expected to lose an estimated 60%. (d) Risk takers will be
attracted to leveraged funds, and risk-averse investors will stay away.

12.52 (a), (b) First weekend and U.S. gross: 
Do not reject At the 0.05 level of

significance, there is a insufficient evidence of a linear relationship between
First weekend sales and U.S. gross. First weekend and worldwide gross:

Do
not reject At the 0.05 level of significance, there is a insufficient 
evidence of a linear relationship between first weekend sales and 
worldwide gross. U.S. gross and worldwide gross: 

Reject At the 0.05 levelH0.5.5807 7 2.7764, p-value = 0.0051 6 0.05.
r = 0.9414, tSTAT =

H0.
r = 0.4149, tSTAT = -0.912 6 2.7764, p-value = 0.4134 7 0.05.

H0.2.7764, p-value = 0.6292 7 0.05.
r = 0.2526, tSTAT = -0.5221 6

= b0 + 3.0

3.3072 … b1 … 5.3590.
H0.0 6 0.05;

tSTAT = 4.8964 7 2.086

CI = -0.0314 ; 2.1 * 0.0102 = 1-0.0527, -0.01002.

0.0439 … b1 … 0.0562.

H0.tSTAT = 16.52 7 2.0322;

b1 ; ta>2Sb1
= 7.4 ; 2.2281(1.59) 3.86 … b1 … 10.94.

H0.tSTAT =
b1 - b1

Sb1

=
7.4

1.59
= 4.65 7 2.2281.

tSTAT 6 t10.99, 132, t (0.99, 13) = 2.65.

dU = 1.42,
D = 1.64 7b0 = -2.535, b1 = 0.06073.

D =
a

n

i=2
1ei - ei-122

a
n

i=1
e2

i

=
1,243.2244

599.0683
= 2.08 7 1.45.

YN = 0.458 + 0.0161X = 0.458 + 0.016114,5002 = 72.908,

b0 = Y - b1 X = 71.2621 - 0.0161 14,3932 = 0.458

b1 =
SSXY

SSX
=

201399.05
12495626

= 0.0161

Z08_LEVI0923_06_SE_ANS.QXD  1/16/12  3:30 PM  Page 609

61



610 Self-Test Solutions and Answers to Selected Even-Numbered Problems

of the variation in selling price can be explained by the variation in
assessed value. (e) Neither the residual plot nor the normal probability
plot reveals any potential violation of the linearity, equal variance, and
normality assumptions. (f) p-value is
virtually 0. Because reject There is evidence of a
linear relationship between selling price and assessed value. (g)

12.78 (a) (b) For each additional point on the
GMAT score, the predicted GPA is estimated to increase by 0.00487.
Because a GMAT score of 0 is not possible, the Y intercept does not have
a practical interpretation. (c) 3.222. (d) (e) There is no
obvious pattern in the residuals, so the assumptions of regression are met.
The model appears to be adequate. (f) reject 
(g)
(h)

12.80 (a) There is no clear relationship shown on the scatter plot.
(c) Looking at all 23 flights, when the temperature is lower, there is likely
to be some O-ring damage, particularly if the temperature is below
60 degrees. (d) 31 degrees is outside the relevant range, so a prediction
should not be made. (e) Predicted where

and -ring damage (g) A nonlinear model would
be more appropriate. (h) The appearance on the residual plot of a
nonlinear pattern indicates that a nonlinear model would be better. It also
appears that the normality assumption is invalid.

12.82 (a) (b) For each additional million-
dollar increase in revenue, the franchise value will increase by an
estimated $2.9576 million. Literal interpretation of is not meaningful
because an operating franchise cannot have zero revenue. (c) $437.3901
million. (d) 98.1% of the variation in the value of an NBA
franchise can be explained by the variation in its annual revenue.
(e) There does not appear to be a pattern in the residual plot. The
assumptions of regression do not appear to be seriously violated.
(f) or because the p-value is approximately 0,
reject at the 5% level of significance. There is evidence of a linear
relationship between annual revenue and franchise value. (g)

(h) (i) The
strength of the relationship between revenue and value is stronger for
baseball and NBA franchises than for European soccer teams.

12.84 (a) (b) For each additional
centimeter in circumference, the weight is estimated to increase by
82.472 grams. (c) 2,319.08 grams. (d) Yes, since circumference is a very
strong predictor of weight. (e) (f) There appears to be a
nonlinear relationship between circumference and weight. (g) p-value is
virtually reject (h)

12.86 (b) Thickness = 71.9 0.0101 Pressure (c) If pressure = 0,
Thickness = 71.9, which is the Y-intercept. For every unit increase in
pressure, Thickness is expected to decrease by 0.0.0101 units. (d) R-Sq =
0.2% => 0.2% of total variation is being explained by the linear regression.
(f) P-value = 0.779 => there does not seem to be any evidence of linear
relationship between pH and Thickness. (g) 95% CI: 0.01 ± 2.01*0.0357
= ( 0.081, 0.062)

12.88 (b) Thickness = 28.2 0.417 Voltage (c) If Voltage = 0,
Thickness = 28.2, which is the Y-intercept. In this case this value will
have no physical interpretation. For every unit increase in Voltage,
Thickness is expected to increase by 0.417 units. (d) R-Sq = 67.3% =>
67.3% of total variation is being explained by the linear regression. 
(f) P-value = 0.00  => there seems to be strong evidence of linear
relationship between Voltage and Thickness. (g) 95% CI: 0.417 ±
2.01*0.0420 = (0.3326, 0.5014)

-
+-

-
-

-

72.7875 … b1 … 92.156.H0.0 6 0.05;

r2 = 0.937.

b0 = -2,629.222, b1 = 82.472.

408.8257 … YX=150 … 465.9544.mY|X=150 … 443.7334.
431.0467 …

H0

tSTAT = 38.0207 7 2.0484

r2 = 0.981.

b0

b0 = -6.2448, b1 = 2.9576.

Y = OX = temperature
Y = 18.036 - 0.240X,

.00366 … b1 … .00608.
3.144 … mY|X=600 … 3.301, 2.866 … YX=600 … 3.559.

H0.tSTAT = 8.43 7 2.1009;

r2 = 0.798.

b0 = 0.30, b1 = 0.00487.

1.5862 … b1 … 1.9773.

H0.p-value 6 0.05,
18.6648 7 2.0484,tSTAT =

12.90 (a) The correlation between compensation and stock performance
is 0.0389. (b)
The correlation between compensation and stock performance is 
not significant. (c) The lack of correlation between compensation 
and stock performance was surprising (or maybe it shouldn’t 
have been!).

CHAPTER 13
13.2 (a) Expected decrease in Y value is 7 per unit increase in when

is held at a constant level. Expected increase in Y value is 26.2 per unit
increase in when is held at a constant level. (b) When both and

are at 0, expected value of Y is 90.

13.4 (a) (b) For a given
number of orders, for each increase of $1,000 in sales, the distribution
cost is estimated to increase by $47.114. For a given amount of sales, for
each increase of one order, the distribution cost is estimated to increase
by $11.95. (c) The interpretation of has no practical meaning here
because it would represent the estimated distribution cost when there
were no sales and no orders. (d)

, or $69,878. (e)
(f) (g) The interval in 

(e) is narrower because it is estimating the mean value, not an individual
value.

13.6 (a) . (b) For a given amount of
newspaper advertising, each increase by $1,000 in radio advertising is
estimated to result in an increase in sales of $13,081. For a given amount
of radio advertising, each increase by $1,000 in newspaper advertising is
estimated to result in an increase in sales of $16,795. (c) When there is no
money spent on radio advertising and newspaper advertising, the
estimated mean sales is $156,430.44. (d) Holding the other independent
variable constant, newspaper advertising seems to be more effective
because its slope is greater.

13.8 (a) where 
(b) For a given age, each increase by one acre in land area 

is estimated to result in an increase in appraised value by $456.45
thousands. For a given land area, each increase of one year in age is
estimated to result in a decrease in appraised value by $2.47 thousands.
(c) The interpretation of has no practical meaning here because it
would represent the estimated appraised value of a new house that has
no land area. (d)

thousands. (e) (f)

13.10 (a) 97.27% of the total variability in 

the fast food burgers is explained by the fat and carbohydrate content of 

the burgers. (b) Adjusted 

13.12 (a) . (b) p-value is
0.00. The relationship is therefore significant at 1% level.

13.14 (a) reject (b)
(c) 87.59% of the variation in distribution cost can be
explained by variation in sales and variation in number of orders. 
(d)

13.16 (a) . Reject There is evidence 
of a significant linear relationship. (b)
(c) 80.87% of the variation in sales can be explained byr2 = 0.8087.

p-value 6 0.001.
H0.FSTAT = 40.16 7 3.522

r2
adj = 0.8641.

r2 = 0.8759.
p-value = 0.H0.FSTAT = 74.13 7 3.467;

MSR = 258669, MSE = 854, FSTAT = 302.89

r2 = 1 -
MSE

MST
= 96.9%.

r2 =  
SSR

SST
=

517337
531855

= 0.9727.

YX … 572.2649.
235.1964 …372.7370 … mY|X … 434.7243.$403.73

YN = 400.8057 + 456.448510.252 - 2.47081452 =

b0

 X2 = age.
X1 = land area,YN = 400.8057 + 456.4485X1 - 2.4708X2

YN = 156.4 + 13.081X1 + 16.795X2

$59,380.61 … YX … $80,376.33.$73,337.01.
$66,419.93 … mY|X …0.011947145002 = 69.878

YN = -2.72825 + 0.04711414002 +

b0

YN = -2.72825 + 0.047114X1 + 0.011947X2.

X2

X1X1X2,
X2

X1,

tSTAT = -0.4912 7 -1.96; p-value =  0.6239 7  0.05.-
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variation in radio advertising and variation in newspaper advertising. 
(d)

13.18 (a)–(e) Based on a residual analysis, there is no evidence of a violation
of the assumptions of regression. (f) (g)
There is no evidence of positive autocorrelation in the residuals.

13.20 (a) There appears to be a quadratic relationship in the plot of the
residuals against both radio and newspaper advertising. (b) Since the
data are not collected over time, the Durbin-Watson test is not
appropriate. (c) Curvilinear terms for both of these explanatory variables
should be considered for inclusion in the model.

13.22 (a) The residual analysis reveals no patterns. (b) Since the data are
not collected over time, the Durbin-Watson test is not appropriate. (c)
There are no apparent violations in the assumptions.

13.24 (a) and has
the larger slope. (b) (c) Both and 
are significant at 5% level. Both may be included in the model.

13.26 (a) 95% confidence interval on 
(b) For 

Reject There is evidence that 
contributes to a model already containing For 

Reject There is evidence that 
contributes to a model already containing Both (sales) and 

(orders) should be included in the model.

13.28 (a) (b) For Reject
There is evidence that contributes to a model already containing 

For Reject There is evidence that 
contributes to a model already containing Both (radio advertising) 
and (newspaper advertising) should be included in the model.

13.30 (a) (b) For 
and Because reject There is
evidence that contributes to a model already containing For

and . Because 
reject There is evidence that contributes to a model already
containing Both (land area) and (age) should be included
in the model.

13.32 Variable makes a significant
contribution to the model.

13.34 (a) where 
of rooms and (b) Holding constant the effect
of neighborhood, for each additional room, the selling price is estimated to
increase by 9.2189 thousands of dollars, or $9,218.9. For a given number
of rooms, a west neighborhood is estimated to increase the selling price
over an east neighborhood by 12.6967 thousands of dollars, or $12,696.7.
(c) or 

(d) Based on a residual analysis, the model appears to be adequate. 
(e) the p-value is virtually 0. Because 
reject There is evidence of a significant relationship between selling
price and the two independent variables (rooms and neighborhood). 
(f) For the p-value is virtually 0. Reject Number
of rooms makes a significant contribution and should be included in the
model. For Reject 
Neighborhood makes a significant contribution and should be included in
the model. Based on these results, the regression model with the two
independent variables should be used. (g)
(h) (i) (j) The slope of selling
price with number of rooms is the same, regardless of whether the house

r2
adj = 0.851.5.2378 … b2 … 20.1557.

7.0466 … b1 … 11.3913.

H0.X2:tSTAT = 3.5913, p-value = 0.0023 6 0.05,

H0.X1:tSTAT = 8.9537,

H0.
p-value 6 0.05,FSTAT = 55.39,

mY|X … $331, 943.71.$309,560.04 … YX … $343,855.1.  $321,471.44 …
$326, 707.6.YN = 243.7371 + 9.2189192 + 12.6967102 = 326.7076,

X2 = neighborhood (east = 0)
X1 = numberYN = 243.7371 + 9.2189X1 + 12.6967X2,

X2tSTAT = 2.73. t10.975,122 = 2.18.

X2X1X1.
X2H0.

p-value 6 0.05p-value = 0.0012X2: tSTAT = -3.6295
X2.X1

H0.p-value 6 0.05,p-value = 0.0003.
X1: tSTAT = 4.0922227.5865 … b1 … 685.3104.

X2

X1X1.
X2H0.X2: tSTAT = 5.67 7 2.093.

X2.X1H0.
X1: tSTAT = 7.43 7 2.093.9.398 … b1 … 16.763.

X2X1X1.X2

H0.0.0112>0.0023 = 5.31 7 2.0796.
X2: tSTAT = b1>Sb1

=X2.
X1H0.0.0471>0.0203 = 2.32 7 2.0796.

X1: tSTAT = b1>Sb1
=(0.0203),  0.0049 … b1 … 0.0893.

b1: b1 ; tSb1
, 0.0471 ; 2.0796

X2X19 ; 2.07 * 2.9 = 12.997, 15.002.
X1b2>Sb2 = 12>4.7 = 2.55.b1>Sb1 = 9>2.9 = 3.10

D = 2.26 7 1.55.D = 2.26

r2
adj = 0.7886.

is located in an east or west neighborhood. (k)
For Do not

reject There is no evidence that the interaction term makes a
contribution to the model. (l) The model in (b) should be used.

13.36 (a) Predicted Dry. 
(b) Holding constant the effect of type of drilling, for each foot
increase in depth of the hole, the drilling time is estimated to increase
by 0.00523 minutes. For a given depth, a dry drilling hole is estimated
to reduce the drilling time over wet drilling by 2.1052 minutes. (c) 6.428
minutes, (d) The 
model appears to be adequate. (e) reject 
(f) reject 
reject Include both variables. (g)
(h) (i) 69.0%. (j) The slope of the additional
drilling time with the depth of the hole is the same, regardless of the 
type of drilling method used. (k) The p-value of the interaction

so the term is not significant and should not 
be included in the model. (l) The model in part (b) should be used.

13.38 The regression equation is

Calories = 10.9 + 10.4 Fat + 6.40 Carbs 0.0191 Interaction

Predictor Coef SE Coef T P

Constant 10.91 96.52 0.11 0.911
Fat 10.388 3.286 3.16 0.006
Carbs 6.399 1.717 3.73 0.002
Interaction 0.01915 0.05258 0.36 0.721

The interaction term is not significant. No interaction model may be 
used.

13.40 (a) The p-value of the interaction so the
term is significant and should be included in the model. (b) Use the
model developed in this problem.

13.42 (a) For Do not reject There
is insufficient evidence that the interaction term makes a contribution
to the model. (b) Because there is not enough evidence of an interaction
effect between total staff present and remote hours, the model in
Problem 13.7 should be used.

13.50 (a) , where number
cubic feet moved and number of pieces of large furniture.
(b) Holding constant the number of pieces of large furniture, for each
additional cubic foot moved, the labor hours are estimated to increase
by 0.0319. Holding constant the amount of cubic feet moved, for each
additional piece of large furniture, the labor hours are estimated to
increase by 4.2228. (c)

(d) Based on a residual analysis, the errors appear to be 
normally distributed. The equal-variance assumption might be violated
because the variances appear to be larger around the center region of 
both independent variables. There might also be violation of the linearity
assumption. A model with quadratic terms for both independent variables
might be f itted. (e) p-value is virtually 0. Because

reject There is evidence of a significant relationship
between labor hours and the two independent variables (the amount of
cubic feet moved and the number of pieces of large furniture). (f) The
p-value is virtually 0. The probability of obtaining a test statistic of
228.80 or greater is virtually 0 if there is no significant relationship
between labor hours and the two independent variables (the amount 
of cubic feet moved and the number of pieces of large furniture). 
(g) of the variation in labor hours can be explained
by variation in the number of cubic feet moved and the number of pieces

r2 = 0.9327.93.27%

H0.p-value 6 0.05,
FSTAT = 228.80,

20.4926.
YN = -3.9152 + 0.031915002 + 4.2228 122 =

X2 =
X1 =YN = -3.9152 + 0.0319X1 + 4.2228X2

H0.X1 X2, p-value = 0.2353 7 0.05.

term = 0.002 6 0.05,

--

--

--

term = 0.462 7 0.05,

-2.403 … b2 … -1.808.
0.0032 … b1 … 0.0073.H0.

tSTAT = -14.03 6 -1.9847;H0.1.9847;tSTAT = 5.03 7
H0.FSTAT = 111.11 7 3.09;

6.210 … mY|X … 6.646, 4.923 … YX … 7.932.

time = 8.01 + 0.00523 Depth - 2.105

H0.
0.330.X1 X2,  p-value =8.032X1 - 5.90X2 + 2.089X1X2.

YN = 253.95 +

Z08_LEVI0923_06_SE_ANS.QXD  1/16/12  3:45 PM  Page 611

63



612 Self-Test Solutions and Answers to Selected Even-Numbered Problems

of large furniture. (h) (i) For the
p-value is virtually 0. Reject The number of cubic feet moved 
makes a significant contribution and should be included in the model. For

the p-value is virtually 0. Reject The number of
pieces of large furniture makes a significant contribution and should be
included in the model. Based on these results, the regression model with
the two independent variables should be used. (j) For 
the p-value is virtually 0. The probability of obtaining a sample that
will yield a test statistic farther away than 6.9339 is virtually 0 if the
number of cubic feet moved does not make a significant contribution,
holding the effect of the number of pieces of large furniture constant. 
For the p-value is virtually 0. The probability of
obtaining a sample that will yield a test statistic farther away than 4.6192
is virtually 0 if the number of pieces of large furniture does not make a
significant contribution, holding the effect of the amount of cubic feet
moved constant. (k) You are 95% confident that
the mean labor hours will increase by between 0.0226 and 0.0413 for
each additional cubic foot moved, holding constant the number of pieces
of large furniture. In Problem 12.44, you are 95% confident that the labor
hours will increase by between 0.0439 and 0.0562 for each additional
cubic foot moved, regardless of the number of pieces of large furniture.

13.52 (a) , where 
value and since assessment. (b) Holding constant the time
period, for each additional thousand dollars of assessed value, the
selling price is estimated to increase by 1.7506 thousand dollars. Holding
constant the assessed value, for each additional month since assessment, the
selling price is estimated to increase by 0.3680 thousand dollars. 
(c) thousand
dollars. (d) Based on a residual analysis, the model appears to be adequate.
(e) the p-value is virtually 0. Because 
reject There is evidence of a significant relationship between selling 
price and the two independent variables (assessed value and time since
assessment). (f) The p-value is virtually 0. The probability of obtaining 
a test statistic of 223.46 or greater is virtually 0 if there is no significant
relationship between selling price and the two independent variables
(assessed value and time since assessment). (g) 94.30% of the
variation in selling price can be explained by variation in assessed value and
time since assessment. (h) (i) For 
the p-value is virtually 0. Reject The assessed value makes a 
significant contribution and should be included in the model. For

Reject The time since
assessment makes a significant contribution and should be included in the
model. Based on these results, the regression model with the two independent
variables should be used. (j) For the p-value is virtually
0. The probability of obtaining a sample that will yield a test statistic 
farther away than 20.4137 is virtually 0 if the assessed value does not make 
a significant contribution, holding time since assessment constant. For

the p-value is virtually 0. The probability of obtaining a
sample that will yield a test statistic farther away than 2.8734 is virtually 0 if
the time since assessment does not make a significant contribution holding
the effect of the assessed value constant. (k) You
are 95% confident that the selling price will increase by an amount
somewhere between $1.5746 thousand and $1.9266 thousand for each
additional thousand-dollar increase in assessed value, holding constant the
time since assessment. In Problem 12.76, you are 95% confident that the
selling price will increase by an amount somewhere between $1.5862
thousand and $1.9773 thousand for each additional thousand-dollar increase
in assessed value, regardless of the time since assessment.

13.54 (a) , where and
(b) Holding age constant, for each additional thousand square

feet, the assessed value is estimated to increase by $10.7252 thousand.
X2 = age.

X1 = sizeYN = 163.7751 + 10.7252X1 - 0.2843X2

1.5746 … b1 … 1.9266.

X2: tSTAT = 2.8734,

X1: tSTAT = 20.4137,

H0.X2: tSTAT = 2.8734, p-value = 0.0078 6 0.05.

H0.
X1: tSTAT = 20.4137,r2

adj = 0.9388.

r2 = 0.9430.

H0.
p-value 6 0.05,FSTAT = 223.46,

1.750611702 + 0.36801122 = 181.9692YN = -120.0483 +

X2 = time
assessedX1 =YN = -120.0483 + 1.7506X1 + 0.3680X2

0.0226 … b1 … 0.0413.

X2: tSTAT = 4.6192,

X1: tSTAT = 6.9339,

H0.X2: tSTAT = 4.6192,

H0.
X1: tSTAT = 6.9339,r2

adj = 0.9287. Holding size constant, for each additional year, the assessed value is
estimated to decrease by $0.2843 thousand. (c)

thousand dollars. (d) Based
on a residual analysis, the errors appear to be normally distributed.
The equal-variance assumption appears to be valid. There might be a
violation of the linearity assumption for age. You might want to include a
quadratic term in the model for age. (e)

Because reject There is
evidence of a significant relationship between assessed value and the two
independent variables (size and age). (f) The
probability of obtaining an test statistic of 28.58 or greater is
virtually 0 if there is no significant relationship between assessed value
and the two independent variables (size and age). (g)
82.65% of the variation in assessed value can be explained by variation
in size and age. (h) (i) For 

Reject The size of a house makes a significant
contribution and should be included in the model. For 

Reject The age of a house makes a
significant contribution and should be included in the model. Based on
these results, the regression model with the two independent variables
should be used. (j) For The probability of obtaining
a sample that will yield a test statistic farther away than 3.5581 is 0.0039
if the size of a house does not make a significant contribution, holding
age constant. For The probability of obtaining a
sample that will yield a test statistic farther away than is 0.0053 if
the age of a house does not make a significant contribution, holding the
effect of the size constant. (k) You are 95%
confident that the mean assessed value will increase by an amount
somewhere between $4.1575 thousand and $17.2928 thousand for each
additional thousand-square-foot increase in the size of a house, holding
constant the age. In Problem 12.77, you are 95% confident that the mean
assessed value will increase by an amount somewhere between $9.4695
thousand and $23.7972 thousand for each additional thousand-square-foot
increase in heating area, regardless of the age. (I) Based on your answers to
(b) through (k), the age of a house does have an effect on its assessed value.

13.56 (a) , where 
and (b) Holding constant the
effect of the league, for each additional ERA, the number of wins is
estimated to decrease by 18.4490. For a given ERA, a team in the
National League is estimated to have 3.2787 fewer wins than a 
team in the American League. (c) 74.8771 wins Confidence interval:
69.6315 to 80.1227 Prediction interval: 57.3027 to 92.4515. 
(d) There is no apparent violation of the assumptions. 
(e) Because

reject There is evidence of a significant
relationship between wins and the two independent variables 
(ERA and league). (f) For the p-value
is virtually 0. Reject ERA makes a significant contribution and
should be included in the model. For 

Do not reject The league does not make a
significant contribution and should not be included in the model. Based
on these results, the regression model with only the ERA as the
independent variable should be used. (g)
(h) (i) 48.62% of the variation 
in wins can be explained by the variation in ERA and league. (j) The
slope of the number of wins with ERA is the same, regardless of 
whether the team belongs to the American League or the National
League. (k) For the p-value is

Do not reject There is no evidence that the 
interaction term makes a contribution to the model. (m) The 
model with one independent variable (ERA) should 
be used.

H0.0.7815 7 0.05.
X1X2: tSTAT =  -0.2802 7 -2.0555

r2 = 0.4862.-9.4825 … b2 … 2.9250.
-25.9562 … b1 … -10.9418.

H0.p-value = 0.0502 7 0.05.
X2: tSTAT = -1.0844 7 -2.0518,

H0.
X1: tSTAT = -5.0424 6 -2.0518,

H0.p-value 6 0.05,
FSTAT = 12.7768 7 3.35, p-value = 0.0001.

X2 = league (American = 0, National = 1)
X1 = ERAYN = 157.8976 - 18.4490X1 - 3.2787X2

4.1572 … b1 … 17.2928.

-3.4002
X2: p-value = 0.0053.

X1: p-value = 0.0039.

H0.p-value = 0.0053 6 0.05.
X2: tSTAT = -3.4002,

H0.0.0039 6 0.05.
X1: tSTAT = 3.5581, p-value =r2

adj = 0.7976.

r2 = 0.8265.

FSTAT

p-value = 0.0000272776.

H0.p-value = 0.0000 6 0.05,0.0000272776.
FSTAT = 28.58, p-value =

10.725211.752 - 0.28431102 = 179.7017
YN = 163.7751 +
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13.58 The of the multiple regression is very low, at 0.0645. Only 6.45%
of the variation in thickness can be explained by the variation of pressure
and temperature. The F test statistic for the combined significant of
pressure and temperature is 1.621, with Hence, at a
5% level of significance, there is not enough evidence to conclude that
both pressure and temperature affect thickness. The p-value of the t test
for the significance of pressure is Hence, there is
insufficient evidence to conclude that pressure affects thickness, holding
constant the effect of temperature. The p-value of the t test for the
significance of temperature is 0.0820, which is also There is 
insufficient evidence to conclude that temperature affects thickness 
at the 5% level of significance, holding constant the effect of 
pressure. Hence, neither pressure nor temperature affects thickness
individually.

The normal probability plot does not suggest any potential violation
of the normality assumption. The residual plots do not indicate potential
violation of the equal variance assumption. The temperature residual plot,
however, suggests that there might be a nonlinear relationship between
temperature and thickness.

The of the multiple regression model is very low, at 0.0734. Only
7.34% of the variation in thickness can be explained by the variation of
pressure, temperature, and the interaction of the two. The F test statistic
for the model that includes pressure and temperature is 1.214, with a 
p-value of 0.3153. Hence, at a 5% level of significance, there is
insufficient evidence to conclude that pressure, temperature, and the
interaction of the two affect thickness. The p-value of the t test for the
significance of pressure, temperature, and the interaction term are 0.5074,
0.4053, and 0.5111, respectively, which are all greater than 5%. Hence,
there is insufficient evidence to conclude that pressure, temperature, or
the interaction individually affects thickness, holding constant the effect
of the other variables.

The pattern in the normal probability plot and residual plots is
similar to that in the regression without the interaction term. 
Hence the article’s suggestion that there is a significant interaction
between the pressure and the temperature in the tank cannot be 
validated.

CHAPTER 14
14.2 (a) Day 3, Day 6. (b) . (c) No, there
are no special causes of variation.

14.4 (a) .

(b) Because the individual points are distributed around without any
pattern and all the points are within the control limits, the process is in a
state of statistical control.

14.6 (a) . The proportion of unacceptable
cans is below the LCL on Day 4. There is evidence of a pattern over time
because the last eight points are all above the mean, and most of the earlier
points are below the mean. Therefore, this process is out of control.

UCL = 0.0176, LCL = 0.0082

p

 = 0.0476 - 3A
0.047611 - 0.04762

500
= 0.0190

LCL = p - 3A
p11 - p2

n

 = 0.0476 + 3A
0.047611 - 0.04762

500
= 0.0761

UCL = p + 3A
p11 - p2

n

n = 500, p = 761>16,000 = 0.0476

LCL = 0.0143, UCL = 0.3387

r2

7 0.05.

0.8307 7 0.05.

p-value = 0.2085.

r2 14.8 (a) . Days 9, 26, and 30 are above
the UCL. Therefore, this process is out of control.

14.12 (a) (b) . (c) . (d) .
(e) .

14.14 (a) R chart:

LCL does not exist. chart:

(b) The process appears to be
in control because there are no points outside the control limits, there is
no evidence of a pattern in the range chart, there are no points outside the
control limits, and there is no evidence of a pattern in the chart.

14.16 (a) , LCL does not exist, 
(b) . (c) The process is
in control.

14.18 (a) , LCL does not exist, 
(b) There are no sample ranges 

outside the control limits, and there does not appear to be a pattern in the
range chart. The mean is above the UCL on Day 15 and below the LCL
on Day 16. Therefore, the process is not in control.

14.20 (a) , LCL does not exist, 
(b) On Days 5 and 6, the sample

ranges were above the UCL. The mean chart may be erroneous because
the range is out of control. The process is out of control.

14.28 (a) The main reason that service quality is lower than product
quality is because the former involves human interaction, which is prone
to variation. Also, the most critical aspects of a service are often
timeliness and professionalism, and customers can always perceive that
the service could be done more quickly and with greater professionalism.
For products, customers often cannot perceive a better or more ideal
product than the one they are getting. For example, a new laptop is 
better and contains more interesting features than any laptop the owner
has ever imagined. (b) Both services and products are the results of
processes. However, measuring services is often harder because of the
dynamic variation due to the human interaction between the service
provider and the customer. Product quality is often a straightforward
measurement of a static physical characteristic such as the amount of sugar
in a can of soda. Categorical data are also more common in service quality.
(c) Yes. (d) Yes.

14.30 (a) (b) Yes,
RudyBird’s market share is in control before the in-store promotion.
(c) All seven days of the in-store promotion are above the UCL. The
promotion increased market share.

14.32 (a) . Although
none of the points are outside the control limits, there is a clear pattern
over time, with the last 13 points above the center line. Therefore, this
process is not in control. (b) Because the increasing trend begins around
Day 20, this change in method would be the assignable cause. (c) The
control chart would have been developed using the first 20 days, and then
a different control chart would be used for the final 20 points because
they represent a different process.

14.34 (a) (b) Day 24 is
below the LCL; therefore, the process is out of control. (c) Special 
causes of variation should be investigated to improve the process. 
Next, the process should be improved to decrease the proportion of
undesirable trades.

p = 0.1198, LCL = 0.0205, UCL = 0.2191.

p = 0.75175, LCL = 0.62215, UCL = 0.88135

p = 0.2702, LCL = 0.1700, UCL = 0.3703.

UCL = 90.3060, LCL = 89.9573.
UCL = 0.6389;   X = 90.1312,R = 0.3022

UCL = 24.0577, LCL = 12.1823.
UCL = 18.5869;  X = 18.12,R = 8.145

X = 20.1065, LCL = 19.4654, UCL = 20.7475
UCL = 2.0068.R = 0.8794

X

A2 
 R = 5.9413 - 0.72913.2752 = 3.5538.

LCL = X -UCL = X + A2R = 5.9413 + 0.72913.2752 = 8.3287.

 XUCL = D4 R = 2.28213.2752 = 7.4736.

R =
a

k

i=1
 Ri

k
= 3.275,  X =

a
k

i=1
 Xi

k
 = 5.941.

A2 = 0.419
D4 = 1.924D3 = 0.076d3 = 0.833d2 = 2.704.

UCL = 0.1431, LCL = 0.0752
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14.36 Separate p charts should be developed for each food for each shift:

Kidney—Shift 1:
Although there are no points outside the control limits, there is a strong
increasing trend in nonconformances over time.

Kidney—Shift 2:
Although there are no points outside the control limits, there is a strong
increasing trend in nonconformances over time.

Shrimp—Shift 1: There are
no points outside the control limits, and there is no pattern over time.

p = 0.006995, UCL = 0.01569, LCL = 0.

p = 0.01829, UCL = 0.03329, LCL = 0.00329.

p = 0.01395, UCL = 0.02678, LCL = 0.00112.

Shrimp—Shift 2: There are no
points outside the control limits, and there is no pattern over time.

The team needs to determine the reasons for the increase in
nonconformances for the kidney product. The production volume 
for kidney is clearly decreasing for both shifts. This can be observed 
from a plot of the production volume over time. The team needs to
investigate the reasons for this.

p = 0.01023, UCL = 0.021, LCL = 0.
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